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Manual Explanation * If there are any variations between the explanation in this manual and the actual application

method, priority is given to the actual application method.

¢ This manual is a common manual for T2 Elite, T2 Pro and T2 Express. Screenshots and
illustrations in this manual may vary from those of the actual product.

e The screenshots used as examples in this manual are those of the development stage, so
they may vary from those in the final product.

¢ This manual is written for users who have a basic knowledge of how to use a computer.
If there are no special instructions, perform the same operation as a normal computer
operation.

* The contents of this product may modify without prior notice.
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Notice

Section

MICROSOFT SOFTWARE LICENSE TERMS
WINDOWS EMBEDDED STANDARD 7

August 3, 2012

These license terms are an agreement between you and Grass Valley, Inc. Please
read them. They apply to the software included on this device. The software also
includes any separate media on which you received the software.
The software on this device includes software licensed from Microsoft
Corporation or its affiliate.
The terms also apply to any Microsoft

¢ updates,

¢ supplements,

¢ Internet-based services, and

® support services
for this software, unless other terms accompany those items. If so, those terms
apply.
If you obtain updates or supplements directly from Microsoft, then Microsoft,
and not Grass Valley, Inc., licenses those to you.
As described below, using the software also operates as your consent
to the transmission of certain computer information for Internet-based
services.
By using the software, you accept these terms. If you do not accept them,
do not use the software. Instead, contact Grass Valley, Inc. to determine its
return policy for a refund or credit.

If you comply with these license terms, you have the rights below.

1. USE RIGHTS

Use. The software license is permanently assigned to the device with which you

acquired the software. You may use the software on the device.

T2 User Manual 1
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2. ADDITIONAL LICENSING REQUIREMENTS AND/OR USE RIGHTS

a. Specific Use. Grass Valley, Inc. designed the device for a specific use.

You may only use the software for that use.

. Other Software. You may use other programs with the software as long

as the other programs

e directly supports the manufacturer’s specific use for the device, or

e provide system utilities, resource management, or anti-virus or similar
protection.

e Software that provides consumer or business tasks or processes
may not be run on the device. This includes email, word processing,
spreadsheet, database, scheduling and personal finance software. The
device may use terminal services protocols to access such software

running on a server.

. Device Connections. You may not use the software as server software.

In other words, more than one device may not access, display, run, share
or use the software at the same time.

You may use terminal services protocols to connect the device to a
server running business task or processes software such as email, word

processing, scheduling or spreadsheets.

You may allow up to ten other devices to access the software to use

e File Services,
e Print Services,
¢ Internet Information Services, and

¢ Internet Connection Sharing and Telephony Services.

The ten connection limit applies to devices that access the software
indirectly through “multiplexing” or other software or hardware that
pools connections. You may use unlimited inbound connections at any
time via TCP/IP.

. Remote Access Technologies. You may access and use the software

remotely from another device using remote access technologies as

follows.

Remote Desktop. The single primary user of the device may access

a session from any other device using Remote Desktop or similar
technologies. A “session” means the experience of interacting with
the software, directly or indirectly, through any combination of input,
output and display peripherals. Other users may access a session from
any device using these technologies, if the remote device is separately

licensed to run the software.
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Other Access Technologies. You may use Remote Assistance or similar

technologies to share an active session.

Other Remote Uses. You may allow any number of devices to access

the software for purposes other than those described in the Device
Connections and Remote Access Technologies sections above, such as to

synchronize data between devices.

e. Font Components. While the software is running, you may use its fonts
to display and print content. You may only

¢ embed fonts in content as permitted by the embedding restrictions in
the fonts; and

¢ temporarily download them to a printer or other output device to print
content.

f. lcons, images and sounds. While the software is running, you may use
but not share its icons, images, sounds, and media.

3. VHD BOOT. Additional copies of the software created using the software’s

Virtual Hard Disk functionality (“VHD Image”) may be pre-installed on the
physical hard disk of the device. These VHD Images may only be used for
maintaining or updating the software installed on the physical hard disk or
drive. If the VHD Image is the only software on your device, it may be used as
the primary operating system but all other copies of the VHD Image may only

be used for maintenance and updating.

. POTENTIALLY UNWANTED SOFTWARE. The software may include

Windows Defender. If Windows Defender is turned on, it will search this

i

device for “spyware,” “adware” and other potentially unwanted software. If it
finds potentially unwanted software, the software will ask you if you want to
ignore, disable (quarantine) or remove it. Any potentially unwanted software
rated “high” or “severe,” will be automatically removed after scanning unless
you change the default setting. Removing or disabling potentially unwanted

software may result in

¢ Other software on your device ceasing to work, or
* Your breaching a license to use other software on this device

By using this software, it is possible that you will also remove or disable
software that is not potentially unwanted software.

. SCOPE OF LICENSE. The software is licensed, not sold. This agreement only

gives you some rights to use the software. Grass Valley, Inc. and Microsoft
reserve all other rights. Unless applicable law gives you more rights despite
this limitation, you may use the software only as expressly permitted in this

agreement. In doing so, you must comply with any technical limitations in the
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software that allow you to use it only in certain ways. For more information,

see the software documentation or contact Grass Valley, Inc. You may not:

work around any technical limitations in the software;

reverse engineer, decompile or disassemble the software;

make more copies of the software than specified in this agreement;
publish the software for others to copy;

rent, lease or lend the software; or

use the software for commercial software hosting services.

Except as expressly provided in this agreement, rights to access the software

on this device do not give you any right to implement Microsoft patents or

other Microsoft intellectual property in software or devices that access this

device.

. INTERNET-BASED SERVICES. Microsoft provides Internet-based services

with the software. Microsoft may change or cancel them at any time.

a. Consent for Internet-Based Services. The device may contain one or

more of the software features described below. These features connect
to Microsoft or service provider computer systems over the Internet. In
some cases, you will not receive a separate notice when they connect.
For more information about these features, visit go.microsoft.com/
fwlink/?linkid=104604.

By using these features, you consent to the transmission of this
information. Microsoft does not use the information to identify or contact
you.

Computer Information. The following features use Internet protocols,

which send to the appropriate systems computer information, such as
your Internet protocol address, the type of operating system and browser,
the name and version of the software you are using, and the language
code of the device where you installed the software. Microsoft uses this
information to make the Internet-based services available to you. Grass
Valley, Inc. has elected to turn on the following features on the device.

¢ Plug and Play and Plug and Play Extensions. You may connect new

hardware to your device. Your device may not have the drivers needed
to communicate with that hardware. If so, the update feature of the
software can obtain the correct driver from Microsoft and install it on
your device.

e Web Content Features. Features in the software can retrieve related

content from Microsoft and provide it to you. Examples of these
features are clip art, templates, online training, online assistance and
Appshelp. You may choose to switch them off or not use them.

e Digital Certificates. The software uses x.509 version 3 digital certificates.
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These digital certificates confirm the identity of user sending
information to each other and allow you to encrypt the information.
The software retrieves certificates and updates certificate revocation
lists over the Internet.

Auto Root Update. The Auto Root Update feature updates the list of
trusted certificate authorities. You can switch off this feature.

Windows Media Digital Rights Management. Content owners use

Windows Media digital rights management technology (WMDRM) to
protect their intellectual property, including copyrights. This software
and third party software use WMDRM to play and copy WMDRM-
protected content. If the software fails to protect the content, content
owners may ask Microsoft to revoke the software’s ability to use
WMDRM to play or copy protected content. Revocation does not affect
other content. When you download licenses for protected content, you
agree that Microsoft may include a revocation list with the licenses.
Content owners may require you to upgrade WMDRM to access their
content. Microsoft software that includes WMDRM will ask for your
consent prior to the upgrade. If you decline an upgrade, you will not
be able to access content that requires the upgrade. You may switch off
WMDRM features that access the Internet. When these features are off,

you can still play content for which you have a valid license.

Windows Media Player. When you use Windows Media Player, it

checks with Microsoft for

e compatible online music services in your region;

* new versions of the player; and

e codecs if your device does not have the correct ones for playing

content.

You can switch off this feature. For more information, go to:
go.microsoft.com/fwlink/?LinkId=51331.

Malicious Software Removal/Clean On Upgrade. Before installation

of the software, the software will check and remove certain malicious
software listed at www.support.microsoft.com/?kbid=890830
(“Malware”) from your device. When the software checks your device
for Malware, a report will be sent to Microsoft about any Malware
detected or errors that occurred while the software was checking for
Malware. No information that can be used to identify you is included
in the report. You may disable the software’s Malware reporting
functionality by following the instructions found at www.support.
microsoft.com/?kbid=890830.

Network Awareness. This feature determines whether a system is

connected to a network by either passive monitoring of network traffic
or active DNS or HTTP queries. The query only transfers standard TCP/

IP or DNS information for routing purposes. You can switch off the
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active query feature through a registry setting.

Windows Time Service. This service synchronizes with www.time.

windows.com once a week to provide your 1 device with the correct
time. The connection uses standard NTP protocol.

Search Suggestions Service. In Internet Explorer, when you type

a search query in the Instant Search box or type a question mark

(?) before your search term in the Address bar, you will see search
suggestions as you type (if supported by your search provider).
Everything you type in the Instant Search box or in the Address bar
when preceded by a question mark (?) is sent to your search provider as
you type. Also, when you press Enter or click the Search button, the text
in the Instant Search box or Address bar is sent to the search provider.
If you use a Microsoft search provider, use of the information sent is
subject to the Microsoft Online Privacy Statement. This statement is
available at go.microsoft.com/fwlink/?linkid=31493. If you use a third-
party search provider, use of the information sent will be subject to

the third party’s privacy practices. You can turn search suggestions off
at any time. To do so, use Manage Add-ons under the Tools button in
Internet Explorer. For more information about the search suggestions
service, see go.microsoft.com/fwlink/?linkid=128106.

Consent to Update Infrared Emitter/Receiver. The software may contain

technology to ensure the proper functioning of the infrared emitter/
receiver device shipped with certain Media Center-based products. You
agree that the software may update the firmware of this device.

Media Center Online Promotions. If you use Media Center features of

the software to access Internet-based content or other Internet-based

services, such services may obtain the following information from the

software to enable you to receive, accept and use certain promotional
offers:

e certain device information, such as your Internet protocol address,
the type of operating system and browser you are using, and the
name and version of the software you are using,

e the requested content, and

e the language code of the device where you installed the software.

* Your use of the Media Center features to connect to those services
serves as your consent to the collection and use of such information.

Media Playback Updates. The software on the device may include

media playback features which receives updates directly from the
MSCORP Media Playback Update servers. If activated by your
manufacturer, these updates will be downloaded and installed without
further notice to you. The manufacturer is responsible for ensuring

these updates work on your device.

e Windows Update Agent. The software on the device includes Windows
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Update Agent (“WUA”). This feature enables your device to access
Windows Updates either directly from MSCORP Windows Update
server or from a server installed with the required server component
and from the Microsoft Windows Update server. To enable the proper
functioning of the Windows Update service in the software (if you

use it) updates or downloads to the Windows Update service will be
required from time to time and downloaded and installed without
further notice to you. Without limiting any other disclaimer in these
license terms or any license terms accompanying a Windows Update,
you acknowledge and agree that no warranty is provided by Microsoft
Corporation or their affiliates with respect to any Windows Update that
you install or attempt to install on your device.

b. Use of Information. Microsoft may use the device information, error
reports, and Malware reports to improve our software and services. We
may also share it with others, such as hardware and software vendors.
They may use the information to improve how their products run with
Microsoft software.

c. Misuse of Internet-based Services. You may not use these services in
any way that could harm them or impair anyone else’s use of them. You
may not use the services to try to gain unauthorized access to any service,

data, account or network by any means.

7. PRODUCT SUPPORT. Contact Grass Valley, Inc. for support options. Refer to

the support number provided with the device.

8. MICROSOFT .NET BENCHMARK TESTING. The software includes one or
more components of the .NET Framework (“.NET Components”). You may
conduct internal benchmark testing of those components. You may disclose the
results of any benchmark test of those components, provided that you comply
with the conditions set forth at go.microsoft.com/fwlink/?LinkID=66406.

Notwithstanding any other agreement you may have with Microsoft, if you
disclose such benchmark test results, Microsoft shall have the right to disclose
the results of benchmark tests it conducts of your products that compete

with the applicable .NET Component, provided it complies with the same
conditions set forth at go.microsoft.com/fwlink/?LinkID=66406.

9. BACKUP COPY. You may make one backup copy of the software. You may

use it only to reinstall the software on the device.

10.DOCUMENTATION. Any person that has valid access to your device or
internal network may copy and use the documentation for your internal,

reference purposes.
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11.PROOF OF LICENSE. If you acquired the software on the device, or on a

disc or other media, a genuine Certificate of Authenticity label with a genuine
copy of the software identifies licensed software. To be valid, this label must
be affixed to the device, or included on or in Grass Valley, Inc.’s software
packaging. If you receive the label separately, it is not valid. You should keep
the label on the device or packaging to prove that you are licensed to use the

software. To identify genuine Microsoft software, see www.howtotell.com.

12.TRANSFER TO A THIRD PARTY. You may transfer the software only with the

device, the Certificate of Authenticity label, and these license terms directly to
a third party. Before the transfer, that party must agree that these license terms
apply to the transfer and use of the software. You may not retain any copies of
the software including the backup copy.

13.NOTICE ABOUT THE H.264/AVC VISUAL STANDARD, THE VC-1 VIDEO

STANDARD, THE MPEG-4 VISUAL STANDARD AND THE MPEG-2 VIDEO
STANDARD. This software may include H.264/AVC, VC-1, MPEG-4 Part 2,
and MPEG-2 visual compression technology. If the software includes those
visual compression technologies MPEG LA, L.L.C. requires this notice:

THIS PRODUCT IS LICENSED UNDER ONE OR MORE VIDEO PATENT
PORTFOLIO LICENSES SUCH AS, AND WITHOUT LIMITATION, THE
AVC, THE VC-1, THE MPEG-4 PART 2 VISUAL, AND THE MPEG 2

VIDEO PATENT PORTFOLIO LICENSES FOR THE PERSONAL AND
NON-COMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN
COMPLIANCE WITH THE ABOVE STANDARDS (“VIDEO STANDARDS”)
AND/OR (ii) DECODE VIDEO THAT WAS ENCODED BY A CONSUMER
ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE
VIDEO UNDER SUCH PATENT PORTFOLIO LICENSES. NONE OF THE
LICENSES EXTEND TO ANY OTHER PRODUCT REGARDLESS OF
WHETHER SUCH PRODUCT IS INCLUDED WITH THIS PRODUCT IN A
SINGLE ARTICLE. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED
FROM MPEG LA, L.L.C. SEE WWW.MPEGLA.COM.

14.NOTICE ABOUT THE MP3 AUDIO STANDARD. This software includes MP3

audio encoding and decoding technology as defined by ISO/IEC 11172-3 and
ISO/IEC 13818-3. It is not licensed for any implementation or distribution in

any commercial product or service.

15.NOT FAULT TOLERANT. The software is not fault tolerant. Grass Valley,

Inc. installed the software on the device and is responsible for how it
operates on the device.

August 3, 2012



MICROSOFT SOFTWARE LICENSE TERMS (WINDOWS EMBEDDED STANDARD 7)

August 3, 2012

16.RESTRICTED USE. The Microsoft software was designed for systems that do

not require fail-safe performance. You may not use the Microsoft software in
any device or system in which a malfunction of the software would result in
foreseeable risk of injury or death to any person. This includes operation of
nuclear facilities, aircraft navigation or communication systems and air traffic

control.

17.NO WARRANTIES FOR THE SOFTWARE. The software is provided “as

is”. You bear all risks of using it. Microsoft gives no express warranties,
guarantees or conditions. Any warranties you receive regarding the
device or the software do not originate from, and are not binding on,
Microsoft or its affiliates. When allowed by your local laws, Grass Valley,
Inc. and Microsoft exclude implied warranties of merchantability, fithess
for a particular purpose and non-infringement.

18.LIABILITY LIMITATIONS. You can recover from Microsoft and its affiliates

only direct damages up to two hundred fifty U.S. Dollars (U.S. $250.00).
You cannot recover any other damages, including consequential, lost
profits, special, indirect or incidental damages.

This limitation applies to:

¢ anything related to the software, services, content (including
code) on third party internet sites, or third party programs, and

e claims for breach of contract, breach of warranty, guarantee or
condition, strict liability, negligence, or other tort to the extent
permitted by applicable law.

It also applies even if Microsoft should have been aware of the
possibility of the damages. The above limitation may not apply to you
because your country may not allow the exclusion or limitation of
incidental, consequential or other damages.

19.EXPORT RESTRICTIONS. The software is subject to United States export

laws and regulations. You must comply with all domestic and international
export laws and regulations that apply to the software. These laws include
restrictions on destinations, end users and end use. For additional information,

see www.microsoft.com/exporting.

20.ENTIRE AGREEMENT. This agreement, additional terms (including any

printed-paper license terms that accompany the software and may modify or
replace some or all of these terms), and the terms for supplements, updates,
Internet-based services and support services that you use, are the entire

agreement for the software and support services.
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21.APPLICABLE LAW

a. United States. If you acquired the software in the United States,
Washington state law governs the interpretation of this agreement and
applies to claims for breach of it, regardless of conflict of laws principles.
The laws of the state where you live govern all other claims, including
claims under state consumer protection laws, unfair competition laws,

and in tort.

b. Outside the United States. If you acquired the software in any other
country, the laws of that country apply.

22.Third Party Programs. Microsoft provides the following copyright notices
for third party software included in the software. These notices are
required by the respective copyright holders and do not change your
license to use this software.

Portions of this software are based in part on the work of Spider Systems ®
Limited. Because Microsoft has included the Spider Systems Limited software
in this product, Microsoft is required to include the following text that

accompanied such software:

Copyright 1987 Spider Systems Limited
Copyright 1988 Spider Systems Limited
Copyright 1990 Spider Systems Limited

Portions of this software are based in part on the work of Seagate Software.
Portions of this software are based in part on the work of ACE*COMM Corp.
Because Microsoft has included the ACE*COMM Corp. software in this product,
Microsoft is required to include the following text that accompanied such

software:

Copyright 1995-1997 ACE*COMM Corp

Portions of this software are based in part on the work of Sam Leffler and
Silicon Graphics, Inc. Because Microsoft has included the Sam Leffler and Silicon
Graphics software in this product, Microsoft is required to include the following

text that accompanied such software:

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written

permission of Sam Leffler and Silicon Graphics.
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY
OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS

BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

Portions Copyright © 1998 PictureTel Corporation

Portions of this software are based in part on the work of Highground Systems.
Because Microsoft has included the Highground Systems software in this
product, Microsoft is required to include the following text that accompanied

such software:

Copyright © 1996-1999 Highground Systems

Windows 7 incorporates compression code from the Info-ZIP group. There are no
extra charges or costs due to the use of this code, and the original compression
sources are freely available from www.info-zip.org/ or ftp://ftp.info-zip.org/pub/

infozip/src/ on the Internet.
Portions Copyright © 2000 SRS Labs, Inc

This product includes software from the 'zlib' general purpose compression

library.

Portions of this software are based in part on the work of ScanSoft, Inc. Because
Microsoft has included the ScanSoft, Inc. software in this product, Microsoft is
required to include the following text that accompanied such software:

TextBridge® OCR © by ScanSoft, Inc.

Portions of this software are based in part on the work of University of Southern
California. Because Microsoft has included the University of Southern California
software in this product, Microsoft is required to include the following text that

accompanied such software:

Copyright © 1996 by the University of Southern California
All rights reserved.

Permission to use, copy, modify, and distribute this software and
its documentation in source and binary forms for any purpose and
without fee is hereby granted, provided that both the above copyright

notice and this permission notice appear in all copies, and that any
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documentation, advertising materials, and other materials related

to such distribution and use acknowledge that the software was
developed in part by the University of Southern California, Information
Sciences Institute. The name of the University may not be used to
endorse or promote products derived from this software without

specific prior written permission.

THE UNIVERSITY OF SOUTHERN CALIFORNIA makes no
representations about the suitability of this software for any purpose.
THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.

Other copyrights might apply to parts of this software and are so noted
when applicable.

Portions of this software are based in part on the work of James Kanze. Because
Microsoft has included the James Kanze software in this product, Microsoft is

required to include the following text that accompanied such software:

COPYRIGHT AND PERMISSION NOTICE
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, publish, distribute, and/or
sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, provided that the above copyright notice(s) and
this permission notice appear in all copies of the Software and that
both the above copyright notice(s) and this permission notice appear
in supporting documentation. Permission is also given to modify

the software to any extend, under the condition that, in the modified
software, the prefix "GB_" is changed to something else, and the name

"

directories for includes files (g

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD
PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER
OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION

OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,

in this distribution) is also changed.
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ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall
not be used in advertising or otherwise to promote the sale, use or other
dealings in this Software without prior written authorization of the

copyright holder.

This product contains software from Cisco ISAKMP Services.

Portions of this software are based in part on the work of RSA Data Security,
Inc. Because Microsoft has included the RSA Data Security, Inc. software in this
product, Microsoft is required to include the following text that accompanied

such software:

Copyright © 1990, RSA Data Security, Inc. All rights reserved.

License to copy and use this software is granted provided that it

is identified as the "RSA Data Security, Inc. MD5 Message-Digest
Algorithm" in all material mentioning or referencing this software

or this function. License is also granted to make and use derivative
works provided that such works are identified as "derived from the
RSA Data Security, Inc. MD5 Message-Digest Algorithm" in all material

mentioning or referencing the derived work.

RSA Data Security, Inc. makes no representations concerning either the
merchantability of this software or the suitability of this software for
any particular purpose. It is provided "as is" without express or implied

warranty of any kind.

These notices must be retained in any copies of any part of this

documentation and/or software.

Portions of this software are based in part on the work of OpenVision
Technologies, Inc. Because Microsoft has included the OpenVision Technologies,
Inc. software in this product, Microsoft is required to include the following text

that accompanied such software:
Copyright 1993 by OpenVision Technologies, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee,
provided that the above copyright notice appears in all copies and
that both that copyright notice and this permission notice appear

in supporting documentation, and that the name of OpenVision

not be used in advertising or publicity pertaining to distribution of
the software without specific, written prior permission. OpenVision
makes no representations about the suitability of this software for any
purpose. It is provided "as is" without express or implied warranty.
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OPENVISION DISCLAIMS ALL WARRANTIES WITH REGARD

TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
OPENVISION BE LIABLE FOR ANY SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN
AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE
OR PERFORMANCE OF THIS SOFTWARE.

Portions of this software are based in part on the work of Regents of The
University of Michigan. Because Microsoft has included the Regents of The
University of Michigan software in this product, Microsoft is required to include

the following text that accompanied such software:

Copyright © 1995, 1996 Regents of The University of Michigan.
All Rights Reserved.

Permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted,
provided that the above copyright notice appears in all copies and

that both that copyright notice and this permission notice appear

in supporting documentation, and that the name of The University

of Michigan not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.
This software is supplied as is without expressed or implied warranties

of any kind.

Copyright © 1993, 1994 Regents of the University of Michigan.
All rights reserved.

Redistribution and use in source and binary forms are permitted
provided that this notice is preserved and that due credit is given to the
University of Michigan at Ann Arbor. The name of the University may
not be used to endorse or promote products derived from this software
without specific prior written permission. This software is provided “as

is" without express or implied warranty.

Portions of this software are based in part on the work of Massachusetts Institute
of Technology. Because Microsoft has included the Massachusetts Institute
of Technology software in this product, Microsoft is required to include the

following text that accompanied such software:

Copyright 1989, 1990 by the Massachusetts Institute of Technology. All
Rights Reserved.

Export of this software from the United States of America may

require a specific license from the United States Government. It is the

August 3, 2012



MICROSOFT SOFTWARE LICENSE TERMS (WINDOWS EMBEDDED STANDARD 7)

August 3, 2012

responsibility of any person or organization contemplating export to

obtain such a license before exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify,

and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the
name of MLLT. not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.
M.IT. makes no representations about the suitability of this software for

any purpose. It is provided "as is" without express or implied warranty.

Under U.S. law, this software may not be exported outside the US
without license from the U.S. Commerce department.

Copyright 1994 by the Massachusetts Institute of Technology. All Rights
Reserved.

Export of this software from the United States of America may
require a specific license from the United States Government. It is the
responsibility of any person or organization contemplating export to

obtain such a license before exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify,

and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the
name of MLLT. not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.
M.LT. makes no representations about the suitability of this software for
any purpose. It is provided "as is" without express or implied warranty.

This product includes software developed by the University of California,
Berkeley and its contributors.

Portions of this software are based in part on the work of the "Entrust” security
technology licensed from Northern Telecom.

Portions of this software are based in part on the work of Hewlett-Packard
Company. Because Microsoft has included the Hewlett-Packard Company
software in this product, Microsoft is required to include the following text that

accompanied such software:

Copyright © 1994 Hewlett-Packard Company

Permission to use, copy, modify, distribute and sell this software and its

documentation for any purpose is hereby granted without fee, provided
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that the above copyright notice appear in all copies and that both that
copyright notice and this permission notice appear in supporting
documentation. Hewlett-Packard Company and Microsoft Corporation
make no representations about the suitability of this software for any

purpose. It is provided "as is" without express or implied warranty.
This product includes software from the 'libpng' PNG reference library.

Portions of this software are based in part on the work of Autodesk, Inc. Because
Microsoft has included the Autodesk, Inc. software in this product, Microsoft is
required to include the following text that accompanied such software:

© Copyright 1995 by Autodesk, Inc.

This product contains graphics filter software; this software is based in part on
the work of the Independent JPEG Group.

This product includes “True Verb” technology from KS Waves Ltd.

Portions of this software are based in part on the work of SGS-Thomson
Microelectronics, Inc. Because Microsoft has included the SGS-Thomson
Microelectronics, Inc. software in this product, Microsoft is required to include

the following text that accompanied such software:

Copyright 1996 SGS-Thomson Microelectronics, Inc. All Rights
Reserved

Portions of this software are based in part on the work of Unicode, Inc. Because
Microsoft has included the Unicode, Inc. software in this product, Microsoft is
required to include the following text that accompanied such software:

COPYRIGHT AND PERMISSION NOTICE

Copyright © 19912005 Unicode, Inc. All rights reserved. Distributed

under the Terms of Use in www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a
copy of the Unicode data files and any associated documentation (the
"Data Files") or Unicode software and any associated documentation
(the "Software") to deal in the Data Files or Software without restriction,
including without limitation the rights to use, copy, modify, merge,
publish, distribute, and/or sell copies of the Data Files or Software, and
to permit persons to whom the Data Files or Software are furnished

to do so, provided that (a) the above copyright notice(s) and this
permission notice appear with all copies of the Data Files or Software,
(b) both the above copyright notice(s) and this permission notice
appear in associated documentation, and © there is clear notice in each
modified Data File or in the Software as well as in the documentation

associated with the Data File(s) or Software that the data or software
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has been modified.

THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS",
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN
THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL
INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THE DATA FILES OR
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall
not be used in advertising or otherwise to promote the sale, use or
other dealings in these Data Files or Software without prior written
authorization of the copyright holder.

The Combined PostScript Driver was the result of a cooperative development

process by Adobe Systems Incorporated and Microsoft Corporation.

Portions of this software are based in part on the work of Media Cybernetics.
Because Microsoft has included the Media Cybernetics software in this product,
Microsoft is required to include the following text that accompanied such
software:

HALO Image File Format Library © 1991-1992 Media Cybernetics, Inc.

Portions of this software are based in part on the work of Luigi Rizzo. Because
Microsoft has included the Luigi Rizzo software in this product, Microsoft is

required to include the following text that accompanied such software:
© 1997-98 Luigi Rizzo (luigi@iet.unipi.it)

Portions derived from code by Phil Karn (karn@ka9q.ampr.org),
Robert Morelos-Zaragoza (robert@spectra.eng.hawaii.edu) and Hari
Thirumoorthy (harit@spectra.eng.hawaii.edu), Aug 1995

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
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notice, this list of conditions and the following disclaimer in the

documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHORS “AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE AUTHORS BE LIABLE FOR ANY

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER

IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

Portions of this software are based in part on the work of W3C. Because
Microsoft has included the W3C software in this product, Microsoft is required

to include the following text that accompanied such software:

W3C ® SOFTWARE NOTICE AND LICENSE
www.w3.org/Consortium/Legal/2002/copyright-software-20021231

This work (and included software, documentation such as READMEs,
or other related items) is being provided by the copyright holders
under the following license. By obtaining, using and/or copying this
work, you (the licensee) agree that you have read, understood, and will
comply with the following terms and conditions.

Permission to copy, modity, and distribute this software and its
documentation, with or without modification, for any purpose and
without fee or royalty is hereby granted, provided that you include the
following on ALL copies of the software and documentation or portions
thereof, including modifications:

1. The full text of this NOTICE in a location viewable to users of the
redistributed or derivative work.

2. Any pre-existing intellectual property disclaimers, notices, or terms
and conditions. If none exist, the W3C Software Short Notice should be
included (hypertext is preferred, text is permitted) within the body of
any redistributed or derivative code.

3. Notice of any changes or modifications to the files, including the date
changes were made. (We recommend you provide URLSs to the location
from which the code is derived.)
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THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS,"
AND COPYRIGHT HOLDERS MAKE NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF THE
SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE ANY
THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER
RIGHTS.

COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT,
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF ANY USE OF THE SOFTWARE OR DOCUMENTATION.

The name and trademarks of copyright holders may NOT be used in
advertising or publicity pertaining to the software without specific,
written prior permission. Title to copyright in this software and any
associated documentation will at all times remain with copyright
holders.

Portions of this software are based in part on the work of Sun Microsystems,
Inc. Because Microsoft has included the Sun Microsystems, Inc. software in this
product, Microsoft is required to include the following text that accompanied

such software:

Sun RPC is a product of Sun Microsystems, Inc. and is provided for
unrestricted use provided that this legend is included on all tape media
and as a part of the software program in whole or part. Users may copy
or modify Sun RPC without charge, but are not authorized to license

or distribute it to anyone else except as part of a product or program
developed by the user.

SUN RPC IS PROVIDED AS IS WITH NO WARRANTIES OF

ANY KIND INCLUDING THE WARRANTIES OF DESIGN,
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE,
OR ARISING FROM A COURSE OF DEALING, USAGE OR TRADE
PRACTICE.

Sun RPC is provided with no support and without any obligation
on the part of Sun Microsystems, Inc. to assist in its use, correction,
modification or enhancement.

SUN MICROSYSTEMS, INC. SHALL HAVE NO LIABILITY WITH
RESPECT TO THE INFRINGEMENT OF COPYRIGHTS, TRADE
SECRETS OR ANY PATENTS BY SUN RPC OR ANY PART THEREOEF.

In no event will Sun Microsystems, Inc. be liable for any lost revenue or

profits or other special, indirect and consequential damages, even if Sun
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has been advised of the possibility of such damages.

Sun Microsystems, Inc.
2550 Garcia Avenue
Mountain View, California 94043

Manufactured under license from Dolby Laboratories. “Dolby” and the double-D
symbol are trademarks of Dolby Laboratories. Confidential unpublished works.
Copyright 1992-1997 Dolby Laboratories. All rights reserved.

Portions of this software are based in part on the work of Andrei Alexandrescu.
Because Microsoft has included the Andrei Alexandrescu software in this
product, Microsoft is required to include the following text that accompanied
such software:

The Loki Library

Copyright © 2001 by Andrei Alexandrescu

This code accompanies the book:

Alexandrescu, Andrei. "Modern C++ Design: Generic Programming and
Design Patterns Applied." Copyright © 2001. Addison-Wesley.
Permission to use, copy, modify, distribute and sell this software for
any purpose is hereby granted without fee, provided that the above
copyright notice appear in all copies and that both that copyright notice
and this permission notice appear in supporting documentation.

The author or Addison-Welsey Longman make no representations
about the suitability of this software for any purpose. It is provided "as
is" without express or implied warranty.

Portions Copyright © 1995 by Jeffrey Richter

Portions of this software are based in part on the work of the Distributed
Management Task Force, Inc. (DMTF). Because Microsoft has included software
based on DMTF specifications in this product, Microsoft is required to include
the following text:

Copyright © 2007 Distributed Management Task Force, Inc. (DMTF). All
rights reserved.

Portions of this work are derived from "The Draft Standard C++ Library"
Copyright © 1995 by PJ. Plauger published by Prentice-Hall and are used with
permission.

Portions of this software are based in part on the work of Hewlett-Packard
Company. Because Microsoft has included the Hewlett-Packard Company
software in this product, Microsoft is required to include the following text that
accompanied such software:

Copyright © 2002, 2003 Hewlett-Packard Company:.
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About Notice:
This software is based on software available from mpvtools.

sourceforge.net.

This software processes a format called MPV. MPV is an open
specification for managing collections and multimedia playlists of
photo, video, and music content and associated metadata and is
available at no cost from the Optical Storage Technology Association.
More information about the MPV specification can be found at www.
osta.org/mpv.

Permission Notice:

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit
persons to whom the Software is furnished to do so, subject to the

following conditions:

The above copyright notice, this permission notice, and the above
About Notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT
SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall
not be used in advertising or otherwise to promote the sale, use or other
dealings in this Software without prior written authorization of the
copyright holder.

All other trademarks are property of their respective owners.
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T2 is multi-channel video disk recorder that allows simultaneous video
recording and playing and has 1 input and 2 output channels. Video and
audio data are saved in the built-in data drive.

T2 has pre-installed software that performs recording/editing/playing of
video and creating or playing of playlists. The following two operation
modes are available depending on the environment.

> Front panel mode

You can operate this mode by tapping the display on the touch screen LCD
on the T2 front panel. The operation is available under minimum network
environment.

The basic operations can be performed only on the front panel mode.

> Workstation mode
You can connect and use a PC monitor, mouse, and keyboard to T2 in this
mode.

All functions are available in this mode.
Operations in Workstation Mode» P153

The operating instructions on this manual describe procedures in the front
panel mode.

Changes in the specifications by upgrade

T2 User Manual

For the added and changed specifications by the upgrade from T2 BASIC/
T2 RAID/T2 SSD to T2 Express/T2 Pro/T2 Elite, see “Specification Change
List”.

Specification Change List»P219
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The indications and the meanings are as follows.

Section 4 — Connection/Start-up/Exit

Connecting peripheral devices
The procedure to connect peripheral devices such as external input/output
device to T2 is described in this part.
1 Connect a device for R1 channel input to T2.
Connect a device to the analog audio input/output section or R1 input
section on T2 rear panel.
Analog audio input/output section»p. 38
R1 input section»p. 38
(1 ) TP  YPbPr signal is input via the analog RGB pins on the DVI-I port. To
input YPbPr signal, use an analog RGB conversion connector cable.

2 Connect a device for P1/P2 channel output to T2.

Connect a device to the analog audio input/output section or P1/P2 output
section on T2 rear panel.
(2) Analog audio input/output section»p. 38
P1/P2 output section»p. 39
Supported video format and output terminal»p. 205

TIP  YPbPr signal is input via analog RGB pins on the DVII port. To
output YPbPr signal, use an analog RGB conversion connector cable.

3 If you wish to operate T2 in the workstation mode, connect a
mouse, keyboard, and PC monitor (optional) to T2.

Connect the mouse and keyboard to the USB (2.0) port, and connect the

PC monitor to the monitor port.

Rear panel»p. 37

If you wish to operate T2 in the front panel mode, you do not need to

connect a mouse, keyboard, and PC monitor.

4 Insert the power cable to the inlet of T2.

51f necessary, fix the power cable fixing clamp using the provided

(3) NOTE  * When fixing the power cable fixing clamp, be careful not to
loosen the fixing screw of the fan on the power unit.

46 T2 User Manual August 3, 2012

*The illustration on this page is only for explanation purpose. It differs
from the actual page on this manual.

(1) | TiP Describes important points for operations.

(2) | Reference page Indicates related pages.

Describes cautions and restrictions for
operations.

(3) | NOTE
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Part Names and Functions
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Front panel

T2 User Manual
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(1) | SSD drive bay Works as an SSD drive bay.
2) | Touch screen LCD Operates T2 by tapping the display on the
screen.
(3) | Power switch Turns on T2.
(4) | USB (2.0) ports Used to connect USB removable devices.
(5) | Volume control Used to adjust the headphone volume.
(6) | Headphone jack Used to connect a headphone.
Performs channel selection or playing back
(7) | Control buttons and recording of video.

Control buttons» P35
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Control buttons

(1) —r1
(2)—P1]
(3)—r2)

Front panel

rrren), B F B 00 0 (i maneaiot

) () (6) (7) (8)

™

[R1] button

Switches to 1ch view of the R1 channel. Makes
the R1 channel active.

()

[P1] button

Switches to the 1ch view of P1 channel. Makes
the P1 channel active.

@)

[P2] button

Switches to the 1ch view of P2 channel. Makes
the P2 channel active.

(4)

[Rew] button

By every press, moves back frame by frame.
Holding on the button will rewind by 32 times
speed.

)

[Play] button

Starts playback.

(6)

[FF] button

By every press, moves forward frame by frame.
Holding on the button will fast-forward by 32
times speed.

(7)

[Stop] button

Stops playback or recording.

(8)

[Rec] button

Starts recording.

(9)

[SHTL/JOG]
hutton

Switches to the jog/shuttle mode.
Playing back in jog/shuttle mode» P99

(10)

[VAR] button

Switches to the variable speed mode.
Displays the speed controller and allows to
change the playback speed.

Playing back in variable speed mode (variable
playback)» P98

(1)

Jog/Shuttle

When the [SHTL/JOG] button is on, executes jog/
shuttle playback operations.

When the [VAR] button is on, executes variable
speed playback.

August 3, 2012
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Rear panel

T2 User Manual

[Rew] + [Stop] buttons

While playing a clip, moves to the previous
In/Out point or to the top of the clip.

While playing a playlist, moves to the
previous event.

[FF] + [Stop] buttons

While playing a clip, moves to the previous
In/Out point or to the end of the clip.
While playing a playlist, moves to the next
event.
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(10)
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(11) (12) (13) (14) (15)

™

AC Power inlet (3-
pin)

Used to connect to the AC power outlet
with the supplied power cable.

(2)

Main power switch

Turns on/off the main power.

@)

Analog audio input/
output section

Used for analog audio input/output.
Analog audio input/output section» P37

(4)

LAN port

Used to connect a LAN cable.

)

R1 input section

Used for input to the R1 channel.
R1 input section» P38

(6)

P1 output section

Used for output from the P1 channel.
P1/P2 output section» P38

(7)

P2 output section

Used for output from the P2 channel.
P1/P2 output section» P38

(8)

Monitor (VGA) port

Used to connect a PC monitor.

(9)

Monitor (DVI-D) port

Used to connect a PC monitor.

(10)

USB (2.0) port

Used to connect a keyboard, mouse, and so
on.
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Rear panel

(11) | Sound Not used.
(12) | REFIN Used to input REF signal.
(13) | GP11/0 Used for GPI input/output.

Used for remote control of R1, P1, P2
channels.

(15) | MONITOR Used for audio monitor.

(14) | REMOTE RS422 port

NOTE e In the workstation mode, you cannot use T2 with the monitor
ports (VGA/DVI-D) connected simultaneously. (Exclusive use
only)

¢ Be sure to turn off your T2 when removing and inserting the
cable for the monitor ports.

Analog audio input/output section

(1) ) @)

A —) —®) )
@t 7 — ANALOG AUDIO _ P
Used for audio input to the R1 channel.
R1 - CH1 .
(1) R1 - CH? (Balanced audio input.)
XLR-3-31 x 2 (CH1 - 2)
Used for audio output to the P1 channel.
P1-CH1 .
(2) P1 - CH2 (Balanced audio output.)
XLR-3-32 x 2 (CH1 - 2)
Used for audio output to the P2 channel.
P2 - CH1 .
(3) P2 - CH2 (Balanced audio output.)
XLR-3-32 x 2 (CH1 - 2)
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R1 input section

INPUT | C LG ) (AESIEBU) (CNPST)
HD/SD

R“E“@ @ @ G
) ® ®

(1) (2) (3) (4) ®)

(1) | LTC Used for LTC (timecode) input.

(2) | AES/EBU Used for digital audio (AES/EBU) input.

(3) | CMPST Used for composite input.

(4) | DVI-I Used for DVI-Iinput. (Also for DVI and YPbPr.)

5) | SDI Used for SDI input (left), and for active
through (right).

TIP ® YPbPr signal is input via the analog RGB pins on the DVI-I
port. To input YPbPr signal, use an analog RGB conversion
connector cable.

P1/P2 output section

(CLTc ) (AESEBU) (CWMPST) Covia ) SDI
OUTPUT =

"l ) ©liz

PLAYER
(LTC ) |AES[EBU) | CMPST)
QUTPUT =

"l [ e @{

mn @ @ (4) ® (®

M‘@
R
OIOH

(1) | LTC Used for LTC (timecode) output.

(2) | AES/EBU Used for digital audio (AES/EBU) output.

(3) | CMPST Used for composite output.

@) | DvI-l Used for DVI-I output. (Also for DVI, RGB,
and YPbPr.)

(5) | SDI Used for SDI output.

(6) | MONITOR Used for monitor output (composite).

TIP * YPbPr signal is output via the analog RGB pins on the DVI-I
port. To output YPbPr signal, use an analog RGB conversion
connector cable.
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Section

Connection/Start-up/Exit

This section describes how to attach T2 iDDR Rack Mount Kit (optional),
how to connect peripheral devices to T2, start-up and exit procedures, and
switching procedures of front panel mode and workstation mode.

Attaching T2 iDDR Rack Mount Kit (optional)

The procedure to set T2 to a rack using T2 iDDR Rack Mount Kit (optional)
is described in this part.

Parts of T2 iDDR Rack Mount Kit

T2 iDDR Rack Mount Kit includes two rails for the left and right sides and
other accessories.

The following illustration shows the right side of the parts of T2 iDDR Rack
Mount Kit. (The parts are same on the left side.)

305A slide rail
Middle cabinet section
305A slide rail Pan-head screw
Drawer section M4x10
Pan-head screw
M5x10
Latch (slide lock) -
Pan-head screw - R

Pan-head screw

M5 (with washer)
Nut

X e ’ \),
N \\; l:§__ ?% M5 (with washer)
T 5

Mounting bracket BK5517

- Nut
e M4 (with washer)
Pan-head screw Nut -
M5x10 M4 (with washer)
Pan-head inch screw Pan-head screw
No. 10-32UNF M4x12 (with SW) Mounting bracket BK5517

or
Pan-head inch screw

No. 12-24UNC 3U mounting bracket
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Setting to a 19 inch rack

T2 iDDR Rack Mount Kit supports EIAJ 19 inch unit rack.
With the brackets supplied with T2 iDDR Rack Mount Kit, set your T2 to
the mounting holes of the mounting chassis of the EIAJ 19 inch unit rack.

EIAJ 19 inch unit chassis specifications

Wide pitch Universal pitch
g g
| 1.250 in | 0.625in
. : 0.625 in
i 0.500 in . 0.500 in
Repeated . Repeated
pitch . pitch

Setting T2 to a rack

The procedure to attach T2 iDDR Rack Mount Kit to a rack and set T2 is
described in this part.

NOTE e The screws can come loose because of the movement of the
slide rails. To set this product, make sure that the screws are
firmly fastened. (If the product is not fixed firmly, the drawer
may not move smoothly.)

* When you operate your T2 set in a rack, in order to dissipate
the exhaust heat, be sure that there is enough space between
the devices set above and below so that the heat can be easily
released. (When devices are set too close to each other, their
internal temperatures may increase, causing problems or
malfunctions.)
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Attaching T2 iDDR Rack Mount Kit (optional)

1 Disassembly of slide rail

If you pull out the slide rail to as far as it goes in the direction of the
arrow in the illustration, the latch on the drawer section (slide lock) will
automatically lock the slide rail.

To disassemble, push the tip of the latch (slide lock) to unlock, and pull the
drawer section in the direction shown in the arrow.

Disassemble the slide rail on the other side in the same procedure.

NOTE - Be careful not to get your fingers jammed in the moving parts
when pulling out the slide rail.
¢ A small amount of oil is applied on the moving parts of the
drawer and middle cabinet sections for the smooth slide
movements. Be careful when handling those parts.

305A slide rail

Latch (slide lock) l

Middle cabinet section

Drawer section
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2 Set the mounting bracket to the slide rails (middle cabinet
section).

Set the mounting bracket (two pieces) to the middle cabinet section and
affix them.

Set the mounting bracket to the other side of the middle cabinet section in
the same procedure.

Mounting bracket
BK5517

305A slide rail

Nut Middle cabinet section

M4 (with washer)

e Mounting bracket
] BK5517

Nut
M4 (with washer)

Pan-head screw
M4x10

Pan-head screw
M4x10

3 Set the slide rails (middle cabinet section) to the rack.

After affixing the bracket to the panel mounting frame, fasten the screws to
affix the slide rail and the bracket so that they are firmly fastened.

Set the slide rail on the other side to the rack in the same procedure.

To mount your T2 to a rack, make sure that the two rails are set at the same
height, and be sure to fasten the mounting brackets on both ends to the rack
(panel mounting frame).

TIP * When using female screws on the panel mounting frame,
follow the instructions and use screws specified for the rack.

Rack panel mounting frame
(Both front and rear sides)

Pan-head screw
M5x10

P

b oo 0 00 0 oo b ob o oof

Nut
M5 (with washer)
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Attaching T2 iDDR Rack Mount Kit (optional)

4 Set the 3U mounting bracket and slide rail (drawer section) to
the T2 body.

Set the 3U mounting bracket and slide rail (drawer section) to the side of
the T2 body.

Set the other 3U mounting bracket and slide rail (drawer section) to the
other side of your T2, in the same way.

When setting slide rails to the left and right sides, make sure that both rails
are set at the same height.

305A slide rail
Drawer section

T s Pan-head screw
M4x10
Pan-head screw
M4x12 (with SW)
3U mounting bracket

5 Set T2 to the slide rails attached on the rack.

Insert the slide rails (drawer section) attached on both sides of T2 into the
slide rails (middle cabinet section) to set your T2 to the rack.

T2 will mount smoothly without locking the latch (slide lock), when setting
your T2 to a rack. If you try to forcefully slide your T2 into the rack, the
slide rails may be damaged.

Make sure that T2 can be mounted all the way to the end, and that T2 can
then be smoothly slid out, and then affix the 3U mounting bracket to the
rack panel mounting frame.

TIP ¢ If your T2 cannot slide smoothly in the rack, the position and
angle of the slide rails must be adjusted. check the positions
of the parts and adjust them so that the slide rails move
smoothly.

* Some rack types may not fit the accessories (screws) of this
product. Check the specifications of your rack, and use the
recommended parts for your rack.
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Operating after set up

When you slide your T2 out from a rack, if you remove the fixing screws of
the 3U mounting brackets set on the left and right sides of the T2, the latch
automatically locks at the position where the T2 was fully slid out.

To pull your T2 out from a rack, or to slide it back into a rack again, push
down the tip of the latches on the slide rails (drawer section) on both the left
and right sides, to unlock the slide rail.

NOTE © When you operate your T2 set in a rack, in order to dissipate
the exhaust heat, be sure that there is enough space between
the devices set above and below so that the heat can be easily
released. (When devices are set too close to each other, their
internal temperatures may increase, causing problems or
malfunctions.)

Connecting peripheral devices

The procedure to connect peripheral devices such as external input/output
device to T2 is described in this part.

1 Connect a device for R1 channel input to T2.

Connect a device to the analog audio input/output section or R1 input
section on T2 rear panel.

Analog audio input/output section» P37

R1 input section» P38

TIP * YPbPr signal is input via the analog RGB pins on the DVI-I port. To
input YPbPr signal, use an analog RGB conversion connector cable.

2 Connect a device for P1/P2 channel output to T2.

Connect a device to the analog audio input/output section or P1/P2 output
section on T2 rear panel.

Analog audio input/output section» P37

P1/P2 output section» P38

Supported video format and output port»P201

TIP * YPbPr signal is output via analog RGB pins on the DVI-I port. To
output YPbPr signal, use an analog RGB conversion connector cable.
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Starting up and exiting T2

3 If you wish to operate T2 in the workstation mode, connect a
mouse, keyboard, and PC monitor (optional) to T2.

Connect the mouse and keyboard to the USB (2.0) port, and connect the PC
monitor to the monitor port.

Rear panel» P36

If you wish to operate T2 in the front panel mode, you do not need to
connect a mouse, keyboard, and PC monitor.

4 Insert the power cable to the inlet of T2.

NOTE ° When fixing the power cable fixing clamp, be careful not to
loosen the fixing screw of the fan on the power unit.

6 Connect the power cable to the AC power outlet.
Starting up and exiting T2

Starting up T2

1 Turn on the main power switch on the T2 rear panel.

@II11e
\___ 0000000000©)

ﬁ‘
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2 Turn on the main power switch on the T2 front panel.

T

2 Q9
o o o o |

When starting up for the first time, T2 will start up in the front panel mode.
The display appears in the 3ch view on the touch screen LCD.

Other than the first time, T2 will start up in the previously used operation
mode (front panel mode or workstation mode).

TIP ¢ To start up T2 in the workstation mode, start up T2 in the front
panel mode, and then switch to the workstation mode.
Switching from the front panel mode to the workstation mode» P47
Once switched to the workstation mode, T2 will start up in the
workstation mode after the next start-up.

Exiting T2 in the front panel mode

NOTE ° Do not forcibly exit T2 by holding down the power switch or
turning off the main power switch. A malfunction may occur.

1 Press one of the [R1], [P1], or [P2] button.

You can also perform the operation by tapping [Ich View] on the touch
screen LCD or [Bin].

2 Tap [Menu], and then tap [Tools] -> [Exit].

Unload

Properties

3ch

Rename 2
View

Event Effect
Config.
Event Properties

Remote

T,
‘p TRIM O.g Transfer
Playout Mode

T2 to T2 Sync backup... Tools Remaining:

S13:58 (g
]

2:01PM ¢
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Switching front panel mode/workstation mode

3 Select [Shut Down] from the list and tap [OK].

To restart T2, select [Restart].
If you do not use T2 for a long time, turn off the main power switch on the
T2 rear panel and unplug the power cord.

Exiting T2 in workstation mode

NOTE * Do not forcibly exit T2 by holding down the power switch or
turning off the main power switch. A malfunction may occur.

1 On the PC monitor, click [System] on the menu bar, and click
[Exit].

2 Select [Shut Down] from the list and click [OK].

To restart T2, select [Restart].
If you do not use T2 for a long time, turn off the main power switch on the
T2 rear panel and unplug the power cord.

Switching front panel mode/workstation mode

August 3, 2012

Switching from the front panel mode to the workstation
mode

1 On the PC monitor, click [System] on the menu bar, and click
[Switch to Workstation mode].
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Switching from the workstation mode to the front panel
mode
1 Tap the touch screen LCD.

You can also switch the mode on the PC monitor, by clicking [System] on
the menu bar, and then clicking [Switch to Front Panel mode].

Checking the software version

You can check the software version of your T2.
1 Press one of the [R1], [P1], or [P2] button.

You can also perform the operation by tapping [Ich View] on the touch
screen LCD or [Bin].

2 Tap [Menu] on the touch screen LCD, and tap [Tools] -> [About
T2].

The version information of T2 is displayed.

4:55PM
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Section

Recording

This section describes the recording procedure in the R1 channel.

Displaying R1 channel in 1ch view

In the 1ch view of the R1 channel, various operations for recording are
available.

1 Press the [R1] button.

The display switches to the Ich view of the R1 channel, and the [R1] button
lights in green.

You can also switch by tapping [1ch View] and then tapping the R1 channel
tab.

> R1 channel — 1ch view
(1 @) @) (5)6)(7) (8) (9) (10)

4:56 PM

(11) (12)(13) (14) (15) (16)(17) (18)

By tapping, selects and highlights the R1

(1) | R1 channel tab channel.

(2) | Status Indicates the recording progress status.
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Locks R1 channel operations.
While the operations are locked, [Locked]

(3) | [Locked] and [R1] buttons light in red.
Tapping it again releases the lock.
Displays the video currently recorded.

(4) | Preview Tapping the preview displays in the full
screen view.

(5) | [Cur:] Indicates the current timecode.

(6) | Scrubbing bar Indicates the recording progress status.

. Indicates the elapsed time of recording by
(7) | [Elap:] timecode display.
(8) | Audio level display Displays input audio level.

(9)

[Menul

Displays the related menu.

(10)

Recording mode

Switches the recording mode (R1-live mode
/R1-VTR mode/R1-remote mode).

(1)

Operation buttons

Operation buttons of R1 channel» P51

(12)

[Clip:]

Displays the name of the clip currently
recorded.

(13)

[Record destination
hin]

Sets the saving destination of the recorded
clip.

The destination bin name is displayed in
the right.

(14)

[Length:]

If [Fixed Length] is on, sets the time length
(duration) from the start point to the end
point of recording by tapping the timecode.

(15)

[In:]1/[Out:]/[Dur:]

Indicates the timecode of In/Out points and
duration.

If fixed length recording mode is off, you
can set In or Out point by tapping the
timecode of [In:] or [Out:].

(16)

[Format:]

Displays the video size, frame rate, port
used for input, source TC (TC (LTC)/SDI
(VITC)/INT), etc.

(17)

[Fixed Length]

By tapping to set it on, automatically ends
recording after the duration specified in
[Length:] has passed.
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Displaying R1 channel in 1ch view

(18)

1ch view/3ch view/
bin/transfer screen
common area

1ch view/3ch view/hin/transfer screen
common area» P51

> Operation buttons of R1 channel
(1

2 © @ ©6

(6)

(1) | [Clear (In/Out)] Clears set In/Out points.
(2) | [Cue(In)]™ Moves the VIR to the In point.
(3) | [Mark(In)] Sets In point to the current position.
(4) | [Mark(Out)] Sets Out point to the current position.
(5) | [Cue(Out)]™ Moves the VIR to the Out point.

Creates a sub clip between In-Out points
(6) | [Create Subclip]™ set while recording, and saves it as

highlight.

*1  Only for R1-VTR mode.
*2 Only for R1-live mode.

> 1ch view/3ch view/bin/transfer screen common area

(1)

()

®3)

(4)

(®)

(6)

(7)

(8)
() | [Bin] Display the bin view.

Managing contents in the bin» P78
. Switches the currently selected channel to

(2) | [1ch View] 1ch view.
(3) | [3ch View] Switches to 3ch view.
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Displays the setting screen.

4 ig.
(4) | [Config.] Displaying the setting screen»P118

Display the transfer screen.

Transf
(5) | [Transfer] Checking the transfer status» P66

Displays the estimated recording time
Remaining HDD available on HDD.

(remaining time) When the remaining capacity reduces, the
icon is displayed in red.

(6)

Displayed when a removable drive such as
USB removable device, XDCAM, P2, GF,
(7) | [Remove Devicel] etc. is connected.

By tapping, disconnects the removable
device.

Displays the current time.

(8) | Time Set the time in the maintenance mode. For
more information about the maintenance
mode, refer to the T2 Maintenance Manual.

NOTE Ifthe icon appears in 1ch view/3ch view/bin/transfer
screen common area, there is a problem with the RAID
system. Consult the shop of purchase.

Selecting R1 channel in 3ch view

In 3ch view, you can view three channels, the video recorded in the R1
channel and the clip or playlist played in the P1/P2 channel simultaneously.
In 3ch view of the R1 channel, you can use the operation buttons on the
lower part of the touch screen LCD, to start and end of recording.

1 Tap [3ch View].

The display switches to 3ch view.
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Selecting R1 channel in 3ch view

2 Tap the R1 channel tab.

’
: 00:00:00;00

Config.

: Clip_05

. 00:06:43;07

: 00:00:06;13 Transfer

i 1920%1080i5994_100— Remaining:
i:se
. 00:00:49;02 «
: 00:01:01;09

4:59 PM

R1 channel is selected and highlighted.

> R1 channel — 3ch view

(1) (2)(3) (4)

Curi — 7 = e ’

Elap: 00:00:00;00

By tapping, selects and highlights the R1

(1) | R1 channel tab channel.
(2) | Status Indicates the recording progress status.
Locks R1 channel operations.
While the operations are locked, [Locked] and
(3) | [Locked] [R1] buttons light in red.
Tapping it again releases the lock.
(4) | Preview Displays the video currently recorded.
Audio level . : :
(5) display Displays input audio level.
(6) | [Clip:] Indicates the name of the clip.
(7) | [Cur:] Indicates the current timecode.
(8) | [Elap:] Indicates the elapsed time of recording by

timecode display.

August 3, 2012
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Recording by VTR control from T2 (R1-VTR mode)

The procedure to control VIR from your T2 and perform recording is
described in this part.

Set the connection information of the VIR used for recording or the video
format for capturing beforehand.

General — Hardware settings»P119

R1 settings» P129

Transfer — common settings» P137

Ifnecessary, make settings in the setting screen according to the environment
in use.

Settings»P118

TIP ¢ In the workstation mode, you can import the batch capture list
to your T2 and record sources at once.
Recording sources at once (batch capturing) »P182
¢ The VTR can be controlled by using your T2 as a controller and
via AMP command or BVW command.
Controlling an external device from T2 with AMP/BVW (R1-VTR
mode)»P191
AMP command list»P203
BVW command list»P216

1 Press the [R1] button on T2.

R1 channel is displayed in 1ch view.

R1 channel - 1ch view» P49

The video from the external input device is displayed in the preview.
2 Tap [VTR].

The mode switches to the R1-VIR mode.

3 Tap [Record destination bin], select the saving destination of the
clip to record, and then tap [OK].

4 Play back the video to record and tap [Mark(In)] and [Mark(Out)]
to specity the recording range (In/Out points).
Playing back video» P98

You can also specify the timecode by tapping the entry area of [In:] and
[Out].

TIP  * You can also specify the time lapse from the start point of
recording (duration) to automatically end the recording. Tap
[Fixed Length], tap the entry area of [Length:], and enter the
timecode.
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5 Press the [Rec] button.

The recording starts. The recording automatically ends at the specified Out
point.

You can set the clip name by tapping the entry area of [Clip:] while recording.
To end the recording in the middle, press the [Stop] button.

After the recording ends, the recorded clip is saved in the bin selected in
step 3.

TIP ¢ The video currently recorded in the R1 channel can be loaded

and played on the P1/P2 channel.
Loading and playing back video currently recorded (chasing
playback)» P99

¢ The video currently recorded in the R1 channel can be output
from the P1/P2 channel with active through.
Outputting currently recorded video with active through (E to E
mode)» P100

¢ To check the properties of the clip currently recorded, tap
[Menu] and then tap [Properties] on the 1ch view of the R1
channel.

¢ To change the name of the clip currently recorded, tap [Menu]
and then tap [Rename] on the 1ch view of the R1 channel.

* To unload the video after recording, tap [Menu] and then tap
[Unload] on the 1ch view of the R1 channel.

Recording live video (R1-live mode)

The procedure to record live video from an external device is described in
this part.

Set the connection information of the external device used for recording or
the video format for capturing beforehand.

General — Hardware settings»P119

R1 settings» P129

Transfer — common settings» P137

Ifnecessary, make settings in the setting screen according to the environment
in use.

Settings»P118

TIP ® You can also record video from a device that cannot allow deck
control in the same procedure. Find the start point of the video
for recording beforehand.
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1 Press the [R1] button on T2.

R1 channel is displayed in 1ch view.
R1 channel - 1ch view» P49
The video from the external input device is displayed in the preview.

2 Tap [Live].
The mode switches to the R1-live mode.

3 Tap [Record destination bin], select the saving destination of the
clip to record, and then tap [OK].

4 1f necessary, play the video from the external device and press
the [Rec] button on T2.

The recording starts.
You can set the clip name by tapping the entry area of [Clip:] while recording.

TIP * An important part in the recorded video can be saved in
another clip as highlight. Tap [Mark(In)] and [Mark(Out)], and
then tap [Create Subclip].

* You can also specify the time lapse from the start point of
recording (duration) to automatically end the recording. Tap
[Fixed Length], tap the entry area of [Length:], and enter the
timecode.

¢ The video currently recorded in the R1 channel can be loaded
and played on the P1/P2 channel.

Loading and playing back video currently recorded (chasing
playback)» P99

¢ The video currently recorded in the R1 channel can be output
from the P1/P2 channel with active through.

Outputting currently recorded video with active through (E to E
mode)»P100

¢ To check the properties of the clip currently recorded, tap
[Menu] and then tap [Properties] on the 1ch view of the R1
channel.

¢ To change the name of the clip currently recorded, tap [Menu]
and then tap [Rename] on the 1ch view of the R1 channel.

5 After recording the necessary video, press the [Stop] button on T2.

After stopping recording, the recorded clip is saved in the bin selected in
step 3.

TIP ¢ To unload the video after recording, tap [Menu] and then tap
[Unload] on the 1ch view of the R1 channel.
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Section

Import/Export

This section describes the procedure to import a media file from a removable
drive or network drive and to export contents edited in your T2.

Importing a media file

Displaying the [Browse] tab

Import of media files from a removable drive such as USB removable device,
XDCAM, P2, GF, and from a network drive to your T2 is performed from
the [Browse] tab.

1 Tap [Bin].
The bin view appears.

2 Tap the [Browse] tab.

> [Browse] tab
M @ @ @ 6 6 @

mport || DP1 || >P2) menu

ich
View

3 Removable Media e " 080i_Clip_25 3ch
O View

[ XDCAM

3 xDCcAMEX

£ P2

3 GF

Config.

Transfer

5:16PM

(8) ©) (10) (1)

(1) | [Preview] Switches on/off of the preview (filmstrip).

Switches between [Bin] tab/[Browse] tab/

(2) | View switching tab [Recycle Bin] tab.
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When a removable drive is connected to
(3) | [New connection] T2, you can select a folder to display in the
[Browse] tab.

Imports the selected media file to T2 as a

(4) | [Import] clip.

Loads the selected media file to the P1
channel.

You can play and check the video without
(5) | [>P1] importing to T2 as a clip. However,

the playback speed depends on the
specifications of the connected removable
drive.

Loads the selected media file to the P2
channel.

You can play and check the video without
(6) | [>P2] importing to T2 as a clip. However,

the playback speed depends on the
specifications of the connected removable
drive.

(7) | [Menu] Displays the related menu.

Displays the media or folders in the
(8) | Removable drive list | removable drive connected to T2.

The selected folder is highlighted in blue.

By tapping [Preview] and set it on, displays
(9) | Filmstrip display the contents in the media file in filmstrip
with six frames.

Displays the list of media files in the drive
selected from the removable drive list.
The selected media file is highlighted in
blue.

(10) | Media file list

1ch view/3ch view/
(11) | bin/transfer screen
common area

1ch view/3ch view/bin/transfer screen
common area» P51
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Importing a media file

Displaying media file in removable drive

Media files in a removable drive such as USB removable device, XDCAM,

P2, GF, etc. can be displayed without importing to T2.

NOTE * When using XDCAM, XDCAM EX, or P2 device, install the
driver in the maintenance mode before connecting the device
to P2. For more information about the maintenance mode,
refer to the T2 Maintenance Manual.

Operation-ensured driver versions for XDCAM/XDCAM EX» P197
Operation-ensured driver version for P2»P197

TIP ¢ If you make settings of the network drive in the workstation
mode, you can display media files in the network drive from

the [Browse] tab.
Displaying media files in network drive» P185

1 Connect a removable drive to your T2 and insert medium.

2 Tap [Import].

A new removable device(F:\) has been detected.

" Export Cancel

The screen switches to the [Browse] tab.

3 Tap [New connection] and select a medium type.

Bin Browse

Removable Media

XDCAM

[ Removable Med
XDCAM EX

[ XDCAM

[ XDCAMEX

ju 23 GF
[ 6F

P2

4 Select a drive, and then tap [OK].
Media file list including media files appears.

TIP ¢ To update information in the removable device, tap [Menu],
and then tap [Refresh].
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Playing media file in removable drive

You can load media files in a removable drive to T2 and play them.

NOTE © The system is under heavy load during playback of clips in
removable media. It is recommended that you import the file
to your T2 and play it.

1 Select a drive in the [Browse] tab and display the media file.
Displaying media file in removable drive» P59
2 Select a media file and tap [>P1] or [>P2].

While another clip is loaded, a confirmation message appears. Tap [Yes] to
unload the clip.
The media file is loaded to the P1 channel or P2 channel.

TIP * You can also load the file to the selected channel by tapping
the media file two times.

3 Press the [Play] button.

Playing back video» P98
TIP ¢ The following operation are available on the media files loaded
to the P1/P2 channel.

- Playback operation using the T2 front panel control buttons
- Setting of In and Out points and moving to In or Out point

NOTE * Depending on the specifications of the connected removable
drive, playback operation may not catch up.
¢ The following operations are not available on the media files
loaded to the P1/P2 channel.
- Import of video between set In-Out points
- Gain adjustment of audio level
- Tag editing (workstation mode only)
- Sync playback (pairing)
- Adding to playlist
- Creating sub clips
If you add files to playlist or create sub clips, import the media
file before you perform the operation.
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Checking the properties of media file

The procedure for checking the properties of media file is described in this
part.

1 Select a drive in the [Browse] tab and display the media file.
Displaying media file in removable drive» P59

2 Select a media file, tap [Menu], and then tap [Properties].
The properties of media file is displayed.

> Properties of media file

ClipInfo = MediaInfo = Timecode

Clip: 1080i_Clip_25
Bin: Fih

Container: AVIFile
Video format: Grass Valley HQ 1440x1080 59.94i
Audio format: PCM Wave audio 48kHz 2ch 16bit

InTC: 00:05:26;18
Qut TC: 00:05:32;01
Duration: 00:00:05;13

Reference: 0

Displays the clip information.

You can check the clip name, format, In/Out
points timecode, length, alpha channel presence,
[Clip Info] tab date of creation, etc.

Tapping the entry area allows to change the clip
name.

Checking [Locked] locks the clip from editing.

The information of media file is displayed.

You can check the file path, number of clips and
[Media Info] tab pla.yhsts' linked to the media file, size, In/Out
points timecode, etc.

Tapping [Details...] allows to check the details of

the clips linked to the media file.

Specifies starting timecode.
To use the starting timecode of a media file, select

[Timecode] tab [Source].

To specify a starting timecode, select [Specify
Start Time], tap the entry area, and enter
timecode.

3 Tap [OK].
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Changing media file list display

You can switch the display of the media file list between icon display and
text display.

1 Tap [Menu], and then tap [View].

2 Tap [Icon View] or [Text View].

Importing a media file

The procedure for importing media file to T2 is described in this part.

At the time of import, you can set whether to import the file in the native
format or in a converted format such as Grass Valley HQ AVI.

The import operation will be easier if the format for the imported file and
other setting items have been set beforehand.

Transfer settings»P137

If necessary, make settings in the setting screen according to the environment

in use.

Settings»P118

TIP e For more information about the file formats that can be
imported, see “Appendix”.
Input format»P198

e For XDCAM, XDCAM EX, P2, and GF sources, all files under
the root folder and all folders in the root folder will be copied.
As for files in each folder, only the files that are related to the
selected file for the import will be copied.

* You can convert a file to Grass Valley HQ AVI after importing
it as the native format.

Converting contents to other formats» P84

¢ Still image files are converted to Grass Valley HQ AVI and
imported.

* The maximum file size of the still image that can be imported
is 4,096 x 2,304 pixels (4K).

¢ The system will import files that contain transparency
information after converting them to Grass Valley HQ AVI. In
this case, the conversion is performed so that the bitrate will
be lower (the Q value = 12).

1 Select a drive in the [Browse] tab and display the media file.
Displaying media file in removable drive» P59

2 Select a media file, tap [Import], and then tap [Import...].
The Import dialog box appears.
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> Import dialog box

Mm@ ©

Name Format
1080i_Clip_25 avi(Grass Valley HQ)

Importing a media file

(4)

Start Cancel

®)

(6)

[
7) 8) ()

() | [Delete] ]?eletes the selected file from the import
list.
(2) | [UP] Moves up the selected file.
(3) | [DOWN] Moves down the selected file.
. Displays the setting screen. Sets the file
(4) | [Config.] format after imported.
Displays the list of the files to be imported.
(5) | Import list [Format] shows the formats of files to be
imported.
(©6) | [Bin:] Displays the saving destination bin for the
) imported media files.
7) [Select Import Selects the saving destination bin for the
Destination Bin] imported media files.
(8) | [Start] Starts import.
(9) | [Cancel] Closes the import dialog box.

3 Tap [Config.].

If conversion of the format of the file to import is not necessary, you do not
need to change the settings in the setting screen. Proceed to step 6.
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4 Tap the tab of the format of the media file.

General

Confiaure imnort of imaae and im: in A seauence format

I 11]) (0] 4 Cancel

For example, if the media file to import is XDCAM format, tap the [XDCAM]
tab. If it is an MXF single file, tap the [MXF] tab.

5 From the [File format after import:] list, select a post-import
format and then tap [OK].

6 In the import dialog box, tap [Select Import Destination Bin],
select a bin, and tap [OK].

7 Tap [Start].

Import starts. You can check the progress in the transfer screen.
Checking the transfer status» P66

NOTE e By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P137
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Importing a media file

Importing still images with serial numbers as a
sequence clip

Still images with serial numbers can be imported as a single sequence clip

(in Grass Valley HQ AVI).
If necessary, make settings in the setting screen according to the environment

in use.
Settings»P118

NOTE e If some of the files have different extensions, or if files with
added alpha channel and those without alpha are mixed,
the import of the still images with serial numbers will be

canceled.

TIP * The maximum file size of the still image that can be imported
is 4,096 x 2,304 pixels (4K).

1 Select a drive in the [Browse] tab and display the media file.

Displaying media file in removable drive» P59

2 Select the first file in the serial numbers, tap [Import], and then
tap [Import (Sequence)...].

The Import dialog box appears.
Import dialog box» P63

3 Tap [Config.].

4 In [Configure import of image and images in a sequence format],
select a post-import format and then tap [OK].

PR
Common | AVCHD AV

General

Default... (0] 4 Cancel

5 In the import dialog box, tap [Select Import Destination Bin],
select a bin, and tap [OK].
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6 Tap [Start].

Import starts. You can check the progress in the transfer screen.
Checking the transfer status» P66

NOTE e By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P137

Checking the transfer status

You can check the status of file transfer or conversion (jobs) in the transfer
screen.

1 Tap [Transfer].

> Transfer screen
(1) 2 @ @

Delete Clear

ich

= View

3ch
View

Config.

Remaining:
1358

5:25 PM
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Displays the list of jobs.
[Clip]

Indicates the name of the clip.

[Status]
(1) | Job list Indicates the job progress status.

[Bin]

Indicates the bin name.

[Path]

Indicates media file path and file name.

Deletes selected jobs. If you tap [Delete]

(2) | [Delete] while executing a job, the job will be
canceled.
(3) | [Clear] Deletes all jobs from the job list.

1ch view/3ch view/
(4) | bin/transfer screen
common area

1ch view/3ch view/bin/transfer screen
common area®» P51

Removing medium in removable drive

The procedures to remove a medium in the removable drive connected
to your T2 (such as XDCAM professional disc, SxS memory card, and P2
card), and to disconnect the folder in the USB removable device or GFPAK
are described in this part.

1 Select a drive in the [Browse] tab.

2 Tap [Menu], and then tap [Disconnect].
3 A message appears. Tap [Yes].

4 Remove the medium (XDCAM professional disc, SxS memory
card, or P2 card) from the removable drive.

If you want to disconnect your T2 from the removable drive, disconnect the
removable drive.
Removing removable drive» P68
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Removing removable drive

The procedure to remove a removable drive such as USB removable device,
XDCAM, P2, GF, etc. from T2 is described in this part.

Before removing the removable drive, you need to disconnect the medium
or file in the drive.

Removing medium in removable drive» P67

1 Tap [Remove Device].

You can operate it from the bin view, 1ch view, 3ch view, and transfer screen.

preview (3] mor | >P1| >P2) v | [JEH

Bin Browse Recycle Bin - l.d'
ai / View

[ Removable Media = 5 3_ch
OF View

[ xpcam

[ XDCAMEX

B p2

[mlcs
4

Config.

Transfer

5:26 PM

2 Select a removable drive, and then tap [Remove].
3 A message appears. Tap [Yes].

4 Remove the removable drive from T2.

Exporting a file

68 T2 User Manual

Exporting contents to a file

The procedure to export a clip or playlist stored in the bin of your T2 to a
file is described in this part.

At the time of export, you can set whether to export the file in the native
format or in a converted format.

The export operation will be easier if the format for the exported file and
other setting items have been set beforehand.

Transfer settings»P137

If necessary, make settings in the setting screen according to the environment
in use.

Settings»P118
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Exporting a file

NOTE e For XDCAM, XDCAM EX, P2, and GF sources, all files under
the root folder and all folders in the root folder will be copied.
As for files in each folder, only the files that are related to the
selected file for the import will be copied. If a clip imported as
its native format is exported with no conversion, the exported
clip may not be properly handled depending on the device.

TIP e For more information about the file formats that can be
exported, see “Appendix”.

Output format» P200

¢ For important notes on exporting, see “Appendix”.
Notes on T2 expori»P201

* When exporting to a Grass Valley HQ AVI file, the file is
trimmed between the set In and Out points and exported. For
other formats, the whole file is exported.

* You can export Grass Valley HQ AVI files by converting them
to the following formats.

- MXF format (XDCAM HD422) (1920 x 1080
59.94i/50i/29.97p/25p 50 Mbps)

- MXF format (XDCAM HD) (1440 x 1080
59.94i/501/29.97p/25p/23.98p 25 Mbps)

- MXF format (XDCAM IMX) (720 x 486 59.94i, 720 x 576 50i)

- MXF format (XDCAM DV) (720 x 486 59.94i, 720 x 576 50i)

* When exporting a playlist to a file, the file is converted with
the following features.

- If several formats are contained, they are converted in one
file.

- A timecode set in a playlist or event properties can be
retained in each frame of the converted file.

- When exporting files in Grass Valley HQ AVI format, the
profile (size and frame rate) of the converted file is same as
the profile of the playlist.

- When exporting files in MXF format (XDCAM)), files are
converted according to the settings of [Advanced AVI
transcoding settings] in [Transfer] -> [AVI] on the setting
screen.

- The audio gain set for the event in the playlist is maintained
in the converted clip.

- Audio is converted into PCM 48kHz 24bit 8ch.

1 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78
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2 Select an item, tap [Export], and then tap [Export Media Files...].

A message related to export appears. Read the message, and then tap [OK].
The Export dialog box appears.

> Export dialog box
Mm @ @ 4)

ormat

avi(Grass Valley HQ)

Start Cancel

I I
7) 8 ()

®) (6)

(1) | [Deletel Deletes the selected file from the export list.
(2) | [UP] Moves up the selected file.
(3) | [DOWN] Moves down the selected file.

Displays the setting screen. Sets the file
format and others after exported.

(4) | [Config.]

Displays the list of the files to be exported.

(5) | Export list [Format] shows the formats of files to be
exported.

Displays the saving destination of the files

(6) | [Export Path:] to be exported.

[Select Export Selects the saving destination of the files to
(7)

Folder] be exported.
(8) | [Start] Starts export.
(9) | [Cancel] Closes the export dialog box.

3 If necessary, tap [Config.] to set the file format after conversion.

¢ If conversion is not necessary, you do not need to change the settings
in the setting screen. Proceed to step 4.
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* To export a Grass Valley HQ AVI file to be converted to MXF (XDCAM
format), tap [AVI] and check [Execute transcoding when exporting AVI
file.]. Make settings in [Advanced AVI transcoding settings], and tap [OK].
Transfer — AVI settings» P141

* To export a playlist, tap the [Playlist] tab. From the [File format after
export:] list, select a post-import format and then tap [OK].

Transfer — Playlist settings» P147

4 In the export dialog box, tap [Select Export Folder], select a
folder, and tap [OK].

5 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status» P66

NOTE e By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P137

Exporting contents in T2 format

If you export playlists or clips in the T2 format (TWF file), you can import
them to other T2 with the information (In/Out points, effect, event list, etc.)
retained.

TIP ¢ For important notes on exporting, see “Appendix”.

Notes on T2 export»P201

* TWF file is a file in the ZIP format. If you change the extension
of the TWF file to “*.zip” and extract it with software for ZID,
you can extract it as a media file.

* You can send/receive playlists and clips directly from T2 to
other T2 via FTP.
Transferring a file to other T2» P72

1 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78

August 3, 2012 T2 User Manual 71



Section 6 — Import/Export

72

2 Select an item, tap [Export], and then tap [Export in T2 Format
(TWE Files)...].

A message related to export to other T2 appears. Read the message, and
then tap [OK].

The Export dialog box appears.

Export dialog box» P70

3 In the export dialog box, tap [Select Export Folder], select a
folder, and tap [OK].

4 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status» P66

Transferring a file to other T2

T2 User Manual

Overview of file transfer function from T2 to T2

You can transfer media files from T2 to other T2 via FTP. If you export media
files from T2 (source) to the FTP server of T2 (destination), you can use the
files from the [Bin] tab on T2 (destination) without import operations.

Configuring the FTP server settings of T2 (destination)

The procedure to make settings for the FIP server of T2 (destination) is
described in this part.

TIP e Set T2 (destination) to be used as the FTP server beforehand.
Perform steps 1 to 8 in “Sending/receiving files to T2” on T2

(destination).
Sending/receiving files to T2»P74

1 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer
screen.

2 Tap [General], and then tap the [FTP] tab.

3 Tap[Add..].

The FTP destination setting dialog box appears.
FTP destination setting dialog box»P124
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4 Configure the FTP server settings of T2 (destination), and then
tap [OK].

In the export dialog box, you can tap [Select Export Folder] to select the FTP
server of T2 (destination).

Exporting a file from T2 to T2

Configure the FTP server settings of T2 (destination) before you perform
export operation.

Configuring the FTP server settings of T2 (destination) » P72

The export operation will be easier if the format for the exported file and
other setting items have been set beforehand.

Transfer settings» P137

Make settings in the setting screen according to the environment in use.

Settings»P118

TIP e For more information about the file formats that can be
exported, see “Appendix”.
Output format» P200
¢ For important notes on exporting, see “Appendix”.
Notes on T2 export»P201

1 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78

2 Select an item and tap [Export], and then tap [Export Media
Files...] or [Export in T2 Format (TWF Files)...].

NOTE e Playlists or clips composed of multiple files cannot be exported
as the original formats. Export them in the T2 format.

A message related to export or a message related to export to other T2
appears. Read the message, and then tap [OK].

The Export dialog box appears.

Export dialog box» P70

3 If necessary, tap [Config.] to set the file format after conversion.

¢ [f conversion is not necessary, you do not need to change the settings
in the setting screen. Proceed to step 4.

¢ To export a Grass Valley HQ AVI file to be converted to MXF (XDCAM
format), tap [AVI] and check [Execute transcoding when exporting AVI
file.]. Make settings in [Advanced AVI transcoding settings], and tap
[OK].
Transfer — AVI settings» P141
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* To export a playlist, tap the [Playlist] tab. From the [File format after
export:] list, select a post-convert format and then tap [OK].
Transfer — Playlist settings» P147

4 1In the export dialog box, tap [Select Export Folder].

5 Tap [FTP Server], select the FTP server of T2 (destination), and
then tap [OK].

6 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status» P66

Sending/receiving files to T2

You can use FTP server to connect devices or edit terminals to your T2 and
upload/download files.

NOTE e For the following format files, only single files can be
uploaded/downloaded.
- XDCAM: MXF single file of XDCAM format only
- XDCAM EX: Single file of XDCAM EX format only (*mp4,
*.avi)

- GF: MXEF single file of GF format only

® When uploading files to T2 via FTF, if [File format after
import] is set to [AVI(HQ)] for the transfer setting of each
format, the files will be converted to Grass Valley HQ AVI after
uploaded.
Transfer settings» P137

¢ If you want to use Japanese for file names, you must set
the character set of file names to UTF-8 on the FTP client
side beforehand. Correct file names cannot be displayed if
the character sets do not match. The configuration method
depends on your software. Refer to the help etc.

1 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer
screen.

2 Tap [General], and then tap the [Network-1] tab or [Network-2]
tab.

3 Configure the IP address and DNS server address.
General — Network-1/Network-2 settings»P120
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4 Tap the [FTP] tab.

5 Tap [Settings...].

Hardware | Network-1 |Network-2 Network-3 | FIP | Miscellaneous

FTP Server

[ Limit the FTP trans

The dialog box for FTP setting of T2 appears.
FTP setting dialog box for T2»P124

6 Configure the FTP server settings of T2, and then tap [OK].

7 Tap [Start].

Hardware  Network-1 |Network-2 |Network-3 | FIP | Miscellaneous

FTP Server

R1

P1

directory) :
P2
Stop
Transfer

[ Limit the FTP transf

8 Tap [OK].

9 Access your T2 from a client.

Enter the IP address you configured in [Network-1] or [Network-2] and the
user name and password you configured in the dialog box for FTP setting
of T2, and connect to your T2 via FTP.

10 Upload or download data.

NOTE ° When using the FTP client where disconnection cannot be
made explicitly such as Windows Explore, connection may
be terminated due to the restriction of the simultaneous
connection of clients. In such a case, tap [General] -> the [FTP]
tab on the setup screen, and tap [Stop], and then tap [Start]
again.

[FTP] tab»P123
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NOTE e Depending on the FTP client, files may be transferred with
multiple connections simultaneously. When using such an FTP
client, make sure that the simultaneous connection of clients
does not exceed the [Max Clients:] value set in the FTP setting
dialog box of T2.

FTP setting dialog box for T2»P124

¢ By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.
Transfer — common settings» P137

Loading and editing T2 contents to other editing software

T2 User Manual

You can load T2 contents to Adobe Premiere Pro and Apple Final Cut Pro
to edit the data. Clips in a bin can be converted to XDCAM format and the
converted clips can be downloaded from a client via FTP.

NOTE e If you want to use Japanese for file names, you must set
the character set of file names to UTF-8 on the FTP client
side beforehand. Correct file names cannot be displayed if
the character sets do not match. The configuration method
depends on your software. Refer to the help etc.

1 Perform steps 1 to 8 in “Sending/receiving files to T2”.

2 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78

3 Select an item, tap [Menu], and then tap [Convert] -> [Convert to
MXE(XDCAM)].

4 Tap [Yes].

The conversion starts. You can check the progress in the transfer screen.
Checking the transfer status» P66

The new converted clips will be saved in the same bin as their original
ones.

August 3, 2012



Loading and editing T2 contents to other editing software

5 Download the converted clip(s) via FTP from a client PC.

6 Load the downloaded clips to the editing software on the client
PC.
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Section

Contents Management

This section describes the operations for contents management using the

bin.
Managing contents in the bin

Displaying the [Bin] tab
In the [Bin] tab, you can manage the contents loaded to T2 and export
contents edited with T2.

1 Tap [Bin].
The bin view appears.

2 Tap the [Bin] tab.

> [Bin] tab
M@ @ @ G ® @ 6

Export

[ Bin(1/5)

Thumbnail Name -~
[T
311 ean
[T

12
_— !J
iz an
T,
L

%l
4]

6:21 PM

(10) (1) (12) (13)

(1) | [Preview] Switches on/off of the preview (filmstrip).

Switches between [Bin] tab/[Browse] tab/

(2) | View switching tab [Recycle Bin] tab.
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Managing contents in the bin

Deletes all files in the recycle bin.

(3) | [Empty Recycle Bin] | Note that the deleted contents cannot be
restored.
(4) | [New Bin] Creates a new bin.
(5) | [Export] Exports the selected contents.
(6) | [Delete] Deletes the selected contents.
7) | >P1] Loads the selected contents to the P1
channel.
(8) | [>P2] Loads the selected contents to the P2
channel.
(9) | [Menu] Displays the related menu.
(10) | Bin list Displays the list of bins.
The selected bin is highlighted in blue.
. - By tapping [Preview] and set it on, displays
(1) | Filmstrip display the contents in filmstrip with six frames.
Displays the list of contents selected in the
(12) | Contents list bin list.
The selected item is highlighted in blue.
(13) ;::: /:'rI:r‘:,s/fi[:hs::':zgrf 1ch view/3ch view/bin/transfer screen

common area

common area» P51

Changing bin name
You can change the name of the bin.
1 Select a bin in the [Bin] tab.

Displaying the [Bin] tab» P78

2 Tap [Menu], and then tap [Rename Folder].

3 Enter a name for the bin and tap [OK].
Software keyboard» P115

August 3, 2012

T2 User Manual 79



Section 7 — Contents Management

Deleting a bin

You can delete a bin and the contents in the bin. The deleted bins are moved
to the recycle bin.

1 Select a bin in the [Bin] tab.
Displaying the [Bin] tab» P78
2 Tap [Menu], and then tap [Delete Folder].

A message appears and the list of contents in the bin is displayed.

3 Tap [Yes].

Contents types and icons

The icons that indicate the contents types and common icons, and icons
displayed regardless of the contents types are described in this section.

> Clip

> Still image clip

> Playlist

&)
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> Common icons

(1 (f)

(1) | Pairing Indicates that pairing is set.

Indicates that the contents is used in the

(2) | Used in playlist playlist.

(3) | Lock Indicates that the item is locked.

“1” indicates that another source can be
recorded in the R1 channel while the

Avallable numberof | 1 are played back.

(4) | times of recording
while playing

“0” indicates that another source cannot
be recorded in the R1 channel while the
contents are played back.

“2” indicates that another contents can be
Available number played back simultaneously in the P1/P2

(5) of times of channel while the contents are played back.
simultaneous “1” indicates that another contents cannot
playing be played back simultaneously in the P1/P2

channel while the contents are played back.

(6) Containing alpha Indicates that the contents have
channel transparency information.

Moving contents to another bin

You can move the contents in the bin to another bin.

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78
2 Select an item, tap [Menu], and then tap [Move].

3 Select the destination bin and tap [OK].
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Changing the display of contents list

You can switch the display of the contents list between icon display and
text display.

1 Tap [Menu], and then tap [View].

2 Tap [Icon View] or [Text View].

Checking the properties of the contents

The procedure to check the properties of the clips or playlists in the bin is
described in this part.

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78
2 Select an item, tap [Menu], and then tap [Properties].

The properties of contents are displayed.

> Clip properties

ClipInfo MediaInfo = Timecode

clip_o4

Bin

AVIFile

Grass Valley HQ 1440x1080 59.94i
PCM Wave audio 48kHz 2ch 16bit
00:09:33;28

00:09:37;01

00:00:03;03

Displays the clip information.

You can check the clip name, format, In/Out
points timecode, length, alpha channel presence,
[Clip Info] tab date 9f creation, etc. |
Tapping the entry area allows to change the clip
name and audio gain. (For still images, the length
can be changed.)

Checking [Locked] locks the clip from editing.
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[Media Info] tab

The information of media file is displayed.

You can check the file path, clips referenced to
the media file, and the number of reference clips,
size, In/Out points timecode, etc.

Tapping [Details...] displays the list of clips
referenced to the media file and the number of
reference clips.

[Timecode] tab

Specifies starting timecode.

To use the starting timecode of a media file, select
[Source].

To specify a starting timecode, select [Specify
Start Time], tap the entry area, and enter
timecode.

> Playlist properties

Playlist Info = Timecode = All Events

Playlist: Playlist

Bin: Bin
Duration: 00:00:14; 06
Events: 3
Reference: (0]
Pairing:
Created:

Modified: 7/4/2012 10:41:24 AM

6/25/2012 12:27:18 PM

OK Cancel

[Playlist Info] tab

Displays the playlist information.

You can check the playlist name, bin name

where the playlist is stored, format, length, alpha
channel presence, date of creation, etc.

Tapping the entry area allows to change the
playlist name and audio gain.

Checking [Locked] locks the playlist from editing.

[Timecode] tab

Specifies starting timecode.

[Source]
Uses the starting timecode of the media file.

[Specify Start Time]
Specifies a desired starting timecode. Tap the
entry area and enter a desired timecode.

[According to event setting]
Uses the timecode set in each event in the playlist.
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Updates the settings of effect for event starting
(start effects) and actions or effects for event
ending (end effects) of all events in the playlist.

Updating playlist effect settings» P111

[All Events] tab

3 Tap [OK].

Releasing pairing of contents

You can release the pairing of contents.
For pairing of contents, refer to “Sync playback of contents (3D sync mode)”.
Sync playback of contents (3D sync mode)»P101

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78
2 Select an item, tap [Menu], and then tap [Unpairing].

Converting contents to other formats

You can convert contents to other formats.
A playlist can be converted to a single clip (media file).

NOTE e If a playlist is converted to a single clip, the effect set to the
playlist is disabled.

TIP ¢ If you want to convert a Grass Valley HQ AVI file to an MXF
(XDCAM format) file, set the format details in the setting
screen beforehand.

Transfer — AVI settings» P141
¢ Playlists are converted with the following features.

- If several formats are contained, they are converted in one file.

- A timecode set in a playlist or event properties can be
retained in each frame of the converted file.

- When exporting files in Grass Valley HQ AVI format, the
profile (size and frame rate) of the converted file is same as
the profile of the playlist.

- When exporting files in MXF format (XDCAM)), files are
converted according to the settings of [Advanced AVI
transcoding settings] in [Transfer] -> [AVI] on the setting
screen.

- The audio gain set for the event in the playlist is maintained
in the converted clip.

- Audio is converted into PCM 48kHz 24bit 8ch.
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1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78

2 Select an item, tap [Menu], and then tap [Convert] -> [Convert to
(converted format)].

3 Tap [Yes].

The conversion starts. You can check the progress in the transfer screen.
Checking the transfer status» P66

The new converted clips will be saved in the same bin as their original
ones.

NOTE e By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P137

Checking the recycle bin

Displaying the [Recycle Bin] tab

In the [Recycle Bin] tab, you can restore the deleted contents and completely
delete the files in the recycle bin.

1 Tap [Bin].
The bin view appears.

2 Tap the [Recycle Bin] tab.
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> [Recycle Bin] tab
M@ 6 @ (5)

[3Bin (1/2) 1ch
Thumbnail lame orm: n View

& i
.': . & 3ch
J._a View

3 Bin(1)
[ Default

Config.

Transfer

(6) @) (8) ©)

(1) | [Preview] Switches on/off of the preview (filmstrip).

Switches between [Bin] tab/[Browse] tab/

(2) | View switching tab [Recycle Bin] tab.

Deletes all files in the recycle bin.

(3) | [Empty Recycle Bin] | Note that the deleted contents cannot be
restored.

Restores contents to the original bin.
When restoring a playlist, if clips linked to

4) | [Restore

@1 : the playlist are also in the recycle bin, the

clips are restored at the same time.

(5) | [Menu] Displays the related menu.

Recycle hin folder Displays the list of folders in the recycle
list bin.

(6)

By tapping [Preview] and set it on, displays

(7) | Filmstrip display the contents in filmstrip with six frames.

Displays the list of contents in the folder

(8) | Contents list selected in the recycle bin folder list.

1ch view/3ch view/
(9) | bin/transfer screen
common area

1ch view/3ch view/hin/transfer screen
common area® P51
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Backing up all data to other T2 (full sync backup)

August 3, 2012

Overview of full sync backup function

T2 data (media files and database) can be synchronized to other (multiple)
T2 on the network. T2 (slave) data on the sync destination is initialized and
they are completely synchronized to T2 (master) data.

To synchronize data, set the sync destination T2 (slave) to the slave mode
(step 1), and then set the sync source T2 (master) to the master mode. (step 2)

Step 1: Setting T2 on the sync destination (slave) to the

slave mode

NOTE e Set the remote mode (R1-remote mode/P1-remote mode/P2-
remote mode) to off on both T2 (master and slave) beforehand.

(You cannot switch the remote mode to on and off while
transferring files.)

1 On the sync destination T2, tap [Bin] or [1ch View].

2 Tap [Menu], and then tap [Tools] -> [T2 to T2 Sync backup...].

If contents are being captured or loaded in the R1/P1/P2 channel, a message
appears asking whether to unload the contents. Tap [OK] to unload the clip.

3 In [Operating mode] on the [T2 to T2 Sync backup] dialog box,
select [Slave mode] and tap [Close].

T2 on the sync destination (slave) is set to the slave mode.
To sync data to multiple T2 (slave), repeat steps 1 to 3 on all of the T2 (slave).

Step 2: Setting T2 on the sync source (master) to the
master mode for data sync

1 Onthe sync source T2, tap [Bin] or [1ch View].

2 Tap [Menu], and then tap [Tools] -> [T2 to T2 Sync backup...].

If contents are being captured or loaded in the R1/P1/P2 channel, a message
appears asking whether to unload the contents. Tap [OK] to unload the clip.

3 In [Operating mode] on the [T2 to T2 Sync backup] dialog box,
select [Master mode] and tap [Slave configuration...].

T2 on the sync source (master) is set to the master mode.
The number of T2 set to the slave mode is displayed in [Slave count:].
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4 In the [Slave configuration...] dialog box, set the IP address of T2
set to the slave mode.

¢ Tap [Auto Search...] to search for T2 set to the slave mode on the
network. Select an IP address on the [Search Results] dialog box, and
then tap [Add ALL].

¢ To set an IP address manually, tap [Add] and enter an IP address.

5 Tap [Close].
6 In the [T2 to T2 Sync backup] dialog box, tap [Start Sync].

7 A message appears. Tap [OK].

The synchronization starts. You can check the file transfer status on the
upper progress bar, and the whole status on the lower progress bar.

If you stop synchronization in the middle, tap [Stop]. You can also stop
synchronization from T2 set to the slave mode.

TIP e If data synchronization has been stopped forcibly by such an
event as the power off of T2, contents may be displayed with
the following thumbnail. Such contents cannot be used.

¢ If synchronization has been stopped and started again, files
that are already transferred will be skipped.
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Playing/Editing

This section describes operations to play contents in the P1/P2 channel and
to edit playlists.

Displaying P1/P2 channel in 1ch view

In the 1ch view of the P1/P2 channel, you can perform operations regarding
contents editing.

1 Press the [P1] button (or [P2] button).

The display switches to the 1ch view of the P1 channel (or P2 channel) and
the [P1] button (or [P2] button) lights in green.

You can also switch by tapping [1ch View] and then tapping the P1 channel
tab (or P2 channel tab).

If the clip is loaded to the P1 channel (or P2 channel), clip view is displayed.
And if a playlist is loaded, playlist view is displayed.

> P1/P2 channel (clip view) — 1ch view
(1)(2)(3)4) (5) (6) (7)(8)(9) (10) (1) (12)(13)

it

N ) Format:
2 @\ fciip: clip_oa In: 00:09:33;18 40 i0e0

| 59.941
[Ou[: 00:09:37;01

Dur: 00:00:03;13

(14) (15) (16) (17) (18)
*(2) to (18) are common in P2 channel.

P1 channel tah/P2 By tapping, selects and highlights the P1
channel tab channel (or P2 channel).

™
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Indicates the current playback mode (3D
sync mode, E to E mode, loop playback
mode) of the P1 channel (or P2 channel) in
(2) | Playback mode white characters.

By tapping, also switches the playback
mode.

Switching playback mode» P100

(3) | Status Indicates the playback progress status.
Locks P1 channel (or P2 channel)
operations.

(4) | [Locked] While the operations are locked, [Locked]

and [P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.

Displays the video currently played back.
Tapping the preview displays in the full
(5) | Preview screen view.

If a clip is not loaded, displays the output
profile of the channel on the upper left.

(6) | [Cur:] Indicates the current timecode.

Indicates the current playback speed

(7) | Playback speed (times).

Indicates the playback progress status and
markers of set In/Out points.

(8) | Scrubbing bar

Indicates the timecode of the remaining

(9) | [Rem:] time.
Switches the display scale of the scrubbing
bar.
Tapping it displays [Zoom] in red, and
(10) | [Zoom] displays the In-Out points of the clip as the

whole scale.

Tapping it again returns the display to the
original scale and displays the whole clip.

(11) | Audio level display | Displays output audio level.

(12) | [Menu] Displays the related menu.

(13) | [Playlist View] Switches to the playlist view.

Operation buttons of P1/P2 channel (clip

(14) | Operation buttons view)» P91
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(15)

[Clip:]

Indicates the name of the loaded clip.

Tapping the entry area allows to change the
clip name.

Software keyboard»P115

(16)

[In:]1/[0ut:1/[Dur:]

Indicates the timecode of In/Out points and
duration.

Tapping the entry area allows to set the In
and Out points or duration.

Software keypad — Timecode»P116

(17)

[Format:]

Indicates the video size of the clip and
frame rate.

(18)

1ch view/3ch view/
hin/transfer screen
common area

1ch view/3ch view/bin/transfer screen
common area®» P51

> Operation buttons of P1/P2 channel (clip view)

(1)

@ 6 @ 6

(6) ()

€I P dn Set
(1) | [Clear (In/Qut)] Clears In/Out points set on the clip.
(2) | [Cue(In)] Moves to the In point of the clip.
Sets In point to the current position. After
(3) | [Mark(In)] In point has been set, the In point marker
appears on the scrubbing bar.
Sets Out point to the current position.
(4) | [Mark(Out)] After Out point has been set, the Out point
marker appears on the scrubbing bar.
(5) | [Cue(Out)] Moves to the Out point of the clip.
Creates a sub clip between the set In-Out
ints.
(6) | [Create Subclip] —

Creating a sub clip between In-Out points
(highlight) »P105

(7)

[Set]

Trims the clip between the set In-Out
points.

Trimming a clip between the set In-Qut
points»P104
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> P1/P2 channel (playlist view) — 1ch view
(1)(2)(3X4) (5)(6) (7)(8)  (9) (10)(11)(12)(13)(14)(15)

1y g

=l
£

o
T

Remaining:
ia:se

1:45PM

ormat: 1440x1080

(16)(17) (18) (19) (20)

*(2) to (20) are common in P2 channel.

P1 channel tah/P2 By tapping, selects and highlights the P1
channel tab channel (or P2 channel).

™

Indicates the current playback mode (3D
sync mode, E to E mode, loop playback
mode) of the P1 channel (or P2 channel) in
(2) | Playback mode white characters.

By tapping, also switches the playback
mode.

Switching playback mode» P100

(3) | Status Indicates the playback progress status.
Locks P1 channel (or P2 channel)
operations.

(4) | [Locked] While the operations are locked, [Locked]

and [P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.

Displays the video currently played back.

Tapping the preview displays in the full
screen view.

(5) | Preview o )
If a playlist is not loaded, displays the
output profile of the channel on the upper
left.

) | [Cur:] Indicates the current timecode of the

playlist.
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Indicates the current playback speed

(7) | Playback speed (times).
. Indicates the playback progress status and
(8) | Scrubbing bar markers of set In/Out points.
Indicates the timecode for the remaining
time of event or the timecode for the
remaining time of whole playlist.
©) | [Rem:] The timecode to be displayed can be
' changed by [Playlist Remain TC:] in [P1] (or
[P2]) -> the [Monitor & Remote] tab on the
setting screen.
[Monitor & Remote] tab»P134
Adds an event to the playlist.
10) | [Add Event
(10) | 1 ! Creating a playlist»P106
(11) | [Delete Event] Deletes the event selected in the event list.
(12) | [Move Up] Moves up the event selected in the event
list.
(13) | [Move Down] }\i/;)ves down the event selected in the event
(14) | [Menu] Displays the related menu.
(15) | [Clip View] Switches to the clip view.
. Operation buttons of P1/P2 channel (playlist
(16) | Operation buttons view)» P94
Indicates the name of the loaded playlist.
(17) | [P.List:] Tapp}ng the entry area allows to change the
playlist name.
Software keyboard»P115
Displays the information of the event being
played.
[In:1/[0ut:]/[Dur:]
(18) | [Current Event:] Indicates the timecode of In/Out points and

the length of the event (duration).

[Format:]
Indicates the video size and frame rate.
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94

Displays the list of events in the playlist.

The selected event is displayed with a blue
(19) | Event list frame.

The event being played is highlighted in
blue.

1ch view/3ch view/
(20) | bin/transfer screen
common area

1ch view/3ch view/hin/transfer screen
common area® P51

> Operation buttons of P1/P2 channel (playlist view)
Mm @ @G @ 6 ©

In the TRIM mode, clears In/Out points set
on the event to cancel the TRIM mode.

(1) | [Clear (In/Out)]

(2) | [Cue(In)] Moves to the In point of the event.

In the TRIM mode, sets In point to the
current position. After In point has been
set, the In point marker appears on the
scrubbing bar.

(3) | [Mark(In)]

In the TRIM mode, sets Out point to the
current position. After Out point has been
set, the Out point marker appears on the
scrubbing bar.

(4) | [Mark(Out)]

(5) | [Cue(Out)] Moves to the Out point of the event.

Switches to the TRIM mode. You can edit
the In/Out points of the event selected in
the event list.

Trimming an event»P108

(6) | [TRIM]

Selecting P1/P2 channel in 3ch view

T2 User Manual

In 3ch view, you can view three channels, the video recorded in the R1
channel and the clip or playlist played in the P1/P2 channel simultaneously.
In 3ch view of P1/P2 channel, you can use the operation buttons and jog/
shuttle on the lower part of the touch screen LCD, to play or to switch
playback modes.

1 Tap [3ch View].

The display switches to 3ch view.
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Selecting P1/P2 channel in 3ch view

2 Tap the P1 channel tab (or P2 channel tab).

Clip:

Cur:
00:00:00;00

Config.

ip: Clip_04

ar 00:09:33;18

em: 00:00:03;12 Transfer

ip: dinnero1 Remaining:
=pER]

ey TT R T T E

em: 00:00:04;29

1:50 PM

P1 channel (or P2 channel) is selected and highlighted. The playback
operation to the selected channel becomes valid.

If the clip is loaded to the P1 channel (or P2 channel), clip view is displayed.
And if a playlist is loaded, playlist view is displayed.

> P1/P2 channel (clip view) — 3ch view

(1)) )

©)(7) @

em: 00:00:03;12

ip:  dinner01

00:00:04;29

*(2) to (9) are common in P2 channel.

™

P1 channel tab/
P2 channel tab

By tapping, selects and highlights the P1
channel (or P2 channel).

Indicates the current playback mode (3D sync
mode, E to E mode, loop playback mode) of the

(2) | Playback mode P1 channel (or P2 channel) in white characters.
By tapping, also switches the playback mode.
Switching playback mode» P100
(3) | Status Indicates the playback progress status.
play prog
Locks P1 channel (or P2 channel) operations.
@) | [Locked] While the operations are locked, [Locked] and

[P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.
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Displays the video currently played back.
(5) | Preview If a clip is not loaded, displays the output
profile of the channel on the upper left.
Audio level . .
(6) display Displays output audio level.
Indicates the name of the loaded clip.
7 | 16tip:] Ta}ppmg the entry area allows to change the
clip name.
Software keyboard»P115
(8) | [Cur:] Indicates the current timecode.
(9) | [Rem:] Indicates the timecode of the remaining time.

> P1/P2 channel (playlist view) — 3ch view
M@2)(3)(4) () (6)(7) (8)(9) (10) (11)

ur: 00:00:01;10:
em: 00:00:06;07

Playlist(1)

*(2) to (11) are common in P2 channel.

() P1channel tab/ | By tapping, selects and highlights the P1
P2 channel tab channel (or P2 channel).

Indicates the current playback mode (3D sync
mode, E to E mode, loop playback mode) of the
(2) | Playback mode P1 channel (or P2 channel) in white characters.
By tapping, also switches the playback mode.
Switching playback mode» P100

(3) | Status Indicates the playback progress status.

Locks P1 channel (or P2 channel) operations.

While the operations are locked, [Locked] and
[1] (or [P2] button) buttons light in red.

Tapping it again releases the lock.

(4) | [Locked]

Displays the video currently played back.

(5) | Preview If a playlist is not loaded, displays the output
profile of the channel on the upper left.
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Audio level . :

(6) display Displays output audio level.
Indicates the name of the loaded playlist.

(7) | [P.List:] Tapp¥ng the entry area allows to change the
playlist name.
Software keyboard»P115

(8) | [Now:] Indicates the name of the current event.

(9) | [Next:] Indicates the name of the next event.

(10) | [Cur:] Indicates the current timecode of the playlist.
Indicates the timecode of the remaining time
of event or the timecode of remaining time of
whole playlist.

(11) | [Rem:] The timecode to be displayed can be changed
by [Playlist Remain TC:] in [P1] (or [P2]) -> the
[Monitor & Remote] tab on the setting screen.
[Monitor & Remote] tab»P134

Loading contents to P1/P2 channel

The procedure to load the contents in the bin to the P1 channel or P2 channel
is described in this part.

Contents loaded to the P1/P2 channel can be performed playback or editing
of In/Out points.

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78
2 Select an item and tap [>P1] or [>P2].

The item is loaded to the P1 channel or P2 channel.

If the clip is loaded to the P1 channel (or P2 channel), clip view is displayed.
And if a playlist is loaded, playlist view is displayed.

P1/P2 channel (clip view) — 1ch view» P89

P1/P2 channel (playlist view) — 1ch view» P92

TIP ¢ To unload contents, display the P1 channel (or P2 channel) in
1ch view, tap [Menu], and then tap [Unload].
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Playing back with operation buttons

You can play the video of the selected channel using the operation buttons.

1 Press the [Play] button.

Control buttons» P35
During the playback, the [Play] button lights up.

Playing back in variable speed mode (variable playback)

You can play the video of the selected channel in the variable speed mode.

1 Press the [VAR] button.

Control buttons» P35
The mode switches to the variable speed mode and VAR speed control is
displayed.
While in the variable speed mode, the [VAR] button lights up.

> VAR speed control

(1)

Play Speed: 0.00

™

[<1/[>]

By every tap, increases or decreases the
playback speed by 0.1 time.

()

Speed control bar

By tapping on the speed control bar,
specifies the playback speed within the
range of -2 to +2 times.

@)

[Play Speed:]

Indicates the current playback speed.

(4)

[Close]

Closes the VAR speed control.

Even after closing the VAR speed control,
you can perform variable speed playback
by operating the jog/shuttle.

2 Press the [Play] button.

3 Tap the speed control bar and move it.

Steps 2 and 3 can also be operated by the jog/shuttle.
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Playing back in jog/shuttle mode

You can fast forward or rewind the video of the selected channel using jog/
shuttle operations.
The playback speed changes by the operating angle of jog/shuttle.

1 Press the [SHTL/JOG] button.

Control buttons» P35
The mode switches to the jog/shuttle mode and the [SHTL/JOG] button
lights up.

2 Turn the jog/shuttle.

Turn to the right to fast forward, and turn to the left to rewind.
Depending on the angle to turn the jog/shuttle, the speed can be switched
from 0.13 to 32 times (7 levels) for the right side, and from -0.13 to -32 times
(7 levels) for the left side.

TIP * The maximum speed of the shuttle (16 times/32 times) can be
changed.
Miscellaneous - Jog/Shuttle settings» P151

Loading and playing back video currently recorded (chasing

playback)

August 3, 2012

The video currently recorded in the R1 channel can be loaded and played
on the P1 channel (or P2 channel).

If you only want to load the currently recorded video and do not want to
play it back, you do not need to perform steps 1 to 4.

1 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer
screen.

2 Tap [P1] (or [P2]), and then tap [Video].
P1/P2 - Video settings» P132
3 In [Auto play mode:], tap and check [Auto Play].

4 Tap [OK].
5 Press the [P1] button (or [P2] button).

6 Switch to the clip view.
If the playlist view is displayed, tap [Clip View] to switch the display.
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7 Tap [Menu], and then tap [Now recording].

The video currently recorded in the R1 channel are loaded to the P1/P2
channel and played back automatically.

Switching playback mode

Outputting currently recorded video with active
through (E to E mode)

If the E to E mode is set to on in the P1 channel (or P2 channel), you can
output video currently recorded in the R1 channel to the P1 channel (or P2
channel) with active through.

NOTE e The video format of the channel set to the E to E mode and
that of the R1 channel must be the same.
R1 - Input Settings» P129
P1/P2 - Video settings»P132

1 Tap the P1 channel tab (or P2 channel tab).

2 Tap the playback mode, and then tap [E to E] from the menu.

[E to E] in the menu is checked and [E to E] in the P1 channel tab (or P2
channel tab) is displayed in white characters.

3 On the channel selected in step 1, stop the playback of contents
or unload it.

The video currently recorded is output when the playback of contents has
been stopped or loading of contents is not executed.

TIP * You can also perform the same operation by tapping [Menu] in
the 1ch view of P1 channel (or P2 channel), and then tapping
[Playout Mode] -> [E to E].
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Switching playback mode

Loop playback of contents (Loop mode)

If the Loop mode is set to on in the P1 channel (or P2 channel), you can
perform loop playback of the contents played on the P1 channel (or P2
channel).

1 Tap the P1 channel tab (or P2 channel tab).

2 Tap the playback mode, and then tap [Loop] from the menu.

[Loop] in the menu is checked and [Loop] in the P1 channel tab (or P2
channel tab) is displayed in white characters.

TIP * You can also perform the same operation by tapping [Menu] in
the 1ch view of P1 channel (or P2 channel), and then tapping
[Playout Mode] -> [Loop].

3 Play the contents selected in step 1.

Sync playback of contents (3D sync mode)

By setting pairing on two contents and set 3D sync mode on, the playback
status of the two contents can be synchronized.

You can use this function in such cases as when you want to synchronize
and play the L side and R side of a 3D video.

NOTE e The media files in a removable drive cannot be set to be

paired.

¢ A playlist and a clip cannot be set to be paired.

¢ The E to E mode and 3D sync mode cannot be set to on at the
same time.

¢ In 3D sync mode, only the following operations are available.
- Playing in normal playback speed
- Stopping playback
- Forwarding/rewinding frame by frame
- Moving to an In/Out point

1 Load contents to the P1 channel.

Loading contents to P1/P2 channel» P97
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2 1.oad the contents to be synchronized with the contents loaded in
step 1 to P2 channel.

3 Tap the P2 channel tab.

4 Tap the playback mode, and then tap [Sync] from the menu.

p2() clip: clip_oa

i EtoE
Syn o

ﬂ Sync

[Sync] in the menu is checked and [Sync.] in the P2 channel tab is displayed
in white characters.

TIP * You can also perform the same operation by tapping [Menu] in
the 1ch view of P2 channel, and then tapping [Playout Mode]
-> [Sync].
o If the output settings of the P1 channel and P2 channel are
different, the setting of the P2 channel will be automatically
changed to be the same as that of the P1 channel.

5 A message appears. Tap [Yes].

Pairing are set to the contents loaded on the P1 channel and the contents
loaded on the P2 channel.

6 Select the P1 channel and press the [Play] button.

Contents loaded on the P2 channel is played back, being synchronized with
the contents loaded on the P1 channel.

TIP ¢ To release the pairing of contents, operate in the [Bin] tab.
Releasing pairing of contents» P84

Playback of contents with alpha channel (Fill/Key
signal output mode)

You can play contents with transparency information (alpha channel).

1 Load the contents with alpha channel to the P1 channel (or P2
channel).

Loading contents to P1/P2 channel» P97
The mode switches to the Fill/Key signal output mode. Fill is output to the
loaded channel, and Key is output to the other channel.
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The icons indicating Fill and Key appear on the P1 channel tab and P2
channel tab respectively.

Bin

3ch
View

Config.

Transfer

Format:
T 1440x1080

Remaining:
50.94i Sas:ss

2:00 PM

2 Play the contents on the channel where Fill is output.

Playback operations of clips with alpha channel can be performed only on
the Fill side channel.

When you play a playlist that contains clips with alpha channel, the system
enters the Fill/Key signal output mode and the Key side channel will output
a black screen for normal clip playback.

TIP ¢ The Fill/Key signal output and normal modes will be switched
automatically while playing a playlist. The video may be
disrupted due to the output signal loss when the modes are
switched, however, this is not a system failure.

¢ The following operations are available while a clip with alpha
channel is loaded.

- Moving to an In/Out point

- Setting an In/Out point

- Creating a sub clip (you cannot create a sub clip of a still
image clip with alpha channel)

- Moving to the first frame, frame reverse, stop, playback,
frame forward, and moving to the last frame

- Scrubbing bar operation (workstation mode only)

- Setting a fade in effect (applied to the Key side)/fade out
effect (applied to the Key side)/actions (pause, loop) to an
event in a playlist

¢ The following operations are not available while a clip with
alpha channel is loaded.

- Fast forward and rewind

- Variable speed playback

- Switching to the TRIM mode in the playlist view

* You can also play clips with alpha channel using the remote
control with AMP commands.
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Editing a clip

Setting In and Out points to a clip

You can set In and Out points to a clip.
If In and Out points have been set to a clip, you can move to the set In point
or Out point, trim between In-Out points, or save it as a sub clip.

1 Load a clip to the P1 channel (or P2 channel).

Loading contents to P1/P2 channel» P97

2 Play a clip and tap [Mark(In)] when you want to set the In point.

Operation buttons of P1/P2 channel (clip view)» P91
The In point is set to the current position. A marker appears in the In point
position on the scrubbing bar.

104 T2 User Manual

3 Play a clip and tap [Mark(Out)] when you want to set the Out
point.

The Out point is set to the current position. A marker appears in the Out
point position on the scrubbing bar.

Cur: 00:09:37;00 em: 00:00:03;00
[ Y

TIP * You can also specify In and Out points with the timecode. Tap
the entry area of [In:] and [Out:], and enter the timecode.
P1/P2 channel (clip view) — 1ch view» P89

Trimming a clip between the set In-Out points

If set In and Out points are fixed, you can trim a clip between the In/Out
points.

1 Set In and Out points to a clip.
Setting In and Out points to a clip»P104

2 Tap [Set].
Operation buttons of P1/P2 channel (clip view)» P91
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Editing a clip

The information of the In-Out points for the clip is updated with the set In
and Out points. The space between the In-Out points is displayed in a pale
white bar.

Cur: 00:09:37;00 Rem: 00 :00 :00;00

[ 0 1

€I | e N P an

TIP * Even when a clip is trimmed between In-Out points, the
trimmed range of the video will not be deleted.
¢ To change the trimmed video between In-Out points, set In
and Out points to the clip again, and then tap [Set].

Creating a sub clip between In-Out points (highlight)

You can create a sub clip between set In-Out points and save it as a separate
clip.

1 Set In and Out points to a clip.

Setting In and Out points to a clip»P104

2 Tap [Create Subclip].

Operation buttons of P1/P2 channel (clip view)» P91
A sub clip including video between the set In and Out points is created and
saved in the same bin as the original clip.

Checking clip properties

You can check the properties of the clip loaded to the P1/P2 channel.
1 Tap [Menu] in the clip view, and then tap [Properties].

The properties of the clip are displayed.
Clip properties» P82

Changing a clip name
You can change the name of the clip loaded to the P1/P2 channel.
1 Tap [Menu] in the clip view, and then tap [Rename].

2 Enter a name and tap [OK].
Software keyboard»P115
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Updating thumbnails of clips

You can update the thumbnail images of the clips displayed on the contents
list in the bin view to the image of the current position.

1 Tap [Menu] in the clip view, and then tap [Set Thumbnail Frame].

Editing a playlist

T2 User Manual

Creating a playlist

You can create a playlist including multiple contents.

To create a playlist, add contents to the playlist view on the P1/P2 channel.

The contents added on the playlist are called event.

The procedure to create a new playlist is described in this part.

TIP * You can add a playlist to another playlist as an event. The
added playlist is called playlist event.
If you add a playlist which contains a playlist event to another
playlist, a message appears. Select an adding method of a
playlist event.

1 Press the [P1] button (or [P2] button).

2 Switch to the playlist view.
If the clip view is displayed, tap [Playlist View] to switch the display.
3 Tap [Add Event].

P1/P2 channel (playlist view) — 1ch view» P92
The dialog box to add an event appears.

TIP * To add contents to an existing playlist, select an event immediately
before the position to add the contents and tap [Add Event].

4 Tap [Select Bin].
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5 Select a bin that includes the contents to be added to the playlist
and tap [OK].

6 Select contents in the dialog box to add an event and tap [Add].
7 Repeat steps 4 to 6.

8 Tap [Close].

The contents are registered as events in the playlist by the added order.
Playlists are saved in the bin selected in step 5 with the name “Play (serial
number)”.

Deleting an event from a playlist

You can delete an event from a playlist.
Even after events have been deleted from the playlist, the original contents
will not be deleted.

1 Tap and select an event to delete in the playlist view.
The selected event is displayed with a blue frame.

2 Tap [Delete Event].

P1/P2 channel (playlist view) — 1ch view» P92

Playing back a playlist

You can load a playlist to the P1/P2 channel and play it.

1 Load a playlist to the P1 channel (or P2 channel).

Loading contents to P1/P2 channel» P97

When you load a playlist to the P1/P2 channel, the playback position
automatically moves to the In point of the first event.

Double-tapping a desired event can move the playback position to the In
point of the event.

2 Press the [Play] button.

Playing back video» P98
The event being played is highlighted in blue.
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Icons for events

The icons displayed in the thumbnails are described in this part.

> Event icons
Q) ()

@)

)
(1) | Fade in Indicates that fade in is set.
(2) | Fade out Indicates that fade out is set.
3) | Pause Indicates that the playback stop operation
of the event is set to pause.
(4) | Loop playback Indicates that loop playback is set.

Trimming an event

In the TRIM mode, you can trim an event by setting In and Out points to
the event.

1 Double-tap and select an event to trim in the playlist view.

2 Tap [TRIM].
The mode switches to the TRIM mode.

3 Play an event and tap [Mark(In)] when you want to set the In
point.
Operation buttons of P1/P2 channel (playlist view) » P94

The In point is set to the current position. A marker appears on the In point
position on the scrubbing bar.
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Editing a playlist

4 Play an event and tap [Mark(Out)] when you want to set the Out
point.

The Out point is set to the current position. A marker appears on the Out

point position on the status bar.

Cur: 00:00:04;13 pm: 00 :00 :03 ;04
. I

[
67

5 Tap [TRIM].

The TRIM mode exits, and the event is trimmed between the set In-Out
points.

Setting effects on an event

You can set effects at the event start point (start effect) or the effect at the
event end point (end effect).

1 Tap and select an event in the playlist view.

The selected event is displayed with a blue frame.

2 Tap [Menu], and then tap [Event Effect].

3 To set a start effect, tap the [Start Effect] tab and set each item.

> Event — [Start Effect] tab

Start Effect End Effect

@ FadeIn

Fade in (from black)

Fade Time

30 frames (1 - 300)

Apply

To set a fade in effect, check [Fade In] and select an
action from the list.

e [Fade in (from black)]

Sets a fade in effect from a black screen.
e [Fade in (from white)]

Sets a fade in effect from a white screen.

[Fade In]

Tap the entry area of [Fade Time] and enter the number
of frames from the start point to the end point.
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4 To set an end effect, tap the [End Effect] tab and set each item.

> Event - [End Effect] tab

Start Effect End Effect

™ Fade Out
Fade out (to black)

Fade Time

30 frames (1 -300)

4 Action

Pause (show black)

To set a fade out effect, check [Fade Out] and select an
action from the list.
e [Fade out (to black)]
Sets a fade out effect to a black screen.
e [Fade out (to white)]
Sets a fade out effect to a white screen.

[Fade Out]

Tap the entry area of [Fade Time] and enter the number
of frames from the start point to the end point.

To set an end action for playback, check [Action] and
select an action from the list.
e [Pause (show black)]
Pauses the playback with a black screen displayed.
e [Pause (show white)]
Pauses the playback with a white screen displayed.
e [Pause (last frame)]
[Action] Pauses the playback with the last frame displayed.
e [Pause (next event)]
Pauses the playback with the first frame of the next
event displayed.
¢ [Pause (show EtoE)]
Displays the video input to the R1 channel with
active through.
* [Loop]
Plays back the event in loop.

5 Tap [OK].

TIP e If you set the effects as an event template of playlist, the
template setting is applied to newly added events.
General — Miscellaneous settings» P125
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Editing a playlist

Updating playlist effect settings

You can collectively set effects for event starting (start effects) and actions
or effects for event ending (end effects) to all events in the playlist.
You can also collectively delete effects set to the events.

1 Display the playlist properties.

Checking playlist properties» P113
Checking the properties of the contents» P82

2 Tap the [All Events] tab.

> Playlist — [All Events] tab

Playlist Info = Timecode | All Events

¥ Change start effects:
@® Remove all start effects

O Add start effect to every event
Fade Time frames (1 - 300)
[J change end effects:

v

oK Cancel Apply

Check it when you want to update the setting of
start effects.

[Remove all start effects]
Deletes start effects set to the event.

[Add start effect to every event]
Updates start effects (fade in) set to the event.
[Change start To set a fade in effect, check [Fade In] and select
effects:] an action from the list.
e [Fade in (from black)]

Sets a fade in effect from a black screen.
e [Fade in (from white)]

Sets a fade in effect from a white screen.
Tap the entry area of [Fade Time] and enter the
number of frames from the start point to the end
point.
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[Change end
effects:]

Check it when you want to update the setting of
end effects.

[Remove all end effects]
Deletes end effects set to the event.

[Add end effect to every event]
Updates the end effects (fade out or end action for
playback) set to the event.
To set a fade out effect, check [Fade Out] and
select an action from the list.
e [Fade out (to black)]
Sets a fade out effect to a black screen.
e [Fade out (to white)]
Sets a fade out effect to a white screen.
Tap the entry area of [Fade Time] and enter the
number of frames from the start point to the end
point.
To set an end action for playback, check [Action]
and select an action from the list.
e [Pause (show black)]
Pauses the playback with a black screen displayed.
e [Pause (show white)]
Pauses the playback with a white screen displayed.
e [Pause (last frame)]
Pauses the playback with the last frame displayed.
e [Pause (next event)]
Pauses the playback with the first frame of the
next event displayed.
¢ [Pause (show EtoE)]
Displays the video input to the R1 channel with
active through.
* [Loop]
Plays back the event in loop.

3 Set each item and tap [OK].
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Changing a playlist name
You can change the name of the playlist loaded to the P1/P2 channel.
1 Tap [Menu] in the playlist view, and then tap [Rename].

2 Enter a name and tap [OK].
Software keyboard»P115

Checking playlist properties
You can check the properties of the playlist loaded to the P1/P2 channel.
1 Tap [Menu] in the playlist view, and then tap [Properties].

The properties of the playlist are displayed.
Playlist properties» P83

Checking event properties

You can check the properties of events in the playlist loaded to the P1/P2
channel.

1 Tap and select an event in the playlist view.
The selected event is displayed with a blue frame.

2 Tap [Menu], and then tap [Event Properties].
The properties of the event are displayed.

> Event properties

klip 01

00:00:00;00
00:00:15;06
00:00:15; 06
Clip

None

clip 01

0.0 dB
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[Event Info] tab

Displays the information of the event.

You can check the event name, event type (clip or
playlist), In/Out timecode, length, alpha channel
presence, the name of the contents being linked, etc.
Tapping the entry area allows to change the event
name and audio gain. (For still images, the length
can be changed.)

[GPI] tab

When controlling an external device with GPI
output, allows to check or set the trigger event
actions. (Only for P1 channel.)

Controlling external devices from T2 with GPI
output»P194

[Timecode] tab

Specifies starting timecode of an event. (Enabled
only when [According to event setting] is selected
in the [Timecode] tab in the playlist properties.)
To use the starting timecode of a media file, select
[Source].

To specify a starting timecode, select [Specify
Start Time)], tap the entry area, and enter
timecode.

[Start Effect] tab

Allows to check or set the effects for event ending
(end effects).

Setting effects on an event» P109

[End Effect] tab

Allows to check or set the effects for event ending
(end effects).

Setting effects on an event» P109

3 Tap [OK].
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Entering characters and numerics

Entering characters

The operation to enter characters in each screen is described in this part.

NOTE

* You cannot enter Japanese characters.

1 Tap the entry area of a screen.

2 Enter characters with the software keyboard.

> Software keyhoard
(1)

4) (5) (6)

(1) | Entry area Displays the characters entered with the
y software keyboard.
(2) | [Shift] Switches upper/lower case of alphabets.
(3) | Cursor (left and right) | Moves the cursor in the entry area.
(4) | [Space] Used as the space key.
(5) | [OK] Fixes the entered characters and closes the
software keyboard.
(6) | [Cancel] Cancels the entry and closes the software
keyboard.
(7) | [Dell Deletes currently selected entry or deletes
the character right after the cursor.
(8) | [BackSpace] Deletes the character right before the cursor.
3 Tap [OK].
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Entering timecode

The operation to enter timecode in each screen is described in this part.

1 Tap the timecode entry area of a screen.

2 Enter a timecode with the software keypad.

> Software keypad — Timecode
(1)

00:00:00;00
(8)

@)

(2 @)@ © 6)

Displays the timecode entered with the
software keypad.

According to the entered digits, the number
will be automatically converted into “hour,
minute, second, frame”. For example, enter
“4321” for 43 seconds 21 frames.

(1) | Entry area

(2) | Cursor (left and right) | Moves the cursor in the entry area.

Applies the entered value to the set value
for timecode as it is.

(3) | [=]

Allows to enter reduced or increased value
(relative value) from the current value.
Reduces the set value by entering after
tapping [-].

Increases the set value by entering after
tapping [+].

4) | [-1/1+]

Fixes the entered value and closes the

(5) | [0K] software keypad.

Cancels the entry and closes the software

(6) | [Cancel] keypad.

Deletes currently selected entry or deletes

(7) | [Dell the character right after the cursor.
(8) | [BackSpace] Deletes the character right before the cursor.
3 Tap [OK].
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Entering numerics

The operation to enter numerics in each screen is described in this part.

1 Tap the numeric entry area of a screen.

2 Enter numerics with the software keypad.

> Software keypad — Numeric
(1)

(6)
®)

Cancel

(2) @) (4)

Displays the numerics entered with the

(1) | Entry area software keypad.

Cursor (left and
2) right)

Moves the cursor in the entry area.

Fixes the entered value and closes the

(3) | [OK] software keypad.

Cancels the entry and closes the software

(4) | [Cancel] keypad.

Deletes currently selected entry or deletes

(3) | [Dell the character right after the cursor.

Deletes the character right before the

(6) | [BackSpace] cursor.

3 Tap [OK].
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Section

This section describes items that you can set in the setting screen.

Displaying the setting screen

You can make settings in the setting screen.

1 Tap [Config.].

The configuration screen appears.

> Settings

Audio reference level :

Audio Input/Output level :

Default...

®) (6)

™

Main category

Switches the main category of each setting.
By tapping, displays the sub category tabs
included in the main category.

()

Sub category tab

By tapping, displays the detailed settings of
the sub category.

@)

[Default...]

Restores all the settings made in the setting
screen to the default.

To enable the settings, you must restart
your T2.

(4)

[OK]

Saves the current settings and closes the
setting screen.
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Closes the setting screen without saving the

(5) [Cancel] current settings.

Saves the current settings. You can keep on

(6) | [Apply] making settings of other items.

General settings

General — Hardware settings

You can set synchronization or audio level between an external device
connected to your T2.

1 Tap [General], and then tap the [Hardware] tab in the setting screen.

> [Hardware] tab

Hardware | Network-1 | Network-2 |Network-3 | FTP | Miscellaneous

Reference : Internal

R1
P1
P2

Transfer
Audio reference level : -20 v B

Audio Input/Output level : v dBu
GPI

iscellaneous Default... Cancel

Selects a sync signal from [External], [Input],
and [Internal].

The signal status (NO SIGNAL/SYNC OK) will
be displayed in the lower line.

[P1:]
If the sync signal has been synchronized with
the P1 channel, displays [SYNC OK].

[P2:]
If the sync signal has been synchronized with
the P2 channel, displays [SYNC OK].

[Tri-Level HD H-shift:]

When HD3 value REF is used, adjusts REF
phase by entering a value. (Only when
[External] is selected.)

[Reference:]
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[BB HD H-shift:]

When SD Black Burst REF is used for HD REEF,
adjusts REF phase by entering a value. (Only
when [External] is selected.)

[BB SD H-shift:]

When SD Black Burst REF is used for SD REF,
adjusts REF phase by entering a value. (Only
when [External] is selected.)

[Reference:]

[Audio reference Selects the audio reference level (Headroom)
level:] from the list.

[Audio Input/Output Selects the audio input/output level from the
level:] list.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

General — Network-1/Network-2 settings

You can make network settings of your T2.

1 Tap [General], and then tap the [Network-1] tab or [Network-2]
tab in the setting screen.

> [Network-1]/[Network-2] tab

Hardware | Network-1 | Network-2 | Network-3 | FIP | Miscellaneous

- Local Area Connection 1

@® Obtain an IP address automatically

R1 ~
O Use following IP address :

P1

P2
IS server address automatically

Transfer z ing DNS server addresses :

Default...

[Obtain an IP address Uses DHCP and sets an IP address
automatically] automatically.
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Used to connect to the local area network by
specifying the IP address, subnet mask, and
default gateway:.

[IP address:]

[Use the following IP Specifies an IP address.
address:]
[Subnet mask:]

Specifies a subnet mask.

[Default gateway:]
Specifies a default gateway.

[Obtain a DNS server Uses DHCP and sets a DNS server address
address automatically] | automatically.

Used to connect to the local area network by
specifying the address of the preferred DNS
server and an alternate DNS server.

[Preferred DNS server:]
Specifies the address of the preferred DNS
server.

[Use the following DNS
server addresses:]

[Alternate DNS server:]

Specifies the address of an alternate DNS
server.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

General — Network-3 settings

You can set the network drive to connect with your T2.

1 Tap [General], and then tap the [Network-3] tab in the setting
screen.
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> [Network-3] tab

Hardware | Network-1 | Network-2 | Network-3 | FIP | Miscellaneous

Network Drive

Drive Folder
R1

P1
P2

4

Transfer

*This list can be edited on workstation mode only.

Default... OK

Displays the list of currently set network

Network drive list .
drives.

By clicking, displays the [Map Network Drive]
dialog box and adds a network drive.

(Add] [Map Network Drive] dialog box (workstation
mode only)»P122
[Disconnect]’ Disconnects the network drive.

*Only available in the workstation mode.

> [Map Network Drive] dialog box (workstation mode only)

[Drive:] Assigns a drive letter to a network drive.

Enter the “server name and shared folder” or
“IP address and shared folder” in the entry
[Folder:] area.

You can click [Browse..] to specify the path of
the network drive.

[Reconnect on next By checking, restores the network drive
bootup] allocations on the next start-up of T2.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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General — FTP settings

You can configure FTP settings when T2 is used as FTP server, or
the destination when external FTP server is used for a file transfer
destination.

1 Tap [General], and then tap the [FTP] tab in the setting screen.

> [FTP] tab

Hardware | Network-1 | Network-2 |Network-3 | FTP | Miscellaneous

FTP Server

R1
P1

P2

)t
- Stop

[ Limit the FTP transfer rate wh

Transfer

FTP Export List

Default... Cancel

Displays the FTP settings when T2 is used as FTP
server.

[Settings...]
By tapping, configures FTP settings for T2.

Tapping it displays the FTP setting dialog box for
T2 to configure the settings.

FTP setting dialog box for T2»P124
[Start]

Sets and uses T2 as FTP server.

[FTP Server] [Stop]
Releases the setting and stops using T2 as FTP
server.

[Limit the FTP transfer rate while recording or
playing.]

By checking, automatically restricts FTP transfer
rate while recording or playing.

If this option is unchecked, the recording/
playback operations may not be performed

normally, therefore, we recommend that you use
the system with this option checked.
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[FTP Export List]

transfer destinations.

[Add...]

[Delete]

[Change...]

Changes the server settings.

Displays the list of the FTP servers set as file

Tapping it displays the FTP destination setting
dialog box to configure the destination server.

FTP destination setting dialog box» P124

Deletes a server from [FTP Export List].

> FTP setting dialog box for T2

User Name :

ftpuser

Password ;
Max Clients : S

Bin(root directory) : Default

0K Cancel

[User Name:]/
[Password:]

Enter a user name and password.

[Max Clients:]

to access the FTP server of T2.

Specifies the maximum number of users allowed

[Bin(root directory):]

the root directory.

Specifies the bin to store media files uploaded to

> FTP destination setting dialog box

Setting Name: server
Host Name / IP Address:

Port Number:

Directory:

Example: /Default
User Name: user1

Password:

Connection Test

/Default

21 (1-65535)

[Setting Name:]

Enter the server setting name.

[Host Name/IP
Address:]

server.

Enter the IP address or host name of the FTP

[Port Number:]

Enter a port number (1 to 65535).

August 3, 2012



August 3, 2012
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[Directory:]

Enter the address of file transfer destination
folder (bin).

[User Name:]1/
[Password:]

Enter a user name and password.

[Connection Test]

By tapping, tests the FTP connection with the
entered user name and password.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

General — Miscellaneous settings

You can configure display language for T2 software, restart status, or

other settings.

1 Tap [General], and then tap the [Miscellaneous] tab in the setting

screen.

> [Miscellaneous] tab

Hardware | Network-1 | Network-2 |Network-3 | FTP |Miscellaneous

Language :
R1 DF mode :

Playlist auto scrol :
P1

Playlist event template :
P2

Statuses at the next startup

Transfer (@]
(]

Default...

English
®DF ONDF

®oN  OoFfF

Settings...

Cancel

[Language:]

Selects the display language for T2 software from
the list.

To enable the settings, you must restart your T2.

[DF mode:]

Select [DF] to set drop frame display to timecode,
or select [NDF] to set non-drop frame display.

[Playlist auto scroll:]

Sets whether to scroll the event list automatically
when playing a playlist.

[Playlist event
template:]

By tapping [Settings...], sets the effect as the event
template of the playlist. The template setting is
applied to newly added events.

The event template setting dialog hox» P127
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By clicking [Settings...], changes the settings for
event display or event background color in the
workstation mode.

[Playlist View Style:] dialog box (workstation mode
only)»P127

[Playlist View
Style:]”

By clicking [Settings...], sets the update interval of
[Preview update preview of the R1/P1/P2 channel.

interval:]" [Preview update interval:] dialog box (workstation
mode only) »P128

Sets whether to restore the status of the time
when exiting T2 at the next start-up.

[Keep the connections on the browse tab]

By checking, restores the removable drive
connection status displayed in the [Browse]

tab. The removable drive state displayed in the
[Browse] tab will be updated at the next start-up.

[Automatically playback the mounted contents on

P1/P2]

[Status at the next By checking, restores the contents status loaded

startup] to the P1/P2 channel.

By checking [Keep the playback frame positions

on P1/P2], restores the scrubbing bar playing

position.

Checking [Automatically playback the mounted

contents on P1/P2] plays the contents loaded to

the P1/P2 channel automatically at the next start-

up.

* The names or In/Out points of media files
loaded directly from the [Browse] tab cannot be
restored.

*Only available in the workstation mode.
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> The event template setting dialog box

Start Effect  End Effect

OFade In

Fade Time frames (1 - 300)

Default

Sets the effects for event starting (start effects).

(StartEffectIab | yont - [Start Effect] tab>P109

Sets the effects for event ending (end effects).

[End Effect] tab Event — [End Effect] tab» P110

[Default] Deletes event template settings.

> [Playlist View Style:] dialog box (workstation mode only)

Sets to show/hide the background color
indicating that the event has the playback
[Current Event position on the scrubbing bar.

Background Color:] | To change the background color, check this
item and specify the value for R, G, and B. The
specified color is displayed on the right.

Sets to show/hide the background color
indicating the next event of the event that has the
[Nest Event playback position on the scrubbing bar.
Background Color] To change the background color, check this

item and specify the value for R, G, and B. The
specified color is displayed on the right.
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[Selected Event
Background Color]

Sets to show/hide the background color
indicating the selected event.

To change the background color, check this
item and specify the value for R, G, and B. The
specified color is displayed on the right.

[Show keyboard
shortcuts(A-Z,
Function, 0-9 Key
only)]

Sets to show/hide the keyboard shortcut icon

assigned to the event.

* Icons can be shown only when the [A] to [Z]
keys, function keys, and [0] to [9] keys on the
keyboard are assigned.

[Show progress bar]

Sets to show/hide the progress bar of the
playback.

> [Preview update interval:] dialog box (workstation mode only)

(¥ Update

lower the CPIU usage for better user

[Update mode:]

To set the update interval of preview
automatically, select [Auto], and to set it manually,
select [Manual].

[R1:1/
[P1, P2: Update
everyl]

Set when [Manual] is selected in [Update mode;].
Enter the number of frames in [frames] of [R1:]
or [P1, P2: Update every]. If the value is larger,
the preview update interval becomes longer.

(By default, the preview is updated every two
frames.)

If you do not want to update the preview,
uncheck [Update preview].

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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R1 settings

R1 - Input Settings
You can make settings for input format to record in the R1 channel.

1 Tap [R1], and then tap the [Input Settings] tab in the setting
screen.

> [Input Settings] tab

Input Settings = Timecode & Remote [ Capture

General

P1
P2

Transfer

Default...

[Input type:]
Selects the port used for video input.

[Input format:]
Selects the format for video input.

[Aspect:]
[Video] For SD input, selects the aspect ratio.

[Pedestal:]

Selects the setup level (black level) for NTSC
from OIRE and 7.5IRE. OIRE is used in Japan,
and 7.5IRE is used in North America.
Checking [Correct white peak] performs white
peak correction.

[Format:]
Selects compression format.

[Compression] [Setting:]
Checking [HQ 150Mbps MAX] restricts the

compression ratio of Grass Valley HQ Codec to
150 Mbps.
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[Audio]

[Input type:]

Selects the port used for audio input from
[Analog], [Digital] (AES/EBU), and [SDI
Embedded].

[Input format:]
Check it to input in 16bit 2ch.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

R1-Timecode & Remote settings

You can make settings for the timecode or R1 channel remote control
when recording in the R1 channel.

1 Tap [R1], and then tap the [Timecode & Remote] tab in the

setting screen.

> [Timecode & Remote] tab

Input Settings | Timecode & Remote | Capture

P2
Record ancillary data

Remote Protocol (VTR Mode) :
Transfer

Default...

Cancel

[Select Timecode]

Selects the timecode type from [TC(LTC)] and
[SDI (VITC)].

[Recorded Timecode]

Selects the timecode to use for recording.

To use the timecode of an external device,
select [External].

To use the time of T2, select [Internal - System
time].

If [Internal - Specified start TC] is selected, tap
the entry area and specify the timecode.

[Record ancillary data]

Sets whether to save the VANC data when
recording.
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When controlling a VIR from T2 in the R1-VTR
[Remote Protocol (VTR | mode, selects remote protocol (AMP/BVW).
Mode):] If [AMP] is selected, set the IP address and
channel of the VTR in [AMP Connection].

When controlling a VIR from an external

IR i controller in the R1-remote mode, selects a
emote remote protocol (AMP/BVW),

Protocol(Remote . . .

Mode):] Check [Enable local operations while being

remote controlled.] to operate T2 locally even in

the remote mode.

TIP ¢ If [Enable local operations while being remote controlled.] is
checked, the operations available in the R1-remote mode are as
follows.

- Recording and stop

- Entering a clip name

- Editing tags (workstation mode only)
- Displaying properties

- Unloading clips

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

R1 - Capture settings

You can set whether to automatically export files being recorded in the R1
channel.

1 Tap [R1], and then tap the [Capture] tab in the setting screen.

> [Capture] tab

—_—
Input Settings | Timecode & Remote | Capture

General

t a clip being recorded (1 )

Default...
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By checking [Automatically export a clip being
recorded.], exports the file being recorded

in the R1 channel to the specified location
automatically.

(1) | [Capture]

(2) L?)(IECIIZ(I:‘} Export By tapping, specifies the export destination.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

P1/P2 settings

T2 User Manual

P1/P2 - Video settings
You can make settings for output format to load video to the P1/P2

channel and play it.

1 Tap [P1] (or [P2]), and then tap the [Video] tab in the setting
screen.

> [Video] tab

Video | Monitor & Remote | ProcAmp

General
Fe

R1

P2

Transfer

Default... Cancel

[Format:] Selects the format for video output.

When DVI/RGB output format is used, selects

[DVI option:] the resolution to use.

According to the items selected in [Format:]
[Output capability] and [DVI option:], displays the ports available
for output with green highlights.

For SD, selects the aspect ratio from [4:3] and

[Aspect:] [16:9].
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Selects the analog signal type output from the
DVI-I port.

Selects the setup level (black level) for NTSC
[Pedestal:] from OIRE and 7.5IRE. OIRE is used in Japan,
and 7.5IRE is used in North America.

[Component type:]

Selects the display mode when playback has

paused.

Selecting [Field] performs field corrections

[Still image:] between sti?l i@ages. The video is displayed in
a smooth still image.

Selecting [Frame] displays the top field and

bottom field alternately. The video is displayed

to be shaking.

Selects how conversion is to be performed
when the aspect ratio of the source loaded to
the P1 channel (or P2 channel) differs from the
channel settings.

Selecting [Bars] displays black bars in the
upper and lower or in the right and left.

|21
— o]

Conversion:] Q

Selecting [Crop] cuts the upper and lower parts
or the right and left parts.

O] = |O
O = | O

Checking [Auto Play] automatically plays
[Auto play mode:] the video when a source is loaded to the P1
channel (or P2 channel).

[Automatically mount | By checking, automatically loads a source
a clip being recorded being recorded in the R1 channel to the P1
on the player, when it's | channel (or P2 channel) when the source
ready for playback.] become transmittable.
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[When a subclip
is created in R1, By checking, automatically adds a sub clip
automatically mount created in the R1 channel to a playlist loaded to
it in the playlist of the | the P1 channel (or P2 channel).

player.]

NOTE e Even when [Automatically mount a clip being recorded on

the player, when it's ready for playback.] or [When a subclip

is created in R1, automatically mount it in the playlist of the
player.] was checked, they do not work in the following cases.

- The specified channel is locked or the 3D sync mode is set to on
- The specified channel is in the Fill/Key signal output mode

- The specified channel is in the remote mode (except when

the local operations are enabled in the remote mode)

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

P1/P2 — Monitor & Remote settings

You can make settings for the monitor output from P1/P2 output section
and remote control of P1/P2 channel.

1 Tap [P1] (or [P2]), and then tap the [Monitor & Remote] tab in
the setting screen.

> [Monitor & Remote] tab

P | —
Video | Monitor & Remote | ProcAmp

General

R1

P2
Playis

Transfer Remote protocol :

GPI (J Enable local operations while being remote controlled.

iscellaneous

Default... (0] ¢ Cancel

Makes settings for monitor output.

[Channel:]
Selects the channel for monitor output.

The channel that can be output from the P1
output section is fixed to [P1].

[Monitor out]

The channel that can be output from the P2 output
section is selectable from [R1], [P1], and [P2].
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[Monitor out]

[0SD:]

Selects whether to show the on-screen display
on the monitor.

Checking [Show Cur timecode] displays the
current timecode on the on-screen display.
Checking [Show Remain timecode] displays
the remaining time on the on-screen display.

[Playlist Remain TC:]

Selects the display style for the remaining time
of playlist for on-screen display:.

Selecting [Event] displays the remaining time
of the event.

Selecting [Total] displays the remaining time of
the whole playlist.

[Remote protocol:]

When controlling T2 from an external
controller in the P1-remote mode (or P2-remote
mode), selects a remote protocol (AMP/BVW).

[Enable local
operations while being
remote controlled.]

By checking, allows to operate T2 locally even
in the remote mode.

TIP ¢ If [Enable local operations while being remote controlled.] is
checked, the operations available in P1-remote mode (or P2-
remote mode) are as follows.

- Scrubbing bar operations (workstation mode only)

- Playback control operations (move to the first frame, rewind,
frame reverse, stop, playback, frame forward, fast forward,
and move to the last frame)

- Moving to In/Out points, setting In/Out points, deleting In/
Out points, creating sub clips

- Switching display scale of the scrubbing bar

- Switching audio level display

- Creating thumbnail

- Entering names of clips/playlists

- Editing tags (workstation mode only)

- Entering values for In point/Out point/duration, setting In
point/Out point/duration

- Editing playlist events list (add, delete, sort, copy, paste, and
change names)

- Displaying properties

- Loading and unloading clips/playlists

- Switching on/off for the 3D sync mode, E to E mode, Loop mode

- Operations with buttons on the lower part of the LCD
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2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

P1/P2 - Image quality adjustment settings

You can make adjustment of the image quality when video is composite
output or SD component output from the P1/P2 channel.

1 Tap [P1] (or [P2]), and then tap the [ProcAmp] tab in the setting
screen.

> [ProcAmp] tab

Video | Monitor & Remote | ProcAmp

Default... (0] 4 Cancel

[Video gain
(Composite, SD Adjusts the Y gain.
Component)]

[Chroma gain
(Composite, SD Adjusts the C gain.
Component)]

[Chroma phase

(Composite)] Adjust the color of video.

[Black level
(Composite, SD Adjusts the black level.
Component)]

[Video output
level (Composite, Performs fine adjustment of amplitude.
Component)]

Restores the settings made in the [ProcAmp]

[Restore default] tab to default.
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2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

Transfer settings

Transfer — common settings

You can make settings for file transfer.

1 Tap [Transfer], and then tap the [Common] tab in the setting
screen.

> [Common] tab

Commeon | AYCHD AVI
General
@pa
R1 Clip import configuration
Field order wher irm

P1

nbort of imaae and imaaes in A seauence formar

Default... OK Cancel

By unchecking, enables transfer and conversion
even during a recording or playback. However,
if this option is unchecked, the recording/
playback operations may not be performed

[Pause file transfers
while recording or

playing out.] normally, therefore, we recommend that you
use the system with this option checked.
Selects the field order when importing

[Clip import Windows Media Audio and H.264 (QuickTime

configuration] Video (avcl)). Selecting [Auto] automatically

selects and sets the appropriate field order.
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[Configure clip import
(for not supported
profile)]

Sets the frame size and scaling method when
importing media files that do not match the
profile supported by T2.

[Size:]

Selects the frame size for import.

[Scaling:]

Selects the scaling method when the frame size of
the imported source differs from that set in [Size:].

Selecting [Bars] displays black bars in the upper
and lower or in the right and left, to fit the long
sides of the frame of the source to that set in [Size:].

@ ]=[0]
—=]o]

O

Selecting [Crop] cuts the upper and lower parts
or the right and left parts, to fit the short sides
of the frame of the source to that set in [Size:].

0| =[O
O |==

Selecting [Stretch] stretches or reduces the
whole image, to fit the frame size of the source
to that set in [Size:].

O
O

O
O

—
—
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Makes settings for import of still images or
sequence still images.

[Format:]
Selects the format for import.

[Aspect:]
For SD, selects the aspect ratio from [4:3] and [16:9].

[Scaling:]

Selects the scaling method when the frame size
of the imported source differs from that of the
format set in [Format:].

Selecting [Bars] displays black bars in the upper
and lower or in the right and left, to fit the long
sides of the frame of the source to that of [Format:].

©]=[0]
= [o]

[Configure import of Q
image and images in a
sequence format]

Selecting [Crop] cuts the upper and lower parts
or the right and left parts, to fit the short sides
of the frame of the source to that of [Format:].

O
O

Selecting [Stretch] stretches or reduces the
whole image, to fit the frame size of the source
to that of [Format:].

O O
O O

[Duration(still image):]
Sets the playback duration of the imported still
images by seconds.

—

=
=

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — AVCHD settings

You can make settings for the format to import AVCHD sources.

1 Tap [Transfer], and then tap the [AVCHD] tab in the setting
screen.

> [AVCHD] tab

Default... OK Cancel Apply

[File format after import:]
Selects whether to import the file in the native

[AVCHD Import format or in a converted format at the time of
Settings] import.
Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — AVl settings

You can make settings for the format when converting contents in Grass
Valley HQ AVI format to MXF (XDCAM format) to export.

1 Tap [Transfer], and then tap the [AVI] tab in the setting screen.

> [AVI] tab

Common | AVCHD AV

General
AVI Export Settings

U Execute tr
R1
Advanced AVI transcoding settings

Ad AT fi
Pl

File

Default... (0]4 Cancel Apply

[Execute transcoding when exporting AVI file.]
[AVI Export Settings] By checking, converts files to the format set in
[Advanced AVI transcoding settings] to export.

[File type:]
Selects the file type.

[Format:]
Selects the format.

[Quality/Speed:]
Selects the quality.

[Scaling:]

Selects the scaling method when the frame size
[Advanced AVI of the exported contents differs from that of the
transcoding settings] format set in [Format:].

Selecting [Bars] displays black bars in the
upper and lower or in the right and left, to fit
the long sides of the frame of the contents to
that of [Format:].

@ =0
aad I8

O
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Selecting [Crop] cuts the upper and lower parts
or the right and left parts, to fit the short sides
of the frame of the contents to that of [Format:].

O
O

Selecting [Stretch] stretches or reduces the
whole image, to fit the frame size of the
contents to that of [Format:].

O
O

— | O
—

[Advanced AVI
transcoding settings] Q

—
0| =

[Audio format:]
Selects the audio format.

[ClosedGOP]

By checking, the information are closed within
GOP It increases the data size, but allows
re-editing with editor software. Uncheck it
normally.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — MXF settings

You can make settings for the format to import MXF sources.

1 Tap [Transfer], and then tap the [MXF] tab in the setting screen.

> [MXF] tab

Common | AVCHD AVI d

General
M:

R1

Default... OK Cancel Apply

[File format after import:]

Selects whether to import the file in the native
format or in a converted format at the time of
import.

Selecting [AVI(HQ)] converts the files to Grass
Valley HQ AVI format.

[MXF Import Settings]

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — XDCAM settings

You can make settings for the format to import XDCAM sources or
XDCAM EX sources.

1 Tap [Transfer], and then tap the [XDCAM] tab in the setting
screen.

> [XDCAM] tab

Common

General

XDCAM Import Settings
Fil import:

R1

Default... oK Cancel Apply

[File format after import:]
Selects whether to import the file in the native

[XDCAM Import format or in a converted format at the time of
Settings] import.
Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

[File format after import:]
Selects whether to import the file in the native

[XDCAM EX Import format or in a converted format at the time of
Settings] import.
Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

144 T2 User Manual August 3, 2012



Transfer settings

Transfer — P2 settings

You can make settings for the format to import P2 sources.

1 Tap [Transfer], and then tap the [P2] tab in the setting screen.

> [P2] tab

Common | AVCHD AVI d

General
P2

R1

Default... OK Cancel Apply

[File format after import:]

Selects whether to import the file in the native
format or in a converted format at the time of
import.

Selecting [P2 MXF (OP-Atom)] imports the
source in the native format.

Selecting [MXF (OP-1a)] converts the files to
MXF (OP-1a).

Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

[P2 Import Settings]

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — GF settings

You can make settings for the format to import GF sources.

1 Tap [Transfer], and then tap the [GF] tab in the setting screen.

> [GF] tab

Common | AVCHD AVI

General

R1

Default... OK Cancel Apply

[File format after import:]

Selects whether to import the file in the native
format or in a converted format at the time of
import.

Selecting [GF MXF (OP-Atom)] imports the
source in the native format.

[GF Import Settings]

Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — Playlist settings

You can make settings for the format to export playlists.

1 Tap [Transfer], and then tap the [Playlist] tab in the setting
screen.

> [Playlist] tab

Default... OK Cancel Apply

[File format after export:]

Selects the format for export.

[Playlist Export Selecting [MXF(XDCAM)] converts the files to
Settings] MXF (XDCAM) and exports it.

Selecting [HQ] converts the files to Grass
Valley HQ AVI and exports it.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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GPI settings

GPI - Input settings

You can make settings to control T2 with GPI input.

1 Tap [GPI], and then tap the [Input] tab in the setting screen.

> [Input] tab

Input [ Cutput

GPI-Input 1

Ort Op1 Op2

Default... oK Cancel Apply

Displays the number of the selected GPI input
pin.

GPI-Input

[ butl Tap [Previous] or [Next] and select a GPI input

pin to set.

Sets the GPI input trigger.

[Channel:]
Selects the channel to control with GPI input.

[Action:]

[Trigger settings] Selects the action when the GPI input pin
selected in [GPI-Input] is input.

List of actions for trigger setting»P148
[Active:]

Selects the GP1I signal to activate from [High]
and [Low].

> List of actions for trigger setting

[Stop] Stops playback or recording.
[Play] Plays the contents loaded to the channel.
[Record] Starts recording.
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Rewinds contents. When it comes to the
beginning of the loaded contents or when
performing another operation, rewinding
stops.

[Rewind]

Fast forwards contents. When it comes to the
[FastFwd] end of the loaded contents or when performing
another operation, fast forwarding stops.

[CueStart] Moves to the In point of the loaded contents.
[CueEnd] Moves to the Out point of the loaded contents.
[Eject] Unloads the loaded contents.

Loads the clip that is loaded to the R1 channel

[Preview] to the P1 channel.

[CueNextEvent] When loading a playlist, moves to the next
event of the selected event.

[CuePrevEvent] When loading a playlist, moves to the previous
event of the selected event.
Performs variable playback of the loaded

[VARPlayback] contents in the speed specified in [VAR

setting:].
Miscellaneous - Jog/Shuttle settings» P151

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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GPI - Qutput settings

You can make settings to control external devices by T2 with GPI output.
1 Tap [GPI], and then tap the [Output] tab in the setting screen.

> [Output] tab

Input | Output

General
GPI-Output 1

R1
Settings
Name : boo
P1 22
@ Hgh O Low
P2 I Trigger

Transfer * GPT-Outputs in Trigger mode are available on P1 only.

Default... OK Cancel Apply

Displays the number of the selected GPI output pin.

[GPI-Output] Tap [Previous] or [Next] and select a GPI
output pin to set.

Sets the GPI output trigger.

[Name:]
Sets the name of the GPI output trigger.

[Active:]
Selects the GP1I signal to activate from [High]
and [Low].

[Mode:]

Sets the GPI output trigger mode.

[Settings] Selecting [Trigger] controls an external device with
GPI output by specifying a trigger for an event in
the playlist loaded to the P1 channel of T2.
Selecting [Tally-R1] outputs tally signal from
GPI and lights up the tally lamp of the external
monitor while recording in the R1 channel.
Selecting [Tally-P1] (or [Tally-P2]) outputs tally
signal from GPI and lights up the tally lamp

of the external monitor while playing in the P1
channel (or P2 channel).

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Other settings

Miscellaneous — Jog/Shuttle settings

You can make settings for operations of the jog/shuttle.

1 Tap [Miscellaneous], and then tap the [Jog/Shuttle] tab in the
setting screen.

> [Jog/Shuttle] tab

Jog/Shuttle = AMP

General
Shuttle speed :

R1 VAR setting :

Default... (0]4 Cancel Apply

Selects the maximum speed for playback when

[Shuttle speed:] playing with the jog/shuttle.

Selects the playback speed when
[VAR setting:] [VARPIlayback] is selected in [Trigger settings]
in the [GPI] -> [Input] tab of the setting screen.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Miscellaneous — AMP settings

You can make settings for the AMP command actions when you control
T2 from an external device with the AMP command.

1 Tap [Miscellaneous], and then tap the [AMP] tab in the setting
screen.

> [AMP] tab

Jog/Shuttle | AMP

General
Command behavior

EraselD :
R1

P1

P2

GPI

- Default...

[EraselD:]

Makes settings for the actions of Erase ID
command of AMP.

[Command behavior] Selecting [Recycle] moves the contents to the
recycle bin.

Selecting [Delete] deletes the contents
completely.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Operations in Workstation Mode

This section describes screen elements of the workstation mode and
functions available only in the workstation mode.

Screen elements

> Full display — 3ch view

\
<«d o =B qp

B S I R o

(4)

(1) | Menu bar

By clicking, displays related menu.
Menu bar»P154

Channel display

2) part

Displays R1, P1, and P2 channels in 3ch view.
R1 channel - 3ch view» P155
P1/P2 channel — 3ch view»P162

(3) | Status bar

Status bar»P169

Bin/transfer
(4) | screen display
part

Performs contents management, import/export
of media files, display of the setting screen, etc.
Bin/transfer screen display part»P170
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> Menu bar

Systern Option Help

By clicking, displays the next menu.

[Switch to Front Panel mode]
Switches from the workstation mode to the front
panel mode.

[Switch to Workstation mode]
Switches from the front panel mode to the
workstation mode.

Switching from the front panel mode to the workstation
[System] mode» P47

[T2 to T2 Sync backup...]
Makes a backup of all data to another T2.

[Maintenance...]
Switches to the maintenance mode.

[Exit]
Exits T2.
Exiting T2 in workstation mode» P47

By clicking, displays the next menu.

[Log]
Sets the log level and displays logs.
Checking logs of operations and processes»P188

[Remove Device]

[Option] Disconnects a removable drive such as USB
removable device, XDCAM, P2, GF, etc.

[Customize]

Assigns keyboard shortcuts and sets mouse
operations.

Changing keyboard shortcut assignment» P178
Assigning commands to mouse operation» P180

By clicking, displays the next menu.

[Help] [About T2]
Displays the version of T2.
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> R1 channel — 3ch view
(M2 ()

4)(®) (6)

Screen elements

(7) &)(©) (10) (11)

By clicking, selects and highlights the R1

(1) | R1 channel tab channel.
(2) | Status Indicates the recording progress status.
Locks R1 channel operations.
While the operations are locked, [Locked]
(3) | [Locked] and [R1] buttons light in red.
Clicking it again releases the lock.
(4) | Preview Displays the video currently played back.
(5) | [Cur:] Indicates the current timecode.
(6) | Scrubbing bar Indicates the recording progress status.
(7) | [Elapsed:] I.ndlcates thg elapsed time of recording by
timecode display.
(8) | Audio level display Displays input audio level.
©) [Switch to audio Switches to the audio level detail display.
level detail display]l | Audio level detail display»P160
Switches the recording mode (R1-live mode
/R1-VTR mode/R1-remote mode).
(10) | Recording mode R1-live mode» P156
R1-VTR mode» P157
R1-remote mode»P158
(11) | [Unload] Unloads the video loaded to the R1
channel.
(12) | Operation buttons Operation buttons of R1 channel»P158
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156

T2 User Manual

> R1-live mode

@)

(8)

Enter the name of the clip currently

(1) | [Clip:] recorded.

) | [Tag:] Enter a tag for search to the clip currently
recorded.

(3) | [Properties] Displays the properties of the clip currently
recorded.

@) | [Mark In:] Indicates the In point timecode of the clip
currently recorded.

5) | (Mark Out:] Indicates the Out point timecode of the clip
currently recorded.

. Indicates the time length (duration) of the

(6) | [Dur:] .
clip currently recorded.
Displays the video size, frame rate, port

(7) | [Format] used for input, source TC (TC (LTC)/SDI

(VITC)/INT), etc.

(8)

[Live Record
Settings]

[Fixed Length On]

By clicking to set it on, automatically ends
recording after the duration from the start
point specified in [Length:].
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> R1-VTR mode
1) 2

Screen elements

®)

(6)

(1) | [Clip:]

Enter the name of the clip currently
recorded.

(2) | [Tag:]

Enter a tag for search to the clip currently
recorded.

(3) | [Batch]

Switches to the R1-VTR batch mode.
Recording sources at once (batch
capturing) »P182

(4) | [Properties]

Displays the properties of the clip currently
recorded.

(5) | [Format]

Displays the video size, frame rate, port
used for input, source TC (TC (LTC)/SDI
(VITC)/INT), etc.

[VTR Record

(6) Settings]

[VTR In:]
Enter the In point timecode of the clip
currently recorded.

[VTR Out:]

Enter the Out point timecode of the clip
currently recorded.

[Length:]
Indicates the time length (duration) of the
clip currently recorded.

[Fixed Length On]

By clicking to set it on, automatically ends
recording after the duration from the start
point specified in [Length].
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> R1-remote mode

(1 @ ©)

()

Enter the name of the clip currently
recorded.

(1) | [Clip:]

Enter a tag for search to the clip currently

(2) | [Tag:] recorded.

Displays the properties of the clip currently

(3) | [Properties] recorded.

Displays the video size, frame rate, port
(4) | [Format] used for input, source TC (TC (LTC)/SDI
(VITC)/INT), etc.

> Operation buttons of R1 channel
(2) 0y @) oy (B) - (8) o (10)(12)

(1)| 3) | ®) | () | 9) |(11)| (13)

(1) | [Cue(In)]™ Moves the VIR to the In point.

(2) | [Cue(Qut)]™" Moves the VIR to the Out point.

(3) | [Rewind]" Rewinds the VTR.

@) [IVIO\{e to the * By every click, moves back the VIR frame
previous frame]™ by frame.

(5) | [Stop] Stops playback or recording.
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Screen elements

Starts recording.

The icon display changes depending on
the recording mode.

Indicates that a recording stop operation is

(6) | [Record] necessary.
In-dicates that it is a fixed length recording.
?dicates that In point and Out point are
set.
(7) | [Play]™ Plays the VTR.
(8) [Move }0 the next By every click, moves forward the VTR
frame]™ frame by frame.
(9) | [FastFwd]™ Fast forwards the VTR.
(10) | [Mark(In)] Sets In point to the current position.
(11) | [Mark(OQut)] Sets Out point to the current position.
(12) | [Clear (In/Out)] Clears set In/Out points.
Creates a sub clip between In-Out points
(13) | [Create Subclip]™ set while recording, and saves it as

highlight.

*1 Only for R1-VTR mode.
*2 Only for R1-live mode.
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> R1 channel - 1ch view
The display is same as that of R1 channel — 3ch view.
R1 channel — 3ch view» P155

> Audio level detail display
(1(2)

Channel;

(7) (6)

*This screen is the audio level detail display for the R1 channel. The
display for the P1/P2 channel partly differs.

Displays only in the P1/P2 channel.

(1) | [<1/>] Switches the audio level detail display and
VAR speed control.
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Screen elements

(2)

Switching of display
scale

Selecting [Peak] makes the maximum level
to 0 dB.

Selecting [Ref] makes the set audio
reference level as the standard level.

You can set the audio reference level in
[Audio reference level:] from [General] ->
[Hardware] tab in the setting screen.

General — Hardware settings»P119

3)

Input port

Displays only in the R1 channel.
Indicates the port used for input.

(4)

Gain slider

By moving the slider, adjusts the gain for
each channel (only ANA is available for the
R1 channel).

(5)

Level meter

Displays the input audio level for each
track.

(6)

Monitor channel

Indicates the channel that monitors the
audio level.

For the R1 channel, you can select a
channel to monitor from the list.

(7)

[Close]

By clicking, closes the audio level detail
display.

> VIAR speed control
(1)

(2)(3)

Switches the audio level detail display and

(1) | <] VAR speed control.

By every click, increases or decreases the
@) | <] playback speed by 0.01 time.

By clicking on the speed specifying bar or
(3) | Speed specifying bar the value indicating the speed, specifies the

playback speed within the range of -2 to +2
times.
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By every click, increases or decreases the

(4) | [<<l/[>>] playback speed by 0.1 time.

(5) | [Close] By clicking, closes the VAR speed control.

> P1/P2 channel — 3ch view
(M2)3)4) (5) ®)(7) (8) (9) (10) (11)(12) (13) (14)  (15)

Cur: 00:09:33;28 Rem
[ N
B P RadOsBP 1P

*(2) to (16) are common in P2 channel.

() P1channel tab/ | By clicking, selects and highlights the P1
P2 channel tab channel (or P2 channel).

Locks P1 channel (or P2 channel) operations.
While the operations are locked, [Locked] and
[P1] (or [P2] button) buttons light in red.

Tapping it again releases the lock.

(2) | [Locked]

(3) | Output profile Indicates the output profile of the channel.

(4) | Status Indicates the playback progress status.

Switches on and off of the current playback
mode (3D sync mode, E to E mode, loop
playback mode) of the P1 channel (or P2
channel).

(5) | Playback mode

Displays the video currently played back.
To update the thumbnail of the contents with

6) | Preview
(©) the video of the current position, right-click the
preview and click [Set Thumbnail Frame].
(7) | [Cur:] Indicates the current timecode.
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(8) | Playback speed

Indicates the current playback speed (times).

(9) | Scrubbing bar

Indicates the playback progress status and
markers of set In/Out points.

(10) | [Remain:]

Indicates the timecode of the remaining time.

Audio level

() display

Displays input audio level.

[Switch audio
level detail
display/VAR
speed control]

(12)

Switches to the audio level detail display or
VAR speed control.

Audio level detail display»P160

VAR speed control»P161

[Clipl/

(13) [Playlist]

Switches to the clip view or playlist view.
P1/P2 channel (clip view) — 3ch view» P163
P1/P2 channel (playlist view) — 3ch view» P164

(14) | [Remote]

Switches to the P1-remote mode (or P2-remote
mode).

(15) | [Unload]

Unloads the contents loaded on the P1 channel
(or P2 channel).

[Operation

(16) Button]

Operation buttons of P1/P2 channel» P165

> P1/P2 channel (clip view) — 3ch view

Cur: 00:06:02;06

[ U
| P RdOs P 1P

(1) @ @ @

*(1) to (9) are common in P2 channel.

(1) | [Zoom]

Switches the display scale of the scrubbing bar.
Clicking it displays [Zoom] in red, and displays
the In-Out pints of the clip as the whole scale.

Clicking it again returns the display to the
original scale and displays the whole clip.

(2) | [Clip:]

Indicates the name of the loaded clip.
Also allows to edit the clip name.
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3) | [Tag:] Indicates the tag for search of the loaded clip.
o Also allows to edit the tag.

Displays the properties of the clip currently

(4) | [Properties] loaded.

Indicates the In point timecode of the clip.

(5) | [Mark In:] Also allows to enter and edit the In point
timecode.

Indicates the Out point timecode of the clip.

(6) | [Mark Out:] Also allows to enter and edit the Out point
timecode.
(7) | [Set] Trims the clip between the set In-Out points.

Indicates the time length (duration) of the clip.

(8) | [Dur:] Also allows to enter and edit the timecode of
the duration.

Displays the In and Out points of the clip,
(9) | [Clip Contents] duration of the clip, video size of the clip, and
frame rate.

> P1/P2 channel (playlist view) — 3ch view

*(1) to (5) are common in P2 channel.

Switches to the TRIM mode. You can edit the
In/Out points of the event selected in the event
(1) | [TRIM] list.

P1/P2 channel (playlist view) — 1ch view/TRIM
mode» P167

(2) | [Playlist Menu] | Displays the related menu.

3) | [Playlist:] Indicates the nam‘e of the IOE‘Ided playlist.
Also allows to edit the playlist name.
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Screen elements

(4)

[Properties]

Displays the properties of the playlist currently
loaded.

)

Event list

Displays the list of events in the playlist.

By right-clicking the event, displays the related

menu.

The background color of the event indicates the

current status of the event.

¢ Red indicates that the event has the playback
position on the scrubbing bar.

¢ Green indicates the next event of the event
that has the playback position on the
scrubbing bar.

¢ Blue indicates that the event is selected.

The background color of the event can be

changed to your preferred color.

[Playlist View Style:] dialog box (workstation

mode only) »P127

> Operation buttons of P1/P2 channel

)

(M7 G G) (M) 7O (1) 7 (13)
) AHAAO> PP 1P TT ek

(4) , (6) - (8)

(10),,,.(12) .. (14)

(1) | [Cue(In)] Moves to the In point of the contents.
(2) | [Cue(Out)] Moves to the Out point of the contents.
In the TRIM mode of clip view or playlist
view, moves to the previous edit point (top
3) [Move to previous of the clip, In/Out point after trimmed) by
edit point] every click.
In the playlist view, moves to the In point
of the previous event.
Rewinds the contents. By every click,
(4) | [Rewind] switches the speed to 2 to 32 times (5
levels) and plays in backward.
(5) [Move to the By every click, moves back the contents
previous frame] frame by frame.
(6) | [Stopl] Stops playback.
(7) | [Play] Plays the contents.
(8) [Move to the next By every click, moves forward the contents

frame]

frame by frame.
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Fast forwards the contents. By every click,
(9) | [FastFwd] switches the speed to 2 to 32 times (5
levels) and plays.

In the TRIM mode of the clip view or

playlist view, moves to the next edit point

[Move to next edit (In/Out point after trimmed, end of the

(10) . . .
point] clip) by every click.

In the playlist view, moves to the In point

of the next event.

Sets In point to the current position. After
(11) | [Mark(In)] In point has been set, the In point marker
appears on the scrubbing bar.

Sets Out point to the current position.

(12) | [Mark(Out)] After Out point has been set, the Out point
marker appears on the scrubbing bar.

(13) | [Clear (In/0ut)] Clears set In/Out points.
Creates a sub clip between In-Out points

(14) | [Create Subclip] set while recording, and saves it as
highlight.

> P1/P2 channel (clip view) — 1ch view

The display is same as that of P1/P2 channel (clip view) — 3ch view.
P1/P2 channel — 3ch view» P162

P1/P2 channel (clip view) — 3ch view» P163

g a >
S —— ) &
) AR O E PP 1P T3 ok
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> P1/P2 channel (playlist view) — 1ch view/TRIM mode

The preview and operation button parts are same as that of P1/P2 channel
(playlist view) — 3ch view.

P1/P2 channel - 3ch view» P162

P1/P2 channel (playlist view) — 3ch view» P164

The elements which differ from that of P1/P2 channel (playlist view) — 3ch
view are described here.

*(1) to (7) are common in P2 channel.

Switches on and off of the TRIM mode.
Displayed in red during in the TRIM mode.

By clicking when in the TRIM mode, exits the
TRIM mode.

(1) | [TRIM]

(2) | [Playlist:] Indicates the nam.e of the loe‘1ded playlist.
Also allows to edit the playlist name.

Indicates the tag for search of the loaded
(3) | [Tag:] playlist.
Also allows to edit the tag.

Displays the properties of the playlist currently

(4) | [Properties] loaded.
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Displays the information of the event being
played.

[Event:]

Indicates the name of the event.

Also allows to edit the event name in the TRIM
mode.

[In:]
Indicates the timecode of the In point.

Also allows to edit the In point timecode in the
TRIM mode.

(5) | [Current Event) | [OUE:]
Indicates the timecode of the Out point.

Also allows to edit the Out point timecode in
the TRIM mode.

[Dur:]
Indicates the timecode of the length of the
event (duration).

Also allows to edit the timecode of the duration
in the TRIM mode.

[Set]
Displays only in the TRIM mode.
Trims between the set In-Out points.

(6) | [Playlist Menu] | Displays the related menu.

Displays the list of events in the playlist.

By right-clicking the event, displays the related

menu.

The background color of the event indicates the

current status of the event.

* Red indicates that the event has the playback
position on the scrubbing bar.

(7) | Event list e Green indicates the next event of the event
that has the playback position on the
scrubbing bar.

¢ Blue indicates that the event is selected.

The background color of the event can be

changed to your preferred color.

[Playlist View Style:] dialog box (workstation

mode only)»P127
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> Status bhar

Screen elements

(2)

(3)(4)(3) (6) 7 ®)

[3ch Disp.l/
[1ch Disp.] switching

Switches 3ch view and 1ch view.

(2)

Operation mode

Displays the current operation mode
(workstation mode/front panel mode).

@)

Log notification icon

Notifies a warning or error log with an icon
when it occurs. Clicking the icon displays
the [Log] dialog box and allows to check
the details.

(4)

[FTP]

Indicates that the FTP server of T2 is in use.

(5)

Transfer process
icon

Indicates an icon that notifies import,
export, or file conversion is in process.

(6)

[CPU]

Indicates the CPU load status of T2.

(7)

Remaining HDD
(remaining time)

Displays the estimated recording time
available on HDD.

When the remaining capacity reduces, the
icon is displayed in red.

Displays the current time.
Set the time in the maintenance mode. For

(8) | Time ) ) i
more information about the maintenance
mode, refer to the T2 Maintenance Manual.
NOTE Ifthe icon appears on the status bar, there is a problem

with the RAID system. Consult the shop of purchase.
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> Bin/transfer screen display part

(1|) 2 & @ (?)

Displays the bin view ([Bin] tab, [Browse]

(1) | [Folder] tab, [Recycle Bin] tab, and [Search] tab).
Displays the transfer screen.

2) | [Transf

(2) | [Mransfer] Transfer screen»P175
Switches to [Bin] tab/[Browse] tab/[Recycle
Bin] tab/[Search] tab.

. N [Bin] tab»P171

(3) | View switching tab | g0\ ce] tabmP172
[Recycle Bin] tab»P173
[Search] tab»P174

(4) | [Config.] Displays the setting screen.

(5) | [X] Exits or restarts T2.
Displays the menu related to import.

(6) | [Import] The display switches to the [Browse] tab.

Import menu»P175
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Screen elements

(7)

[Export]

Displays the menu related to export.
The display switches to the [Bin] tab.
Export menu»P176

> [Bin] tab

®)

™

[New Bin]

Creates a new bin.

(2)

[Search Contents]

You can search contents in the bin.
Searching for contents»P185

@)

Bin list

Displays the list of bins.
The selected bin is highlighted in blue.

Right-clicking the selected bin displays the
related menu.

(4)

Contents list

Displays the list of contents selected in the
bin list.

The selected item is highlighted in blue.

Right-clicking the selected contents
displays the related menu.

)

[Detail]

Displays the details of the contents selected
in the contents list.
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> [Browse] tab

(4)

When a removable drive is connected to
1 | [..] T2, you can select a folder to display in the
[Browse] tab.

Displays the removable drive media or
folders in the drive connected to T2.

(2) | Removable drive list | The selected folder is highlighted in blue.
Right-clicking the selected folder displays
the related menu.

Displays the list of media files in the drive
selected from the removable drive list.
The selected media file is highlighted in
blue.

Right-clicking the selected media file
displays the related menu.

(3) | Media file list

Displays the details of the media file

(4) | [Detaill selected in the media file list.
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> [Recycle Bin] tab

(4)

Deletes all files in the recycle bin.

(1) | [Empty Recycle Bin] | Note that the deleted contents cannot be
restored.

Displays the list of folders in the recycle
bin.
The selected folder is highlighted in blue.

Right-clicking the selected folder displays
the related menu.

Recycle hin folder
list

(2)

Displays the list of contents in the folder
selected in the recycle bin folder list.

(3) | Contents list The selected item is highlighted in blue.
Right-clicking the selected contents
displays the related menu.

Displays the details of the contents selected

(4) | [Detail] in the contents list.
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> [Search] tab

(4)

You can search contents in the bin.

(1) | [Search Contents] Searching for contents» P185

Displays the list of folders of the search
result.

The selected folder is highlighted in blue.
Right-clicking the selected folder displays
the related menu.

Search result folder
list

()

Displays the list of contents in the folder
selected in the search result folder list.
(3) | Contents list The selected item is highlighted in blue.
Right-clicking the selected contents
displays the related menu.

Displays the details of the contents selected

(4) | [Detail] in the contents list.
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> Transfer screen

Screen elements

@)

(1) | [Delete]

Deletes selected jobs. If you tap [Delete]
while executing a job, the job will be
canceled.

(2) | [Clear]

Deletes all jobs from the job list.

(3) | Job list

Displays the list of jobs.
[Clip]

Indicates the name of the clip.

[Status]
Indicates the job progress status.

[Bin]

Indicates the bin name.

[Path]

Indicates media file path and file name.

> Import menu

ey Expart Detal

[Add a new
connection...]

When a removable drive is connected to T2, you
can select a folder to display in the [Browse] tab
by clicking it.

[Import the selected

items...]

Imports the media file selected in the media file
list to T2 as a clip.

August 3, 2012
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Imports all the media files in the folder selected

[Import all items...] from the removable drive list.

[Import selected Imports still images with numbers that are serial
items as a sequence | to the selected still image as a single sequence clip
file...] (in Grass Valley HQ AVI).

> Export menu

Import (NEREEEN Detal

[Export the selected | Exports the selected contents as media files or T2
items...] format (TWF) files.

Exports the all items in the selected folder as

[Exportall items...] media files or T2 format (TWF) files.

Keyboard and mouse operations in workstation mode

Multiple selection of contents

You can select multiple contents in the media file list, contents list, and
event list in the same way as PC operations.

Use the [Ctrl] key or [Shift] key on the keyboard or drag the mouse to
select multiple contents and perform operations from the right-click
menu.

In the event list, you can change the event order by the drag & drop
operation with a mouse. You can also sort the multiple events you
selected.
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Keyboard and mouse operations in workstation mode

Loading contents to P1/P2 channel by drag & drop
operation

You can quickly load contents in the media file list and contents list to the
P1/P2 channel by drag & drop operation with a mouse.

1 Select contents and drag & drop it to the display area of the P1
channel (or P2 channel).

Adding events to playlist by drag & drop operation

You can quickly add events to the playlist by drag & drop operation with
a mouse.

You can also add the playlist to another playlist as an event without
spreading it out.

1 Select contents and drag & drop to the event list.

The contents are added to the dropped position as an event.
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Sorting events in playlist

You can quickly sort events in the playlist by drag & drop operation with
a mouse.

1 Select an event in the event list and drag & drop to the
destination.

Major keyboard shortcuts

The following illustration shows the allocation of frequently used
keyboard shortcut keys (default).

Channel Select

|| BR[|
| =
N
Play'Stop I a ;

Changing keyboard shortcut assignment

You can customize the shortcuts assigned to the keyboard.

The procedure to make a new keyboard shortcut setting based on the
default keyboard shortcut to change the shortcut key assignment is
described in this part.

1 Click [Option] on the menu bar, and then click [Customize] ->
[Keyboard Shortcuts...].
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Keyboard and mouse operations in workstation mode

> [Keyboard Shortcuts] dialog box

1) [Keyboard Selects a keyboard shortcut to use.
Shortcuts:] The default name is “default”.

Displays the [Edit List] dialog box and allows
(2) | [Edit List] to change the keyboard shortcut settings in the
items of new creation/copy/delete/name.

Action category | Switches the action category ([General] tab/

(3) switching tab [Contents List] tab/[Playlist] tab).

Displays the list of actions of the selected

(4) | [Command:]
category.

[Enter the new Enter a new shortcut key to assign to the
key:] selected command.

(®)

Assigns the shortcut key entered in [Enter the

(6) | [Set assign] new keyi).

Displays the shortcut key assigned to the

(7) | [Current keys:] selected command.

Deletes the shortcut key selected in [Current

(8) | [Delete] keysi].

2 Click [Edit List].

3 In the [Edit List] dialog box, click [New...].

4 Enter a name of a keyboard shortcut and click [OK].
5 In the [Edit List] dialog box, click [Close].

6 Select the added shortcut setting from the list of [Keyboard
Shortcuts:] in the [Keyboard Shortcuts] dialog box.

7 Select a category from the action category switching tab.
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8 Select an action with [Command:].

9 Enter the shortcut key to assign in the entry area of [Enter the
new key:] and click [Set assign].

The entered shortcut key is displayed in [Current keys:].

10 Click [OK].

Click [Apply] to keep on making settings of other items.

Assigning commands to mouse operation

You can assign commands so that certain mouse operations performs
certain actions, such as loading a clip on the P1/P2 channel and playing it.
The procedure to create a new setting for mouse and assign the command
to the mouse is described in this part.

1 Click [Option] on the menu bar, and then click [Customize] ->
[Mouse...].
> [Mouse Customize] dialog box
(1) )

3)

(4) ®)

(6)

[Mouse
settings:]

(1)

Selects a mouse setting to use.

Displays the [Edit List] dialog box and allows to
(2) | [Edit List] change the mouse settings in the items of new
creation/copy/delete/name.

Action category | Switches the action category ([Contents List]

(3) switching tab tab/[Playlist] tab).

Displays the list of mouse operations of the

[Mouse operation mode selected in [Setting].

operation:]

(4)

Select a mouse operation to assign a command.
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Displays the list of actions of the selected
category.

5) | [Command:

G| : Select a command to assign to the mouse

operation selected in [Mouse operation:].

Selects the operation mode of mouse from
[Single Click Mode], [Double Click Mode], and
[Single Click + Double Click].

Checking [Allow multiple selection] allows
multiple selections of contents by the mouse
operation.

(6) | [Setting]

Click [Edit List].
In the [Edit List] dialog box, click [New...].
Enter the name of the mouse setting and click [OK].

In the [Edit List] dialog box, click [Close].

o~ O A W DN

Select the added mouse setting from the list of [Mouse settings:]
in the [Mouse Customize] dialog box.

N

Select the operation mode of mouse in [Config.].

8 Select a mouse operation to assign a command in [Mouse
operation:].

9 Select an action with [Command:].

10 Click [OK].
Click [Apply] to keep on making settings of other items.
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Recording sources at once (batch capturing)
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You can import the batch capture list to your T2 and record sources from
VTR at once.
The batch capture lists in the following file formats can be imported.
* CSV file (Model/Mode2) (*.csv): Batch capture list created with EDIUS
¢ ALE file (*.ale): File corresponding to Avid Log Exchange batch capture
list
¢ FCL file (*.fcl): File corresponding to Apple Final Cut Pro batch capture
list
NOTE e After importing the batch capture list to your T2, you cannot
change In/Out points, duration, or reel name, and you cannot
add batch capture items.

Set the connection information of the VIR used for action setting of
batch capturing and for recording, or the video format for capturing
beforehand.

General — Hardware settings»P119

R1 settings»P129

Transfer — common settings» P137

Make settings in the setting screen according to the environment in use.
Settings»P118

The procedure to import a batch capture list and start recording is
described in this part.

1 Click the R1 channel tab.

R1 channel is selected.
R1 channel — 3ch view» P155

2 Click [VTR].

The mode switches to the R1-VTR mode.

3 Click [Batch].

The mode switches to the R1-VTR batch mode.
4 Click [Load Batch Capture List].

5 Select the batch capture list and click [OK].
The batch capture list appears.
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> R1-VTR batch mode
(M@ @)

(4)

®) (6)

[Load Batch Imports the batch capture list (CSV, ALE, FCL
Capture List] files).

Deletes a batch capture item.

2) [Delete Batch You can also perform the same operation by
Capture Item] selecting and right-clicking an item, and then

clicking [Delete].

Sorts the batch capture items.

Selecting an item and clicking [Move Up] or
[Move Down] moves an item up or down by
one line.

[Move Upl/
[Move Down]

©)
You can also perform the same operation by
selecting and right-clicking an item, and then
clicking [Move Up] or [Move Down].

[Status]

Displays the recording progress. When an error
occurs, displays the error detail.

[No]

Displays the serial number corresponding to
the suffix of the clip name generated after the
batch capture.

[Reel]
Displays the reel name.

Batch capture
list

(4)
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[In TC1/[Out TC1/[Dur TC]
Displays the timecode of In point/Out point/

duration.
) Batch capture The timecode to be prioritized when recording
list is underlined. To change the prioritized

timecode, select and right-click an item, and
then click [Change to "In/Out Capture"] or
[Change to "In/Dur Capture"].

Displays the total number of the batch capture
items.

(5) | [Count:]

Displays the total duration in the batch capture

(6) | [Duration:] list.

TIP * Select and right-click an batch capture item, and then click
[Select All] to select all items.

6 Press the [Rec] button.

If batch capture items with different reel names set exist in the batch
capture list, a message appears. Insert a tape corresponding to the reel
name into the VTR and click [OK]. (If the same reel names are set in all
batch capture items, or if no reel name is set, the message will not appear
and recording starts.)

Recording starts and the progress is displayed in [Status].

If you stop the batch capture in the middle, click [Stop].

Clips that have been completed recording are stored in the currently
selected bin.
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Displaying media files in network drive

You can display media files in the network drive at the [Browse] tab by
making settings of the network drive connected to T2 in the workstation
mode.

1 Click [Config.], and click the [General] -> [Network-3] tab.

General — Network-3 settings»P121

2 Click [Add].

The [Map Network Drive] dialog box appears.

3 Assign a drive letter to [Drive:].

4 In the [Folder:] entry area, enter the “server name and shared
folder” or “IP address and shared folder”, and then click [OK].

You can click [Browse...] to specify the path of the network drive.

5 Click [OK].

é Display the [Browse] tab.

[Browse] tab»P172
The drive letter assigned in step 3 is displayed in the removable drive list.

7 Click [...] at the right of the drive letter, and select a folder in the
network drive, and then click [OK].

The contents in the network drive are displayed in the media file
list.

Searching for contents

You can specify search conditions and search for contents in the bin.

1 Click [Search Contents].

This operation is available in the [Bin] tab or [Search] tab.
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> [Search] dialog box

o4

Modified

[ 7f ojzo1z @~ M 7/ g9f2012 B~

[Bin:] Select the search target bin from the list.

Specify search conditions. If multiple
conditions are specified, AND search will be
performed.

[Name:]
Enter the contents name to search.

[Date:]

Select [Modified] or [Created], click the icon on
the calendar, and set the date.

[Search condition]

[Type:]
Select [SD] or [HD] from the list.

[Tag:]
Enter the tag added to the contents.

2 Select a search target bin from the list of [Bin:].

3 Specify search conditions and click [OK].

The search starts.
The contents that matches the search conditions are displayed in the

contents list in the search result folder of the [Search] tab.
[Search] tab»P174

TIP ¢ To change the search conditions, right-click the search result
folder and click [Change Search Criteria...].
¢ To delete the search result folder, right-click the search result
folder and click [Clear].
¢ To change the name of the search result folder, right-click the
search result folder and click [Rename].
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Changing the display of playlist view

Changing the display of event list

You can switch the display of event list to the icon view or list view
without thumbnail.

1 Right-click on the event list and click [View] -> the display option
([Icons]/[Tiles]/[List]/[Details]).

TIP ¢ If keyboard shortcuts are assigned to events and one of [Icons]/
[Tiles]/[List] is selected for the view, an icon is displayed on the
thumbnail.

- A red icon indicates the shortcut assigned to the event of the
selected channel.

- A black icon indicates the shortcut assigned to the event of
the specified channel.

¢ If one of [Icons]/[Tiles]/[List] is selected for the view, you can

change the display size of the thumbnail. Right-click on the

event list and click [View] -> [Thumbnail Size] -> the display

size ([Large]/[Middle]/[Small]).

Changing the display or background color of events

You can change the settings of the event view style and background color.

1 Right-click on the event list and click [View] -> [Customize...].

The [Playlist View Style:] dialog box appears.
[Playlist View Style:] dialog box (workstation mode only) »P127

2 Configure the settings, and then click [OK].
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Checking logs of operations and processes

Displaying a log

You can output logs of operations and processes. Use it to find out the
cause of troubles.

1 Click [Option] on the menu bar, and then click [Log] -> [Show
log...].

> [Log] dialog box

)

Selects [Operation Log] to display operation
logs, and select [Process Log] to display process
logs.

Output log
switching

(1)

Displays the list of groups for operations or
(2) | Group list processes. A group is created daily (or when
the log data exceeds 10 MB).

Displays the log list of the group selected in the

(3) | Loglist group list.

Displays the explanation for the log selected in
the log list.

(5) | [Close] Closes the dialog box.

(4) | [Description:]

TIP  * When an error occurs, you can also display the [Log] dialog
box by clicking the notification icon on the status bar.
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Checking logs of operations and processes

Changing log level settings

You can change the output log levels of operations and processes.
By the default setting, information, warning, and error will be output.

1 Click [Option] on the menu bar, and then click [Log] -> [Logging
level...].

> [Log Level Setting] dialog box

Selects the type of operation log to output.

[Error]
Outputs only error logs.

[Warning + Error]
[Operation Log] Outputs warning and error logs.

[Information + Warning + Error]
Outputs information, warning, and error logs.

[All]
Outputs all logs including debug information.

Selects the type of process log to output.

[Error]
Outputs only error logs.

[Warning + Error]
[Process Log] Outputs warning and error logs.

[Information + Warning + Error]
Outputs information, warning, and error logs.

[All]
Outputs all logs including debug information.

2 Configure the settings, and then click [OK].
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Remote Control

This section describes the remote control using GPI input/output, AMP
command, and BVW command.

Remote control using AMP/BVW

Overview of AMP control

For T2, the following AMP control are available via Ethernet.
¢ Controlling an external device from T2 with AMP (R1-VTR mode)
¢ Controlling T2 from an external controller with AMP (R1-remote
mode)
¢ Controlling T2 from an external controller with AMP (P1/P2-remote
mode)

TIP * For the AMP commands list, see “Appendix”.
AMP command list»P203

NOTE ° The AMP commands for T2 do not support controlling via
RS-422.

Overview of BYW control

For T2, the following BVW control are available via R5422
¢ Controlling an external device from T2 with BVW (R1-VTR mode)
¢ Controlling T2 from an external controller with BVW (R1-remote
mode)
¢ Controlling T2 from an external controller with BVW (P1/P2-remote
mode)
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TIP e For the BVW list of commands used in the R1-VTR mode, see

“Appendix”.
BVW command list»P216

¢ For the availability of BVW commands used in the remote
mode, see “Appendix”.
BVW list supporting remote mode» P217

¢ For the input/output pin assignment of R5422, see “Appendix”.
RS422 input/output pin»P218

Controlling an external device from T2 with AMP/BVW
(R1-VTR mode)

The operation of T2 to control an external device (VIR) with the AMP
command (via Ethernet) or BVW command (via RS422), using T2 as a
controller (master) is described in this part.

When you use the BVW command, you do not need to perform steps 1 to 3.

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [General], and then tap the [Network-1] tab or [Network-2] tab.

3 Set the IP address of T2.

General — Network-1/Network-2 settings»P120

4 Tap [R1], and then tap [Timecode & Remote].

5 Select a remote protocol from the list of [Remote Protocol(VIR
Mode):].

If [BVW] is selected, proceed to step 7.

6 If [AMP] is selected in step 5, set the IP address and channel of
the VTR.

7 Tap [OK].

8 Press the [R1] button, and then tap [VIR].

Controlling of an external device from T2 with AMP command or BVW
command will be enabled.
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Controlling T2 from an external controller with AMP/
BVW (R1-remote mode)

The settings of T2 to control the R1 channel of T2 from an external
controller with the AMP command (via Ethernet) or BVW command (via
RS422) is described in this part.

T2 accepts commands from the external controller as a device (slave).

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [R1], and then tap the [Timecode & Remote] tab.
3 Select a remote protocol from the list of [Remote Protocol(Remote
Mode):].

TIP ¢ Check [Enable local operations while being remote controlled.]
to operate T2 locally even in the remote mode.
R1-Timecode & Remote settings» P130

4 Tap [OK].

5 Press the [R1] button, and then tap [Remote].

Controlling of R1 channel from an external controller with AMP or BVW
command will be enabled.

Controlling T2 from an external controller with AMP/
BVW (P1/P2-remote mode)

The settings of T2 to control the P1/P2 channel of T2 from an external
controller with the AMP command (via Ethernet) or BVW command (via
RS422) is described in this part.

T2 accepts commands from the external controller as a device (slave).

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [P1] or [P2], and then tap the [Monitor & Remote] tab.
P1/P2 — Monitor & Remote settings»P134
3 Select a remote protocol from the list of [Remote protocol:].

TIP ¢ Check [Enable local operations while being remote controlled.]

to operate T2 locally even in the remote mode.
P1/P2 — Monitor & Remote settings»P134

4 Tap [OK].
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5 Press the [P1] button.

6 Tap [Menu], and then tap [Remote].

[Remote] will be checked.
Controlling of P1/P2 channel from an external controller with AMP or
BVW command will be enabled.

TIP ¢ For EraselD command of AMP, you can set whether or not to
delete clips completely.
Miscellaneous — AMP settings» P152

Remote control using GPI

Overview of GPI control

For T2, the following GPI control are available.

> Controlling T2 with GPI input

You can control T2 by assigning actions to the GPI input port (6 pins).

GPI input will be accepted regardless whether T2 is in the remote mode or
the channel is locked.

On T2, configure the settings in [GPI] -> [Input] tab of the setting screen.
GPI - Input settings» P148

NOTE ° When controlling T2 with GPI input, do not use RS422 at the
same time. Controlling with RSS422 may become disabled.

> Controlling external devices from T2 with GPI output
Controlling external devices from T2 with GPI output»P194

> Tally output from GPI

You can configure your T2 to output tally signal from GPI and turn on the
tally lamp of an external monitor while playing back or recording video.
On T2, configure the settings in [GPI] -> [Output] tab of the setting screen.
GPI - Output settings» P150

TIP e For GPI input/output pin, see “Appendix”.
GPI settings»P148
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Controlling external devices from T2 with GPI output

You can control an external device with GPI output by specifying a trigger
for an event in the playlist loaded to the P1 channel of T2.

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [GPI], and then tap [Output].
GPI - Output settings»P150

3 Tap [Previous] or [Next] and select a GPI output pin.
The number of the selected pin is displayed on the right of [GPI-Output].

4 Set [Name:] and [Active:] in the trigger setting, and select
[Trigger] from the list of [Mode].

5 Tap [OK].

6 Load the playlist including the event to specify a trigger to the
P1 channel.

7 Press the [P1] button.

8 Tap an event to set the trigger from the event list to select it.

The selected event is displayed with a blue frame.

9 Tap [Menu], and then tap [Event Properties].
10 Tap the [GPI] tab.

11 Check [Trigger GPI] and select the name of the trigger setting set
in step 4 from the list.
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12 Select an action of the event to be the trigger.

Event Info GPT Timecode = StartEffect = End Effect

& Trigger GPI  GPT-OUT-2

@® start of Event
O End of Event
O start plus

O End Minus

* GPI-Outputs are available on P1 only.

0K Cancel Apply

* Select [Start of Event] to set the playback start of an event to be the
trigger.

¢ Select [End of Event] to set the playback end of an event to be the
trigger.

* Select [Start plus] to add a specified time to the time of playback start
of an event and set it to be the trigger. Tap the timecode and enter the
time to add.

¢ Select [End Minus] to subtract a specified time from the time of
playback end of an event and set it to be the trigger. Tap the timecode
and enter the time to subtract.

13 Tap [OK].
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Appendix

This section includes the list of the keyboard shortcut in the workstation mode, input/output format,

operation-ensured drivers for each device, AMP command, and BVW command.

Keyboard shortcut list in workstation mode

The following list shows the default keyboard shortcuts.

Category Action Shortcut
[Select R1 channel] [1]
[Select P1 channel] [2]
[Select P2 channel] [3]
[Start Recording the selected channel (R1)] [M]
[Start playback in the selected channel] [L]
[Play reverse in the selected channel] [71
[Play or pause the selected channel] [Space]
[Stop playing/recording in the selected channel] K]
[Fast Forward (skip) in the selected channel] [l
[Rewind (1 step back) in the selected channel] [H]
[Increase (1 step forward) the VAR speed in the selected [

[General] channel]

[Slower (1 step back) the VAR speed in the selected channel] | []

[Move to top frame(previous event) of the selected channel] | [A]
[Move to last frame(next event) of the selected channel] [S]
[Move to In point of the selected channel] [Shift+I]
[Move to Out point of the selected channel] [Shift+O]
[Move to the next frame in the selected channel] =]
[Move to the previous frame in the selected channel] [<]

[Set the In point of the selected channel] [1]

[Set the Out point of the selected channel] [O]
[Clear the In/Out points of the selected channel] Egg:{g}
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Operation-ensured drivers for each device

Category Action Shortcut
[Mount the selected item on the selected channel] [Enter]
[Scroll to top of selected item] [Home]
[Scroll to last selected item] [End]

[Contents List] [Delete selected item] [Delete]

[Backspace]
[Copy selected item] [Ctr]]+C]
[Cut selected item] [Ctrl]+[X]
[Paste item from the clipboard] [Ctrl]+[ V]
[Cue up to the selected event] [Enter]
) [Delete the selected event] [Delete]

[Playlist]
[Copy the selected event] [Ctr]]+C]
[Paste the selected event] [Ctrl]+[ V]

Operation-ensured drivers for each device

Operation-ensured driver versions for XDCAM/XDCAM EX

The operations of the following version of driver have been ensured on this product.

Product name

Version

XDCAM Browser

Ver. 2.1.0

Operation-ensured driver version for P2

The operations of the following version of driver have been ensured on this product.

Product name

Version

Memory Card Drive “P2 drive” AJ-PCD20 P2 Driver Ver. 2.1.8 (64 bit)
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Input/output format list

Input format

O: Supported, A: Not all supported, X: Not supported

Video Audio Post-import format
Container Format Codec Format Native cﬁ""‘llé:"s?gn Re%rggzl]v;XF Unpack
Grass Valley HQ CcuvcC Linear PCM O — — —
Grass Valley HQX" | CHQX Linear PCM X O — —
DV
DVCPRO25
AVI DVCPRO50
DVCPRO HD Linear PCM x © — —
Uncompress YUV YUY2
uYvy
Uncompress RGB
Grass Valley Lossless| CLLC O X
Grass Valley HQ CuvC . O ©)
Grass Valley HQX" | CHQX Linear PCM X X
AVC Intra 50
AVC Intra 100 ACIH
D10/IMX 30Mbps CIX3
D10/IMX 50Mbps CIX5
MXF — —
DV CDVC | Linear PCM/A- o o
DVCPRO25 CDVP law
DVCPRO50 CDV5
DVCPRO HD CDVH
JPEG2000
MPEG2 M2ES
Dolby Digital
AVCHD H.264/AVC AVCE | (AC-3)/Linear O O — —
PCM
DV CDVC
DVCPRO25 CDVP g M
DVCPRO50 CDV5 inear I
P2 DVCPRO HD CDVE (48kHZl; 11)6 bit/24 O O O —
AVC Intra 50 ACI5
AVC Intra 100 ACIH
XDCAM DV 8 channels
(VFAM/ IMX AES3/Linear O O — —
Linear PCM
XDCAM EX MPEG2 M2ES ( 48kl?{z, 15 bit) O O — —
DV CDVC
DVCPRO25 CDVP Linear PCM
GF DVCPRO50 CDV5 (48kHzt,) 1)6 bit/24 O O X _
M2ES 1
MPEG2 ChG
Windqws Windows Media Windows.Media « o . .
Media Video Audio
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Video Audio Post-import format
Container Format Codec Format Native clll\r‘ll\lléﬂs?gn Re%rgﬂmXF Unpack
DV CDVC
DVCPRO 25 CDVP
DVCPRO 50 CDV5
DVCPRO HD CDVH
e | v
ProRes422 nepa/
scpa
ProRes422 HQ hcpa
ProRes422 Proxy ocpa
ProRes4444 h4pa
JPEG2000 2pjm
Animation elr
MPEG4 v4pm
Photo JPEG gepj AAC/
PNG gnp | Apple Lossless/
QuickTime Uncompressed YUV | UYVY MP3/ADPCM/A- X O - -
Sans war Igw/U—law/
Linear PCM
QuickTime Video YUY?2
(mp4v)
Uncompress 10 bit C210
Uncom\l{)lrje\s}s 10 bit YUY2
QuickTime Video YUY?2
(rpza)
Qulck(l;lvnilg)Wdeo YUY2
Motion JPEG A apjm
Motion JPEG B bpjm
Sorenson Video 3 3QVS
Uncompressed RGB
Grass Valley HQ cuvcC
Grass Valley HQX | CHQX
MPEGI1 Audio
Layer-2/
MPEG2 MPEG2 M2ES | Dolby Digital X O — —
(AC-3)/
Linear PCM
Still image — A O — —
TWF X X — O

*1  When importing Grass Valley HQX AV], the file will be automatically converted to Grass Valley

HQ AVL
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Output format

Sources imported to T2 can be exported in “Post-export format” in the table.
O: Supported, A: Not all supported

Video Audio Post-export format
i Nativ
Container Format Codec Format AVI (HQ) (xglchFM) (ex(c:tlagt) ?\VI TWF
AVI Grass Valley HQ CuvC Linear PCM O O — ©)
Grass Valley HQ CUVC Linear PCM
AVC Intra 50
AVC Intra 100 ACIH
D10/IMX 30Mbps CIX3
D10/IMX 50Mbps CIX5
MXF DV CDVC | Linear PCM/ O
DVCPRO25 CDVP A-law
DVCPRO50 CDV5
DVCPRO HD CDVH
JPEG2000
MPEG2 M2ES
Dolby Digital
AVCHD H.264/AVC AVCE (AC-3)/Linear O
PCM
DV CDVC . .
DVCPRO25 cove | A A
DVCPROS50 CDV5 Inear 1AV
P2 DVCPRO HD CDVH (481(521’)113 bit/ ©
AVC Intra 50 ACI5
AVC Intra 100 ACIH
DV 8 channels
XDCAM IMX AES3/Linear O
MPEG2 M2ES | PCM/A-law
Linear PCM
XDCAM EX MPEG2 M2ES (48kHz, 16 bit) O
DV CDVC
DVCPRO25 CDVP Linear PCM
GF DVCPRO50 CDV5 | (48kHz, 16 bit/ 'e)
M2ES 24 bit)
MPEG2 DG
Still image — — — O
Playlist O ©) O

*1 Can be exported by converting contents to AVI (HQ).
Converting contents to other formats» P84
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Supported video format and output port

Video format Composite SDI DVI-I ?\:’;:Pr) RGB
1920 x 1080 50/59.94p CEAS861D

1920 x 1080 50/59.94i 292M CEA861D 274M

1920 x 1080 24p (PsF) 292M CEA861D 274AM

1280 x 720 50/59.94p 292M CEA861D 296M

1280 x 720 24p 292M

720 x 480 59.94i 170M 259M EBU N10

720 x 576 501 BT.470 259M EBU N10

1280 x 1024 60p DVI 1.0 DMT
1024 x 768 60p DVI 1.0 DMT
800 x 600 60p DVI 1.0 DMT
640 x 480 59.94p DVI 1.0 DMT

Notes on T2 export
O: Supported, A: Not all supported, X: Not supported

Import/Export media Alpha presence In/Out point | _. _ Chasing
e Time-shift | export of
Clip media . specifying/ i di FTP export
Export media No Yes sub cli expor recording
type p file
o
AVI O O O O (For FTP o
AVI export: A7)
MXF O ANG O X Q6 O
TWEF (T2 format) O O O X VAN O
MXF O O X3 X — O
MXF
TWEF O O X8 X — @)
XDCAM O O X3 X — x
XDCAM
TWE (T2 format) O O X8 X — @)
XDCAM EX O O X3 X — x
XDCAM EX
TWEF (T2 format) @) @) X *8 X — @)
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Import/Export media Alpha presence In/Out point | _. _ Chasing
e Time-shift | export of
Clip media . specifying/ i di FTP export
Export media No Yes sub cli expor recording
type p file
P2 O O X3 X — x
P2
TWEF (T2 format) | O ©) X8 X — @)
GF O O X3 X — x
GF
TWEF (T2 format) | O ©) X8 X — @)
AVCHD O O X3 X — O
AVCHD
TWEF (T2 format) O O X8 X — @)
Still image Ok O — X — ©)
Still image
TWEF (T2 format) | O ©) — X — @)
AVI O O O™ yANG — O
Playlist MXF O ©) o X — @)
TWEF (T2 format) @) O X8 X — O

*1 Clips are converted to have no alpha.
*2 Original still image files are exported.

*3 Cutting out and exporting a clip between In and Out points are not supported. (The whole
original media file is exported.)
*4 In/Out point settings of the event in the playlist is retained. No sub clip supported.
*5 An index file is exported at the last stage of creating an AVI file.
*6 Only valid when [Pause file transfers while recording or playing out.] is unchecked in the
[Transfer] -> [Common] tab.
*7 Although the export task is added, the export process is automatically paused until the
recording ends.

*8 When TWF files are imported to T2, In/Out point settings are restored.
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AMP command list

AMP command list

The AMP commands available in T2 are listed in the following tables. The commands with gray-
colored cells in the list are not supported by T2.
For detailed information on AMP commands, refer to the AMP Specification document.

NOTE ° The latency in the number of frames from the time the command such as Play or Stop is
issued to the time the operation actually starts is not fixed. The video loaded on multiple
T2 cannot be synchronized in the accurate frames by AMP commands.
¢ Clips that are not allowed to play or that contain playback restriction will not be loaded
on T2.

Device management

Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementary_ note on T2
less mode mode | output operation
mode
[DF mode] setting that is in
[Miscellaneous] of [General]
in the setting screen will be
Set Drop changed.
01.06 O O O O O
Frame Mode Since [DF mode:] is a common

setting for R1/P1/P2, the
setting change will be applied
to the other channels.

Enabling and disabling of
00.0C | Local Disable No @) @) @) @) local control or remote control
can be set for each channel.

Enabling and disabling of
0X.1D | Local Enable No O O @) @) local control or remote control
can be set for each channel.

0x20 and 0x50 are returned

i [P | o | 0| o | o | o |Smpemdngieoduic
number, respectively.

20.04 | Standby Off No No No No No

20.05 | Standby On No No No No No

20.60 | EE Off No No O No No

20.61 | EE On No No O No No
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Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementarv. note on T2
less mode mode | output operation
mode
It takes several seconds from
Set Mute the time the command has
21.62 Mode No No © © © been issued until the time the
setting is applied.
A8.20 | Set Device ID O O @) O @)
A0z | Device D O O O O O
Request
A0.2c | Device Name O O O O O
Request
Transport controls
Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementary_ note on T2
less mode mode | output operation
mode
Specifying the timecode value
on the command execution
. O O @) O
2X.00 | Stop No (event schedule) is not
supported.
Specifying the timecode value
on the command execution
2X.01 | Play No No © © © (event schedule) is not
supported.
Specifying the timecode value
on the command execution
2X.02 | Record No O No No No (event schedule) is supported
only when the input type is
LTC or VITC (SDI).
20.0F | Eject No O O @) O
20.10 | Fast Forward No No O No No Plays back the video in 32
times the normal play speed.
2X11 | Jog Forward No No O No No™
ax1p | Variable No No | O No | No!
Forward
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Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementary_ note on T2
less mode mode | output operation
mode
ox3 | Shuttle No | No | O | No | No"
Forward
Plays back in reverse the
20.20 | Rewind No No O No No video in 32 times the normal
play speed.
2X.21 | Jog Reverse No No O No No™
2X.22 Variable No No O No No™
Reverse
2X.23 Shuttle No No O No No™!
Reverse
X 31 Cue Up With No No o o o A pseudo clip “<BLACK>" is
Data not supported.
20.52 Tension No No No No No
Release
44.05 BEE? e No No No No No Not supported on T2.
Preset
40.20 | In Reset No No @) @) O
For R1, the setting will be
applied on the timecode
that is saved when video is
Timecode recorded.
41.36 N O N N N
Mode Preset © © © © For LTC, the timecode of TC
input is recorded, and for
VITC, the timecode of SDI
input is recorded.
4040 | AutoMode No | No| O | © 0o
Off
4041 | AutoMode No | No | O | © o
On
If you want to change
Set Loop ﬂE Sli::ll?gsgr?;’ﬁt?(fmmand
4142 | Playback No No | O e o |Payback
Mode approximately four or more
seconds before it comes to the
position to set loop.
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Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementarv. note on T2
less mode mode | output operation
mode
Set
4143 | Widescreen No O No No No
Mode
If you want to change
the setting during the
4144 Set Stop No No o o o playbagk, send the command
Mode approximately four or more
seconds before it comes to the
position to set stop.
Get Stop
4045 Mode No No O ©) O
State Change
60.0B | Latency No No No No No | Not supported on T2.
Request
Since obtaining User Bits is
not supported, 00000000 will
always be returned.
The response is always the
same value regardless of the
) type of LTC or VITC.
C tT
61.0C | STt e O O O O O If LTC source or VITC source
Sense o .
has been specified, R1 input
timecode is returned.
Only 1.LTC, 4Timer,
8:WindowsTime, and 40:LTC
(Src) (R1 LTC input) are
supported.
*2
61.20 Status Sense o o o o o
Record Cue Only specifying the clip name
AX.02 | Up With No O | No | No | No [, yspecilyingthecup
Data is available.

*1 Operates only when the specified speed is 0 (Stop).
*2  Supported status flag

Data0 Busy, Remote+Local/ Local
Datal Play, Record, FFW, REW, Stop
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Data2 Still, TapeDirection, Var, Shuttle

InPreset, OutPreset, AutoMode, FolderalreadyExist,
Data3 InvalidFolderName, FolderDeletionFail,

SourceMissing
Data4 EEOn, LoopPlayBack

FolderNotFound, OutPresetFail, PreviewInPreset,
Data9 .

PreviewOutPreset

IDNotFound, MovieDeleteComplete,
DataA MovieDeleteFail

TapeTop, TapeEnd, LTC, Timer, VITC, TimeOfDay,
DataD

DropFrame

Managing clips on the timeline

Command

Channel-
less mode

R1

P1/P2

3D Sync
mode

Fill/Key
signal
output
mode

Supplementary note on T2
operation

4X.14

In Preset

O

A pseudo clip “<BLACK>" is
not supported.

4X.15

Out Preset

If you want to set an Out
point during the playback,
send the command
approximately four or more
seconds before it comes to the
position to set the Out point.

4F.16

Append
Preset

If you want to execute

the command during the
playback, send the command
approximately four or more
seconds before it comes to the
end point of Preset Timeline.

4X.21

Out Reset

If you want to set an Out
point during the playback,
send the command
approximately four or more
seconds before it comes to the
position to set the Out point.

A0.06

Preview In
Reset

No

No
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Command

Channel-
less mode

R1

P1/P2

3D Sync
mode

Fill/Key
signal
output
mode

Supplementary note on T2
operation

AX.07

Preview Out
Reset

No

No

If you want to set an Out
point during the playback,
send the command
approximately four or more
seconds before it comes to the
position to set the Out point.

44.31

Pre-roll

Not supported on T2.

AX.04

Preview In
Preset

If you want to execute

the command during the
playback, send the command
approximately four or more
seconds before it comes to the
end point of Preset Timeline.
A pseudo clip “<BLACK>" is
not supported.

AX.05

Preview Out
Preset

No

No

If you want to set an Out
point during the playback,
send the command
approximately four or more
seconds before it comes to the
position to set the Out point.

AF.0A

Append
Preview
Preset

If you want to execute

the command during the
playback, send the command
approximately four or more
seconds before it comes to the
end point of Preset Timeline.

Al.32

Set Ganging

No

No

No

Only switching on/off of
3D sync mode by Instant
Ganging is available on T2.
(P1 only)

Send Data 1:

0 3D Sync Off

6 3D Sync On (Channel 2
(bit 1) and Channel 3 (bit 2)
ganged)

A0.33

Get Ganging
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Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementary_ note on T2
less mode mode | output operation
mode
Set Ganging
AX.34 . No No No No No | Not supported on T2.
Information
A0.35 Get Gangmg No No No No No | Not supported on T2.
Information
AX11 Erase No No No No No | Not supported on T2.
Segment
Ao.16 | I Loaded No o | o ® ®
Request
AX.01 | Auto Skip No No O O O

Managing stored clips

Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementary_ note on T2
less mode mode | output operation
mode

A0.26 | 1P Count o o| o] o o

Request
AX.14 | List First ID O O O O O
AX.15 | List Next ID O O O O O
Ax s | D Status o |o]o]| ol o

Request

Set Working
A2.0E | Folder O O @) O O

Request

Get Working
AO0.0F | Folder O O @) O O

Request

In and Out points are

A012 Il?s Changed o o o o o changed 31mu1tanef)usly, e}nd

List Request you can not recognize which

point has been changed.

AX.10 | Erase ID O O @) O O
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Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementarv. note on T2
less mode mode | output operation
mode
A02A | List First o o| o | o O
Folder
A02B | List Next o ol| o| o o
Folder
Total/
axc| Available O o | o O O
Storage
Request
Set Record Recording duration cannot be
A4.1D : No O No No No changed during the recording
Duration .
operation.
A2.31 | Create Folder O O O O O
Rename
A2.28 Folder O O O O O
A2.29 | Delete Folder O O O O O
A295 ID Start Time o o o o o
Request
A2;17 | 1D Duration o ol o| o o
Request
AE.30 | Replace Edit No No No No No Not supported on T2.
In the properties for the
Stripe clip and playlist, [Replace
AX.2D Timecode © © © © © timecode media:] will be set
to [Specify Start Time].
AX2E | Set Mark In o o o o o This set.tmg cannot be applied
to playlists.
If you want to set an Out
point during the playback,
send the command
AX.2F | Set Mark Out ©) O O O O approximately four o more
seconds before it comes to the
position to set the Out point.
This setting cannot be applied
to playlists.
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Command

Fill/Key
Channel- 3D Sync| signal Supplementary note on T2
R1 | P1/P2 .
less mode mode | output operation
mode

Set Audio

It takes several seconds from
the time the command has

AE.1E . O O ©) O O been issued until the time the
Gain . .
setting is applied on a loaded
clip.
AAF| Gt Audio o o|o| ol o
Gain
Abort
C0.28 Transfer ID O O O O O
This setting will be applied
only on the transfer that
has started when Extended
Transfer ID command is
issued. (Not applied to the
Transfer transfer that has started in the
CX.27 | ID Status O O O O O workstation mode/front panel
Request mode of T2.)

type 2 (data containing
number of bytes transferred),
3 (data containing number

of fields transferred) are not
supported.
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Command

Channel-
less mode

R1

P1/P2

3D Sync
mode

Fill/Key
signal
output
mode

Supplementary note on T2
operation

C2.25

Extended
Transfer ID

Export of clips/playlists is only
supported. (Import operation
is not supported.)

Setting of In and Out points is
only supported for FFFFFFFE.
(The range for the transfer
cannot be set.)

The setting for the transfer type
will be disabled. The transfer
type follows the settings in
[Transfer] -> [AVI] or [Playlist]
on the setting screen.

The recommended transfer

type is 0x03 (Profile), which

is described in “K2_Protocol
developers_Guide” as a sample of
transfer via Grass Valley server.
Set the clip/playlist name for
the transfer source.

Set the transfer destination as
follows.
e Network Drive:localhost/[n]:/
[dir]/[file name]
For “n”, specify the network
drive allocated by [General] ->
[Network-3] on the setting screen
or the drive connected via USB.
Example)localhost/z:/Export/Clipl
¢ FTP server:[address]/v:/[bin
name)/[file name]
For address, specify the
address registered in [Hose
Name/IP Address] in [FTP
Export List] of [General] >
[FTP] on the setting screen.
Example)169.254.138.3/v:/
Default/Clipl
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Fill/Key
Command Channel- | o | py/pp 3D Sync| signal | Supplementary note on T2
less mode mode | output operation
mode

Deep copy is not supported.
Setting In and Out points to
AX.19 | New Copy O O O O O playlists is not available.
Only Shallow and Move are
supported.

Clip data information

Fill/Key
e Channel- R1 | P1/P2 3D Sync| signal Supplementary_note on T2
less mode mode | output operation
mode
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Fill/Key
Command Channel- R1 | P1/P2 3D Sync| signal Supplementarv. note on T2
less mode mode | output operation
mode
If Send Data 1 is 'C,
) Compression Type and Video
AA13 I({:llp Datta O O O O O Format are not supported.
eques If Send Data 1 is 'E', this
setting is not available.
Get A JPEG data with the size of
A2.09 Thumbnail © © © © © 160 x 90 will be returned.
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Flags
Flags Command Availability| Note Flags Command Availability| Note
Status hyte 0 Status byte 4
bit0: Local ©) bit0: Preroll O
bitl: Remote+Local O bitl: Event Schedule Failed O
bit2: Hard Error O bit2: —
bit3: General Error O bit3: —
bit4: — bit4: Mute O
bit5: Cassette Out ©) Always 0 bit5: Loop Playback Mode O
bit6: — bit6: EE On O
bit7: Busy O bit7: —
Status byte 1 Status byte 9
bit0: Play O bit0: Preview In Preset O
bitl: Record O bitl: Preview Out Preset O
bit2: Fast Forward ©) bit2: Folder Not Found O
bit3: Rewind O bit3: Disk Overflow O
bit4: Eject O Always(0  bit4: Metadata Not Found No
bit5: Stop O bit5: Clips Dropped ©)
bit6: Tension Release ©) Always 0 bit6: Out Preset Failed O
bit7: Standby On O Always 1 bit7: Overwrite Clip o
Status byte 2 Name
bit0: Cue Complete O Status byte A
bitl: Still O bit0: ID Not Found O
bit2: Direction O bitl: Timecode Not Found O
bit3: Variable Play O bit2: Transfer ID Complete ©)
b%t4: Jog O bit3: Transfer ID Abort o
bit5: Shuttle ©) Complete
bit6: — bit4: Movie Delete Complete O
bit7: Servo Lock O bit5: Transfer ID Failed O
S.tatus byte 3 bit6: Trzjmsfer ID Abort o
bit0: In Preset O Failed
bitl: Out Preset ©) bit7: movie Delete Failed O
bit2: Sp.eciﬁed Folder o S?atus byte D ‘
Exist bit0: Time Of Day ©)
bit3: Invalid Folder o bitl: Widescreen Mode O
' Name bit2: Drop Frame O
) Folder Deletion bit3: VITC O
bitd: Failed © bit4: Timer O
bit5: Jog Reject O bit5: LTC ©)
bit6: Source Missing O bit6: Tape End O
bit7: Auto Mode O bit7: Tape Top ©)
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BVYW command list

The BVW commands available when controlling an external controller from T2 in the R1-VTR mode
are listed in the following tables.
The commands with the “O” mark are available on the optional action as DEVICE, and if mentioned
in the RETURN column, RETURN + DATA is returned, and if not mentioned, 10 01 ACK is returned.
The commands with the “A\” mark return ACK or return RETURN as STATUS, but the action will

not be performed.

Command RETURN

00 | 11 |DEVICE TYPE REQUEST 12 | 11 |DEVICE TYPE RETURN O
20 | 00 |STOP O
20 | 01 [PLAY O
20 | 02 |RECORD O
20 | 04 |STANDBY OFF O
20 | 05 |[STANDBY ON O
20 | 10 |FAST FWD O
2X | 11 [JOG FWD O
2X | 12 |[VAR FWD O
2X | 13 |SHUTTLE FWD O
2X | 20 |REWIND O
2X | 21 |JOG REV O
2X | 22 |VAR REV O
2X | 23 |SHUTTLE REV O
24 | 31 |CUE UP WITH DATA O
20 | 54 | ANTI-CLOG TIMER DISABLE AN
20 | 55 |ANTI-CLOG TIMER ENABLE A
44 | 00 |TIMER-1 PRESET O
40 | 08 |TIMER-1 RESET O
41 | 36 |TIMER MODE SELECT O

74 | 00 |TIMER-1 DATA O

74 | 04 |LTC TIME DATA O

78 | 04 |LTC TIME & UB DATA O
61 | 0C | CURRENT TIME SENSE 74 | 05 |LTC UB DATA ©

74 | 06 | VITC TIME DATA O

78 | 06 |VITC TIME & UB DATA O

74 | 07 |VITC UB DATA O

70 | 0D |REQUEST TIME MISSING O
61 | 20 |STATUS SENSE 7X | 20 |STATUS DATA O
60 | 2E | COMMAND SPEED SENSE 71 | 2E | COMMAND SPEED DATA O
60 | 36 | TIMER MODE SENSE 71 | 36 |TIMER MODE DATA O

* Start Delay value = 10 (*16 hexadecimal)
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BVW list supporting remote mode

BVW list supporting remote mode

The BVW commands available when controlling T2 from an external controller in the R1-remote

mode and P1/P2-remote mode are listed in the following table.

O: Supported, A: Not all supported, X: Not supported

Command

R1

P1/P2

DEVICE TYPE REQUEST

@)

STOP

PLAY, SYNC PLAY

RECORD

STANDBY OFF

STANDBY ON

FAST FWD

JOG FWD

VAR FWD

SHUTTLE FWD

REWIND

JOG REV

VAR REV

SHUTTLE REV

CUE UP WITH DATA

ANTI-CLOG TIMER DISABLE

ANTI-CLOG TIMER ENABLE

TIMER-1 PRESET

TIMER-1 RESET

TIMER MODE SELECT

CURRENT TIME SENSE

[y

TIMER-1 DATA

LTC TIME DATA

LTC TIME & UB DATA

LTC UB DATA

VITC TIME DATA

VITC TIME & UB DATA

VITC UB DATA

REQUEST TIME MISSING

STATUS SENSE

COMMAND SPEED SENSE

TIMER MODE SENSE

REC

olo|o|lo|olo|olo|ojo|olo|Qlo|o|o|D> || x| x|x|x|x|x|x|x|x|x|O|O|x|0O| O

X|{O|O|O|O|O|O|O|O|O|O|O|O0|0|O|0|>|P>|O]O|0]O|0|0|0|0|0|0]0|0]|0|0

*1 If you query the timecode, R1 returns the timecode currently being input. For CURRENT TIME
SENSE, the type of timecode to query can be specified (LTC/VITC). Whichever is specified, the
timecode type set in T2 (the timecode type selected in [Select Timecode] in [R1] -> [Timecode &

Remote] on the setting screen) is returned.
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Section 12 — Appendix

RS422 input/output pin

RS422 input/output pins are as follows.

—
=
R1(R1-VTR mode) R1/P1/P2 (remote mode)
D-Sub 9pin D-Sub 9pin
Pin Signal Pin Signal
1 GND 1 GND
2 RECEIVE- 2 TRANSMIT-
3 TRANSMIT+ 3 RECEIVE+
4 GND 4 GND
5 NC 5 NC
6 GND 6 GND
7 RECEIVE+ 7 TRANSMIT+
8 TRANSMIT- 8 RECEIVE-
9 GND 9 GND
GPI input/output pin
GPI input/output pins are as follows.
I
O 6 0::::::3 O
1' ;
Pin Signal Pin Signal
1 Output 1 9 Input 1
2 Output 2 10 Input 2
3 Output 3 11 Input 3
4 Output 4 12 Input 4
5 Output 5 13 Input 5
6 Output 6 14 Input 6
7 NC 15 NC
8 Common ground 16 Common ground

NOTE ° Only GPI Output 1 to 6 and Input 1 to 6 are available on T2. Pin 7and Pin 15 are not

used.

218 T2 User Manual

August 3, 2012



Section

Specification Change List

This section describes the specification changes from T2 BASIC/T2 RAID/T2 SSD to T2 Express/T2
Pro/T2 Elite.

Software specification changes

The specifications of the software installed on T2 Express/T2 Pro/T2 Elite and their differences with
T2 BASIC/T2 RAID/T2 SSD are listed in the following table.

O: Supported, A: Not all supported, x: Not supported

T2 BASIC/T2 RAID/T2 SSD T2 Express/T2 Pro/T2 Elite
Codec supporting native format playback Playback R1'1/P1/P22 Playback R1'1/P1/P2?
Grass Valley HQ
Grass Valley HQ Alpha
Avi Grass Valley LossLess/DV/ O 1in2 out O
DVCPRO HD/DVCPRO050/
DVCPR0O25
HD422
lin1 out
HD 35Mbps
XDCAM
HD 25Mbps/18Mbps .
1in 2 out
IMX
HD 35Mbps 1in 1 out
XDCAMEX | HD 25Mbps , lin2 out
1in 2 out
DVCAM As
AVC Intra 100 ) O
0in 1 out™
P2 AVC Intra 50
DVCPRO HD/DVCPR050/ .
DVCPRO25 Lin 2 out
HD | Frame only 100Mbps .
1in 1 out
GF HD Long GOP 50Mbps
SD 11in 2 out
AVCHD H.264/AVC O 0in 1 out*
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Section 13 — Specification Change List

| T2 BASIC/T2 RAID/T2 SSD | T2 Express/T2 Pro/T2 Elite
Codec supporting import (conversion to Grass Valley HQ AVI)
Grass Valley HOX X O
AVl Grass Valley Lossless @) O
uncompressed O @)
ToOWS | windows Media Video ¢ o)

DV/DVCPRO HD/H.264/
ProRes422/ProRes4444/
JPEG2000/Animation/
Quick Time | MPEG4/Photo JPEG/PNG/

©)
©)

uncompressed

Grass Valley HQ/

Grass Valley HQOX X O
MPEG2 MPEG2 O

. JPEG/BVW/GIF/TIFF/PNG/
Stillimage | Ta om0 O O
Scaling on playback

SD <->HD O O
HD (720p) <-> HD (1080i) X O

*1 Input to R1 channel will be the Grass Valley HQ format.

*2  The number before “in” indicates the number of other sources that can be recorded while
playing the source. The number before “out” indicates the number of other sources that can be
played simultaneously while playing the source.

*3 Although T2 BASIC/T2 RAID/T2 SSD required a separate license, T2 Express/T2 Pro/T2 Elite
include the function by standard.

*4 Frame rate conversion not available, scaling not available.
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